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Using Your System Management Manual

Overview

The System Management Manual contains sections that are not in the other manuals.
However, the information may be used throughout the system. These sections are:

Using Your Manuals - describes the standard format used by the FACTS
manuals

Using Your System - describes the standard procedures in using the
FACTS System

Troubleshooting - A technical appendix dedicated to problem-solving
Pro5 Features - An appendix dedicated to Pro5 features

Using Preprinted Forms in FACTS

Some of the print programs available in FACTS are designed to output on preprinted
forms available from Western Atlanta Forms Corp., 1895-C Beaver Ridge Circle,
Norcross, GA 30071, 1-800-241-8951

You can order standard preprinted forms with your company name, address, logo, etc.
Sample forms are available in the New User Packet. Samples include:

* AP -check

AR - statement, invoice, past due notice (dunning letter)

. IC - transfer ticket

* JC - estimate, invoice

* PO - purchase order

* PR -check

* SO - quote, pick ticket, invoices (2), counter sales slip, UPS shipping label and bill of

lading.

Keep in mind that it can take anywhere from two to six weeks to print and deliver the
forms, depending on their complexity.

To configure FACTS to use these forms, the Use Preprinted Forms flag must be setto Y
in the following file maintenance programs:

SO Document Print Control ¢ AP Check Print Control
AR Statement Print Control e JC Static Control
AR Invoice Processing Control e TF Letter Print Control

AR Dunning Letter Control

Copyright © 1984-2004 Aperum, Inc. v
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» If you run out of preprinted forms, you can set the Use Preprinted Form flag in the
appropriate file maintenance program to N. The resulting output will print on blank
paper and look similar to the preprinted form.

» If your company already has its own preprinted forms, your Affiliate may need to
modify the programs listed above so that your documents print correctly. (Note: If you
want FACTS to print to blank paper forms that look like your preprinted forms, notify
your Affiliate of this requirement so that the proper modifications can be made.)

Vi Copyright © 1984-2004 Aperum, Inc.



FACTS

System Overview

The System Management module is the backbone of all modules in the FACTS
system. It will accommodate hundreds of companies maintaining accurate file
information and providing complete audit trails. This allows users the secure
feeling that all information is traceable throughout the system. Instructional
prompts, default values and the capability to back up to previous inputs
promote both user efficiency and comfort in using the system.

System Management is broken down into the following menus: Messages,
Menu Setup, Security System, Banking & Check System, Inquiries, Reports &
Prints, End-of-Period Checklist and File Maintenances.

File Maintenances

File maintenance programs allow the user to enter, change and delete data.
These programs are used to enter the initial data required to set up the system.
The user can add, change and delete the records in a file. This is called
maintaining the file. The file maintenance programs in System Management will
be used in the installation of the system. The information set up in these file
maintenance programs is used to control and direct how much of the processing
occurs in all the other modules in the FACTS system. For example, in the
Company Control F/M program, the user sets up the length of the general
ledger number, whether the general ledger department is inserted within the
general ledger number and in what position, whether the branch is inserted
within the general ledger number and in what position, etc. Users set up system
control information, company control information, terminals, printers and
branches.

The system supports up to 980 terminals. For each terminal on the system, the
user may set a default branch, warehouse, department, salesperson and printer.
This relieves the user of having to enter the correct information at these
important inputs. The system will automatically insert the correct information
where necessary as set by the user. All reports throughout FACTS may be
printed to a terminal. The user may set a hex code per terminal to print 132
columns of information (if applicable and within the range of the terminal)
when printing to the terminal. Hot keys can also be defined to each terminal.
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The system supports up to 99 printers. For each printer the user may set the
compressed and standard print hex codes (as applicable based on the printer).
At any time during processing, the print size may be set by the user through the
Set Standard/Compressed Print program. Each program in the system may also
be set to a default printer by terminal. For example, when printing work orders
from certain terminals, the system may automatically print the work orders on
the warehouse printer.

System Security

FACTS comes with its own security system built into the menu driver so that it
can monitor the number of users logging into FACTS versus the number of
licenses purchased.

It relies on an environment variable, called SSI_BASE, and an SMFIDS file to
cross reference FID(0), which is the value that appears as Terminal ID in System
Management’s Terminal F/M.

SSI_BASE is the heart of the security system, enabling it to determine who is
logging into FACTS and how many times. The variable also compares this
information to the number of licenses purchased.

9 Each licensed user can log into FACTS up to nine times, as long as they
do so with the same FACTS user code and on the same workstation.

In any SSI_BASE discussion the word unique appears often, and with good
cause. How FACTS uses SSI_BASE is the reason why administrators shouldn’t
rely on pseudo ttys as SSI_BASE values, and why SSI_BASE needs to be
recognized as early as possible in the start up procedure.

When users log into FACTS, the security system captures the SSI_BASE value
and SME100 checks the SMFIDS file for the SSI_BASE to determine and set the
Terminal ID. These Terminal IDs remain in SMFIDS as long as the User ID is
maintained. Every time a user starts a session, the first session will be Terminal
ID TA, for example; the second session will be terminal ID TB and so on.

The following table shows a NT/PC user, JohnD, who successfully signed into
FACTS three times. He can log into the system six more times with the user
code “SSI” without experiencing any problems.

SSI BASE If UID OK, If NID OK If TCP/IP OK If C0$(1,3) OK

check NID check TCP/IP check C0$(1,3) check ...
Session 1 john UlID=JohnD NID=Iron TCP/1P=123.1.1.1 User code=SSI
Session 2 john UlID=JohnD NID=Iron TCP/1P=123.1.1.1 User code=SSI
Session 3 john UlID=JohnD NID=Iron TCP/1P=123.1.1.1 User code=SSI

When the user launched the first session, the FACTS security system noted
network signon (UID), the PC’s network ID (NID), the PC’s TCP/IP address
and the FACTS user code.
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As new sessions are launched, the security system checks each of these
identifiers in succession. As soon as one fails to match, it drops all sessions for
that SSI_BASE.

In the following table, for instance, one user launched two FACTS sessions
successfully. However, the third attempt failed because the security system
detected a network signon for SSI_BASE=john that differs from the first two
sessions. This indicates that same SSI_BASE value may have been set in two
different autoexec.bat files.

SSI_BASE If UID OK, If NID OK If TCP/IP OK If C0$(1,3)
check NID check TCP/IP check C0$(1,3) OK, ...
Session 1 john JohnD Iron 123.1.1.1 SSI
Session 2 john JohnD Iron 123.1.1.1 SSI
Session 3 john MaryF Quartz 127.3.3.3 SSl

The next example shows a user trying to launch a third FACTS session with a
different FACTS user code. His third attempt will be successful, but when he
returns to the other two sessions and tries to open a program, “User Not Signed
On, CR-Continue” will display at the bottom of the screen.

SSI_BASE If UID OK, If NID OK If TCP/IP OK If C0$(1,3)
check NID check TCP/IP check C0$(1,3) OK, ...
Session 1 john JohnD Iron 123.1.1.1 SSI
Session 2 john JohnD Iron 123.1.1.1 SSI
Session 3 john JohnD Iron 123.1.1.1 MAR

The System Management module also includes a System Security menu that
enables administrators to establish user and program level security systems in
addition to the login security system just discussed.

Menu Setup

FACTS comes with a default menu setup; however, menu customization is
quick and easy. Users may add, change or delete programs on menus or may
add new menus or delete existing menus. Each menu (and program) may be
assigned a user-determined access code. From any menu in the system, when an
existing access code is entered, the menu is displayed or the program is
accessed and entered.
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Messages

Messages may be entered by users to display on any menu in the system. When
entering messages, users specify the menu on which to display the message, the
date to display the message and the user to whom the message will be
displayed. Messages may be sent to a specific user or all users. Messages may
be entered by users to remind themselves of something to do on a specified
date, or messages may be entered to announce an upcoming meeting, etc. Past
Messages may be removed by date and by user through the Remove Messages
program.

Banking and Check System

Within the System Management module there is a centralized banking and
check reconciliation system. All banks used throughout the system are set up
through the Bank F/M with an assigned general ledger cash-in-bank number to
which transactions are posted. Each bank set up on the system may store
ledgercards (each transaction stored which affects the bank accounts balance,
i.e., deposit, check register, etc.). Separate bank accounts within the same bank
may simply be set up as separate bank codes.

The banking systems bank account balances are maintained by the system
through postings from Accounts Payable when checks are written, from
Accounts Receivable when cash is posted (deposits are made) and when
invoices are entered as cash invoices, from Payroll when checks are written, and
from Sales Orders when invoices are entered as cash invoices. Bank account
balances are also maintained by the user making adjustments (for service
charges, etc.) through the Adjust Bank Balance program.

Checks are stored (from the AP and PR systems) for check reconciliation. The
Reconcile Checks program allows the user to enter whether checks have cleared
the bank. The Check Listing program is then printed to list all cleared checks
and then remove them.

Bank information is available for display through the Bank Inquiry program
which displays general information, ledgercards stored and checks written.
Bank notes may also be entered and displayed in the inquiry. The Bank Inquiry
provides users with all bank information at their fingertips and makes bank
account management an organized and efficient process.

Inquiries

The following inquiries are available in the System Management module:

The Summary Management Inquiry provides by branch and department the
current accounts payable and receivable balance, cash in bank, inventory
valuation, open purchase and sales order balance and sales history for the last
six periods.

The Amortization Schedule allows the user to enter a loan principle, interest
rate and period of time for a loan and the loan payments will be listed on the
screen.

The Terminal Inquiry displays all terminals logged into the system, the
company and the program being accessed by each user.
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The User Tracking Inquiry provides a list by user code itemizing which
programs are accessed and the time used (if the user tracking flag issetto Y in
the System Control F/M). (See the section on user tracking in the overview
section.)

The File Usage Inquiry provides a list by file name and by percentage used of
all file specific information.

The Program Inquiry allows the user to view in list form all the programs and
menus set up in the Program F/M on the screen along with their access codes
and security codes.

Reports and Prints

The following reports and prints programs provide lists of companies on the
system, programs, menus, users on the system and program changes:

1. The Company Listing provides a list of all companies, addresses and
phone numbers on the system.

2. The Program Name Listing provides a list of all programs (and menus)
set up in the Program F/M along with terminal validity, access codes,
and security codes, if selected.

3. The Program Usage Report provides a list of each program defined
and lists the menus containing the program.

4. The Menu Selections Report prints a range of menus (as determined by

the user) which may be helpful in setting up security.

5. The User Tracking Report prints a list of users using the system as to
which programs are accessed and the time used (if the User Tracking
flag is set to Y in the System Control F/M). (See the section on the user
tracking in the overview section.)

6.  The Program Change Report prints a list of program changes from the
Program Change F/M. The user (affiliate) enters program changes. If
no program changes are entered, this report will not be used.

7. The F/M Audit Report prints a list of any changes made to the file
information through file maintenance programs. This information is
limited to file maintenance programs where an audit trail is being kept
for changes (as set in the Program Name F/M).

8. The Help Text Print provides all the help text available by help code.

9. The SM Code List prints a list of various SM codes including terminals,
printers, banks, branches and files.

End-Of-Period

The End-of-Period Menu provides a checklist of procedures for closing out each
module in the system at the end of each period. The standard procedures have
been provided and may be printed through the End-of-Period Checklist Print
program. Standard procedures on the checklist may be modified by the user
through the End-of-Period Checklist Entry program. It is suggested to print a
checklist for each period closed. Please refer to the End-of-Period Procedures
section for each module.
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Job Stream

The FACTS Job Stream system allows the user to set up a sequence of programs
to run in a series without users interaction.

Job Stream is a timesaving module in that various reports including end-of-
period reports may be set up and run without user’s supervision. The user may
set up a job stream to include up to 99 reports and can let it run overnight
without having to watch and start each report individually.

The Job Stream system is efficient and flexible in allowing the user to set up as
many job streams as needed. Each job stream asks questions about each
program entered which assists the user in the actual running of the job stream.
It also allows the user, at the time of setting up the job stream, to enter in the
inputs for each program. For example, if the user wants to run four customer
lists in four different sort orders, he can enter the customer list four times
varying the inputs each time.

When a job stream is complete, the user may run a Results Print program to find
out the status of how a particular job stream ran, the time each report took to
print, if an error was encountered, etc.

The Job Stream module also includes a Job Stream Listing which prints what job
stream programs were included, how the user answered the questions
associated with the program, and what the inputs were for each program. Job
streams may be entered, changed or deleted at any time.
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Office Automation

The Office Automation module is a system that helps run the user’s office
internally. All employees should be set up to use it. The system allows users to
enter phone directories, record phone messages, send general messages, view
phone and general messages, use a sign-out board, enter schedules and
maintain and print mailing labels.

Office Automation contains the following programs: Sign In/Out, Messages,
Calendar/Scheduler, Inquiries, Reports & Prints and File Maintenances.

Employees are set up through the Employee F/M program. As employees are
set up, they are assigned to a user code (see System Management). Once set up,
whenever employees sign in to the system using their user code, the Office
Automation system recognizes the user code validating it with the employee.
An Employee Listing may be printed to verify employees. Once employees are
set up, the user may enter group codes. Group codes are set up with employees
assigned to them.

Group codes are set up with the purpose of sending messages to group codes
rather than every employee within the group code. For example, there might be
10 employees in the sales & marketing department. A group code called SALES
would be set up with each sales & marketing employee assigned to that group
code. When the director of the sales & marketing department needs to announce
a meeting for the entire department, rather than entering the same message for
each individual employee in the department, the director may enter one
message for the group code. Each employee in the SALES group code, when
retrieving messages, will receive the message.

Phone directories may be set up through Office Automation. Employees may set
up general phone directories for all employees to access. Employees may also
set up personal directories which are only accessible by the employee(user
code) who entered the record initially. General and personal phone directories
may be printed by running the Phone Directory Print program.

The Office Automation system keeps track of an employee’s location through
the use of a sign out board. When employees are leaving the office the Sign
In/Out program is used. Employees enter the time, where they are going, the
expected return time and where they can be reached. The Sign Out Board
Inquiry program may be used to locate an employee’s whereabouts at any time.
When employees return to the office the Sign In/Out program is used again to
sign back into the office. At the time when an employee signs in the system
displays a welcome communication, and if the employee has any messages on
file, a communication is displayed indicating that there are messages.

General and phone messages may be entered for employees. There is a Phone
Message Entry program where users enter phone messages including message
options (example, please call back, etc.). There is also a General Message Entry
program where users enter general messages to be sent to an individual
employee or a group code (group of employees).
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If an employee has any new phone or general messages that have not been read,
a message to that effect will display on any menu screen the employee accesses.
Messages may be retrieved through the Message Viewing/Disposition
program. Once a message has been viewed, employees may indicate the
message has been read, delete the message or send the message to another
employee.

Schedules may be maintained by employees through the Calendar/Scheduler
program. The calendar is available to display one day at a time (where
scheduled activities may be entered for each half hour), one week at a time
(display only) and one month at a time (display only). Company calendar notes
may be entered to be displayed on the daily calendar through the Company
Calendar Notes F/M. Employees’ schedules are then available for printing
through the Schedule Print program including unscheduled time.

The Office Automation system contains a mailing label system. Each mailing
label must be entered into the system through the Mailing Label F/M program.
Each label entered may be assigned up to 5 mail codes. Mail codes must be
previously set up through the Mail Code F/M program. An example of mail
codes might be PRO — prospects or GEN — general company mail out. Mail
codes are used to select and sort mailing labels to print. The Mailing Label
Report lists mailing labels by mail code along with selected file information.
Mailing labels may be printed for specific mail codes through the Mailing Label
Print F/M program.
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System Management Flow Charts

The following pages present flow charts that illustrate the flow of information
from System Management to the other modules in the FACTS System. They also
illustrate the flow of information within System Management.

Note that not all files and programs are shown. The flow charts simply present
how information flows through the system.

The following symbols represent the types of information shown on the flow

charts.
Program Reglstgr or report with
optional update
Report
File
FACTS Module
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Programs

The programs located on the System Management Master Menu should be run
by the System Administrator.
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Change Company (SMU110)

Function

This program allows the user to change from working in one company to
working in another.

Multiple companies may be set up on one FACTS system. However, a user can
work only in one company at a time. (Any other users may also be working in
the same company.) To switch from working in one company to another, this
Change Company program is used. It may be used at anytime by any user
authorized to work in the new company.

User Inputs

The following inputs are involved in changing the company. Current company
number and name are displayed.

1. New Company

Enter the company code to begin working in. The entry must be a valid
company code. F2 allows a search (ref. 3).

2. OK To Change Company?

Enter Y or N to indicate whether to change companies (from current company
to new). CR defaultsto Y. If Y is entered, the company is changed and the
program returns to the menu.

Technical Notes

FILES USED - SMCNTL, SMZART
FILES UPDATED - SMTRCT
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L® Change Company [SMU110)
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Set Day and Time (SMU120)

Function

This program allows the user to set the date and time on a per user basis.

The date and time are usually already set when bringing the system up.
However, if for some reason the date is incorrect, or for example, the user wants
to set the system date back a day to finish up yesterday’s work the day and time
can be changed.

On some computer systems an ERROR=18 results when attempting to change
date or time if the user does not have permissions set correctly for the host
operating system. Should this occur, abort the procedure and attempt again
when proper permissions have been assigned.

User Inputs

The following inputs are involved in setting the date and time. The current system date and time are
displayed.
1. New Date

Enter the new date (ref. 1). If the day is set more than three days from the
current date a warning is given, but the day is still set to its new value. CR
defaults to the current date.

If you are not logged onto your system as the super user, the new time input is
skipped and is set to the current system time.

2. New Time

Enter the new time (HH:MM ?M). The M after the question mark (?) refers to
A.M. or P.M. Enter A or P in place of the question mark (?). CR defaults to the
current system time.

3. Correct Date And Time

Enter Y or N to indicate the new date and time are correct. CR defaults to Y and
the program returns to the menu.

Technical Notes

FILES UPDATED - SMCNTL
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How to set the date and time for your terminal

1.

Access this program selecting System Management->Programs—>Set Day
and Time.

The system displays the current system date and time.

In the New Date input, enter the new date. If the day is set more than
three days from the current date a warning is given, but the day is still set
to its new value. Press Enter (CR) to default to the current date.

In the New Time input, enter the new time (HH:MM ?M). The M after the
guestion mark (?) refers to A.M. or P.M. Enter A or P in place of the
guestion mark (?). Press Enter (CR) to default to the current system time.
Note: If you are not logged onto your system as the super user, the new
time input is skipped and is set to the current system time.

In the Correct Date And Time input, enter Y or N to indicate the new date
and time are correct. Press Enter (CR) to default to Y and the program
returns to the menu.
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Set Standard/Compressed Print (SMU130)

Function

This program allows you to specify whether standard or compressed print is
used for the current session and current user, and to optionally make the setting
effective for all users.

User Inputs

The following inputs are involved in setting standard or compressed print:
1. Printer

Enter the printer number. CR defaults to 0. F2 allows a search (ref. 3). If the
system uses only one printer input #1 is skipped.

2. Mode

Enter S-standard or C-compressed to indicate the type of print to use for this
printer in the current FACTS session. CR defaults to S.

3. Update File

Enter N or Y to indicate whether this setting should be added to the Printer File,
thus making it effective for all users in all sessions who do not already have a
default mode. If you enter Y, you will not overwrite the settings other users

have specified with this program. If you enter N, this setting is for the current
session and current user. CR defaults to N.

Technical Notes

The SMC100 Open Printer called routine checks the user’s global printer mode
string (set in input #2) for a value. If there is a value (S or C), then it sends the
appropriate mnemonic to the printer. If the string does not exist, the routine
reads the Printer File to get the default setting. This default setting can be
changed with input #3.

FILES UPDATED - SMCNTL
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E% 5et Standard- Compressed Print (SMU130)
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How to set the date and time for your terminal

1.  Access this program selecting System Management—->Programs—>Set Day
and Time.

2. The system displays the current system date and time.

3. Inthe New Date input, enter the new date. If the day is set more than
three days from the current date a warning is given, but the day is still set
to its new value. Press Enter (CR) to default to the current date.

4. Inthe New Time input, enter the new time (HH:MM ?M). The M after the
guestion mark (?) refers to A.M. or P.M. Enter A or P in place of the
guestion mark (?). Press Enter (CR) to default to the current system time.
Note: If you are not logged onto your system as the super user, the new
time input is skipped and is set to the current system time.

5. Inthe Correct Date And Time input, enter Y or N to indicate the new date
and time are correct. Press Enter (CR) to default to Y and the program
returns to the menu.
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CHAPTER 3

Messages

The messages menu allows the user to set up messages to send to a specific user
or all users. Messages may be entered to be displayed on a specific menu on a
specific date. When the user signs in and accesses a menu, the message is
displayed in its entirety in a pop-up window. Messages may be removed
individually through the entry program or by date through the Remove
Messages program.
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Message Entry (SMF210)

Function

This program allows the user to enter messages to be displayed on any menu on
the current or any future date. Messages can be used as reminders, such as
meetings or as PR, such as birthdays. The user may determine the message
content, the date it appears and the menu on which it is displayed. Messages
can be displayed for a specific user or for all users. Up to six lines may be
defined for each message.

Messages may be removed individually through this entry program or by date
through the Remove Messages program.

User Inputs

The following inputs are involved in creating a message:
1. Menu

Enter the name of the menu on which the message is to be displayed. The entry
must be a valid menu name. Entry of a valid name displays the menu
description. CR defaults to MMS000 (master menu).

2. Date

Enter the date this message is to appear (ref. 1). CR defaults to system date. F3
defaults to the first date on file for the menu displayed.

3. User Code

Enter the user code that must be in use for this message to be displayed. The
entry must be a valid user code. Entry of a valid code displays the user’s name.
CR defaults to ALL users. F3 defaults to the first user code on file for the menu
and date displayed.

4. Message (Lines 1-6)

Enter the message (up to 65 characters per line). F3 ends entry of the message.

Technical Notes

FILES USED - SMSLCT, SMZART
FILES UPDATED - SMMESS
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How to enter system messages

1.

2.

Access this program selecting System Management->Programs—>Message Entry.

In the Menu input, enter the name of the menu on which the message is to be displayed. The
entry must be a valid menu name. Entry of a valid name displays the menu description. Press
Enter (CR) to default to MMSO000, which is the FACTS Master Menu.

In Date input, enter the date this message is to appear. Press Enter (CR) to default to system date.
Press F3 to default to the first date on file for the menu displayed.

In the User Code input, enter the user code that must be in use for this message to be displayed.
The entry must be a valid user code. Entry of a valid code displays the user’s name. Press Enter
(CR) to default to ALL users. Press F3 to default to the first user code on file for the menu and
date displayed.

In the Message (Lines 1-6) input, enter the message (up to 65 characters per line). Press F3 to end
entry of the message.

When you are ready to exit the program, press F4.
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Remove Messages (SMU210)

Function

This program allows the user to remove messages from the message file.
Messages should be removed periodically to prevent the file from becoming
full. The user may remove messages for a specific menu, a range of menus or
for all menus. Messages to be removed are determined by the message date.
All messages dated on or before the user-entered date are removed.

User Inputs
The following inputs are involved in removing messages:
1. Beginning Menu

Enter the beginning menu from which to remove messages. CR defaults to
FIRST.

2. Ending Menu

Enter the ending menu from which to remove messages. CR defaults to LAST.
3. Cutoff Date

Enter the message date up through which messages are to be deleted (ref. 1).
CR defaults to the system date.

4, User

Enter the user code of messages to be removed. The entry must be a valid user.
CR defaults to ALL.

Technical Notes

The program reads through the message file (SMMESS) and removes messages
for the correct company and dates.

FILES USED - SMCNTL, SMZART
FILES UPDATED - SMMESS
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ES Remove Messages [SMU210)
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How to remove messages from the message file

3-8

1.

2.

Access this program selecting System Management->Programs—>Remove Messages.

In the Beginning Menu input, enter the beginning menu from which to remove messages. Press
Enter (CR) to default to FIRST.

In the Ending Menu input, enter the ending menu from which to remove messages. Press Enter
(CR) to default to LAST.

In the Cutoff Date input, enter the message date up through which messages are to be deleted.
Press Enter (CR) to default to the system date.

In the User input, enter the user code of messages to be removed. The entry must be a valid user.
Press Enter (CR) to default to ALL.
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Quick Note Entry (SME210)

Function

This program allows you to enter notes or messages (quick notes) that are to be
printed to a printer, faxed out as a cover page only, and/or sent as an OA
message in the Office Automation system. The note/message may be up to 999
lines. Once the program is exited, the note/message entered is not saved. The
same note/message that is entered may be printed, faxed and sent as an OA
message to as many destinations as needed up until the user exits the program.

User Inputs
The following inputs are involved in removing messages:
1. Enter Note

Enter the note/message to be entered. While entering notes, line numbers are
assigned beginning with 001 and will automatically increment by 1. Enter text
(up to 70 characters per line) and the program will go to the next line when the
end of a line is reached or when the user presses CR. F3 ends entry of the lines.
When inserting lines, the line numbers are automatically re-numbered. Lines
may be added, inserted, deleted, or modified.

Other available options;

e Fax - All the user to fax a cover page and calls the Fax Information Entry program.

Messages

e Create OA message - Allows the user to create an OA message and calls the General Message

Entry program from Office Automation.

e Print - Allows the user to print the message. Once printed the program returns to the action

screen.

« F1-Change Note - Use this option to return to the edit screen.

Copyright © 1984-2004 Aperum, Inc.
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How to enter notes or messages (quick notes)

1. Access this program selecting System Management—->Programs—>Quick Note Entry.

2. Inthe Enter Note input, enter the note/message to be entered. While entering notes, line
numbers are assigned beginning with 001 and will automatically increment by 1. Enter text (up
to 70 characters per line) and the program will go to the next line when the end of a line is
reached or when you press Enter (CR). Press F3 to end line entry. When inserting lines, the line
numbers are automatically re-numbered. Lines may be added, inserted, deleted, or modified.

3. There following options are available in the system:

Fax - Allows the user to fax a cover page and calls the Fax Information Entry program.

Create OA message - Allows the user to create an OA message and calls the General Message
Entry program from Office Automation.

Print - Allows the user to print the message. Once printed the program returns to the action
screen.

F1-Change Note - Use this option to return to the edit screen.

4. Press F4 to exit the program.

Copyright © 1984-2004 Aperum, Inc. 3-11



Messages System Management—7.40

3-12 Copyright © 1984-2004 Aperum, Inc.



DISTRIBUTION SOLUTIONS Leaders in Distribution Solutions

CHAPTER 4

Menu Setup

FACTS ships with a complete set of menus and program descriptions.
However, if new programs are added to the system, this sub-module enables
administrators to them to menus. Administrators can also delete menus for
modules that you did not purchase.

All programs and menus must be set up in the Program F/M before they can be
set up on menus in the Menu F/M.

» The Program F/M provides:

e program designation

*  program name (description)
»  access code

* F/M audit flag

» terminal security

e printer usage
» The Menu F/M provides:

* menuname
*  return menu

*  menu description

e programs included

» The Device Usage Update provides global:
* modification of printer(s) usage

« modification of terminal security
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Program F/M (SMF310)

Function

Use this file maintenance to add programs to or delete programs from the menu
system. You can also customize the way program descriptions appear in menus,
restrict certain terminals from accessing these programs and control how users
print from these programs.

Adding and customizing programs

In addition to adding programs to the system, Program F/M can be used to
customize the program descriptions that appear in the menu system, create
selection numbers for the character menu system and set up new access codes
or change existing ones.

2 When creating or renaming programs, make sure you follow the naming
standards set by Aperum™. We provide a quick overview here. For more
information, refer to the FACTS Technical Manual for this release.

Naming standards: Every FACTS program goes by two names. One is an
alphanumeric programming name, for example SMF310. The other is a
descriptive title, such as Program F/M.

All alphanumeric names are six characters long and follow these rules:

The first two characters represent the module. For example, in the name
SMF310, the first two characters tell you that the program is part of the System
Management module.

The third character conveys which type of program it is. The F in SMF310
indicates that this program is a file maintenance. Use E for entries, | for
inquiries, P for special form prints, R for reports, S for menus (selectors) and U
for updates. The last three characters must be numeric and designate the
subsystem to which the program belongs.

Restricting access

Program F/M'’s terminal settings feature can be used to control which terminals
have access to programs, and if they do have access, what kind of printer usage
is allowed from within these programs.

For instance by clicking the Terminals button, you can configure a terminal so
that it can access a program, but not print from it. Or you could restrict that
terminal’s access to a specific printer so that when that terminal’s user attempts
to print, he or she can output documents at the printer designated in this
program.

The user may set up the code to access the program and if the program is a file
maintenance, the user may specify if the information in the file should be
audited. The user also establishes terminal access by program, availability of a
printer and the default printer for the program by terminal.

Once program names are defined, menus may be constructed using the Menu
F/M program.
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To print or inquire on the information in this program, use the Program
Designation Inquiry, Program Name Listing, and Program Usage Report.

Read the User Input section for more information about each field.

User Inputs
1. Program

Enter the 6-character program designation to identify this program, for example
APE310. F2 allows a search of programs in the system (ref. 3).

2. Full Name

The full program name is what appears in the menu system. Enter a name up to
30 characters long by which users can easily identify this program. Use the
Menu F/M program to modify that programs appear on which menus.

*3. Access Code

Access codes can be used as quick shortcuts. For more information on access
codes, refer to the Using FACTS manual.

To create the access code, for the selected program enter up to 6 characters.
Make sure the first character is a letter of the alphabet. An example is CS that is
the default access code for Counter Sales Entry in the Sales Orders module.

Once access codes are set, users can key them in from anywhere in the menu
system to quickly access programs.

4. F/M Audit

For file maintenance programs, you can select this option (enter Y in character)
so you can track which users access these program and then run the F/M Audit
Report to see what changes they made. This feature is essentially a security tool
for administrative users and local FACTS Affiliates. This field is set to N by
default and remains disabled until a file maintenance program is selected.

This input is skipped except for F/M programs (e.g., third character of program
designation is an F).

* Several fields have been purposely omitted from the User Inputs section
because they are no longer used by the system or can only be used by Affiliate
programmers.

Terminals

To set program-specific options for groups of terminals, click the Terminals button at the bottom of
the screen. A new window appears with several terminal-related fields.

From this window, you can tell the system whether selected group of terminals have permission to
access the program selected in the main Program F/M window.

For report and print programs, you can also set printer usage in different programs for groups of

terminals and designate the normal printer each terminal should use in different programs (this
assumes that the program selected is a report or print).
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1. Terminal Group Number

This number is established in Terminal F/M for each terminal ID record. Press
Flor click the All button to select all terminal numbers in the system.

2.  Valid Terminals

For the terminal number specified, designate whether or not this group can
access the program selected on the main screen. The system automatically sets
all terminal numbersto Y.

3. Printer Usage

This field remains disabled unless the program specified on the main window is
a report or print. For these types of programs, select one of the four printer
usage options to determine how users print in each program.

N-No printer indicates no printer can be used in this program.

0-Printer Used, Not User Selectable indicates the program uses the printer
designated default printer (last prompt on this window) , and users cannot
select alternate printers from this program.

1-Printer Used, User Selects if Default Busy indicates the program uses the
default printer unless it is busy. If so, users can select an alternate printer.

2-Printer Used, Always User Selectable indicates users always select the
printer, but the defaults to the printer indicated in the next field.

4. Default Printer

This is the default printer or normal printer used by this program. Enter a
printer number (set in Printer F/M). Press F2 or click on the Search button. You
can set different groups of terminals to default to different printers in each
program.

Technical Notes

FILES USED - SMCNTL
FILES UPDATED - SMNAME
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Menu F/M (SMF320)

Function

This program allows the user to determine the format of all menus. Even
though a complete set of menus ships with FACTS, this program gives users
control of menu choices and allows customization of menus for maximum
efficiency and security.

The user determines the menu name, return menu, description and all
programs to appear on the menu. Programs may appear on any menu chosen
by the user, even on menus in a different module from its own. There is no
limit to the number of menus on which a program may appear.

The menu name, return menu and all called programs must be defined through
the Program F/M program. The third character of the menu and return menu
names must be S. The master menu is always MMS000.

User Inputs

The following inputs are involved in creating a menu record:

Programs

1. Menu Name

Enter the 6-character name of the menu to be defined (e.g., ARS100, 1CS200,
etc.) The entry must exist in the Program F/M.

2. Program Names

Enter up to 24 program names. Each program name must be six characters and
defined in the Program F/M. The program description displays on the bottom
of the screen.

Click the Caption button or press F1 to work in caption mode. This lets you
view the program descriptions as they will appear on the menus.

Click the Search button or press F2 to search for a program.

Click the Delete button or press F3 to delete the entry from the field. When you
delete an entry, all the following entries will move up one.

Click the Insert button to put in a new entry and move all following entries down one.

Menu Descriptions

1. Description 1

Enter up to 30 characters to describe the menu. This description appears at the
top of the VDT screen when displaying this menu.
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2. Description 2

Enter up to 30 characters to describe the menu (if needed). This description
appears just below description 1.

3. Return Menu

You can specify which menu users backup to from the menu selected on the
main tab. For example, if you have APS000, the Accounts Payable master menu,
selected, you can use this field to specify that users will automatically backup to
MMS000, the FACTS Master Menu, when the click on the Back button or press
F4.

Enter the 6-character name of the return menu. The return menu entry must be
set up in Program F/M and the third character must be S.

CR defaults to the FACTS Master Menu, MMS000.

Technical Notes

This program builds a print string to be used in the actual display of the menu.
Therefore, if a program description is changed through the Program F/M, the
print string must be rebuilt through this program to reflect the new description.
The user must call up each menu on which the changed program appears. Then
the user must use the line to change routine, enter any line number and leave
the information on that line the same. No actual change is made by the user but
the system rebuilds the print string to reflect the new program description.

FILES USED - SMCNTL, SMNAME
FILES UPDATED - SMSLCT

L Menu F/M (SMF320) _ (O] =]
Help

81-Demo Company MENU F#H SHF32@a
*. MEHU HAHE ACS AAA

2. RETURH HEHU HHS 888

3. DESCRIPTION 1 Archive Sub-System

4. DESCRIPTIOHN 2

5. PROGRAM 1 AcCIida 17. PROGRAH 13

6. PROGRAM 2 AcCPii1a 18. PROGRAM 14

7. PROGRAM 3 Acuiia 19. PROGRAHM 15

8. PROGRAM 4 ACR11A 28. PROGRAM 16

9. PROGRAM 5 Acuiza 21. PROGRAH 17

18. PROGRAM & AcU1466 22. PROGRAH 18

11. PROGRAM 7 aAcuizae 23. PROGRAHM 19

12. PROGRAM 8 ACF115 24_ PROGRAM 28

13. PROGRAM 9 aAcUi46 25. PROGRAM 21

14. PROGRAM 18 acuize 26. PROGRAHM 22

15. PROGRAM 11 ACF995 27. PROGRAH 23

16. PROGRAKM 12 28. PROGRAM 24

LINE # TO CHANGE (F2-CONTINUED), CR-HEXT, D-DELETE, I-IHSERT, F4-NEW ENTRY ..
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Device Usage Update (SMU310)

Function

This program allows the user to update terminal validity and printer usage for
groups of program designations. Each program may be updated individually
through the Program F/M or in groups defined by the user through this update.
All programs are initially set up with standard values but the user may update
the values to fit the needs of the individual system.

User Inputs

The following inputs are involved in running the Device Usage Update program:
1. Beginning Program

Enter the beginning program to update (6 characters). CR defaults to FIRST.

2. Ending Program

Enter the ending program to update (6 characters). CR defaults to LAST.
3. Program Type

Enter the program types side by side to update (in any combination): File
maintenance, Entry, Inquiry, Print, Report, Update, Selector menu. CR defaults
to ALL.

4, Terminal

Enter up to seventeen 3-digit terminals side by side to update (0-999 based on
the number of terminals used as set in the system control record). When
entering terminal numbers with less than three characters, press the space bar
before entering the number. CR defaults to ALL and input #5 is skipped.

5. Valid

Enter Y, N or S-same to determine for each terminal entered in input #4
whether it is a valid terminal for the program(s) being updated. F2 sets the
remaining terminals to the validity of the previous terminal. F3 sets the
remaining terminals to S.

6. Printer

Enter N-no printer used, O-printer used, no operator selection (always uses
default printer), 1-printer used, selection only if in use, or 2-printer used,
selection always, to determine the printer usage for the program(s) being
updated for each terminal. Enter S if the printer flags should stay the same and
not change from how they are currently set. F2 sets the remaining terminals to
the number of the previous terminal. F3 sets the remaining terminals to S.

7. Normal

Enter the normal (default) printer for each terminal. F2 sets the remaining
terminals to the printer of the previous terminal. F3 sets the remaining
terminals to S.
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Technical Notes

Printing proceeds by reading through the program designation file (SMNAME)
and updating all information that meets the criteria entered.

FILES USED - SMCNTL, SMTRCT
FILES UPDATED - SMNAME

L Device Usage Update [SMU310]
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Security System

The programs available on this menu enable the System Administrator to create
and maintain FACTS users and to set program security.

Users Login

Assign each FACTS user a user code, password, security levels, and company
codes. Each user can then log into the system and access only those companies
and programs for which they have been authorized.

Passwords & Security

There are three types of security available once a user signs on the system using
his/her password: user, password and terminal.

The first method of security is assigned to use up to 10 security codes (0-9).
Then each program (or menu) is assigned to one security code (initially set to 0)
in the Password & Security Code F/M.

The second method of security is assigning a password to a program (or menu)
in the Password & Security Code F/M.

The third is the valid terminals that may access programs which is set in the
Program F/M found on the menu setup menu.

User Tracking

The FACTS User Tracking feature enables the System Administrator to track
program usage on the system. User Tracking monitors and records program
entry, exit and usage time by user. User Tracking Removal enables the System
Administrator to remove the tracking information.
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User Code F/M (SMF410)

Function

This program allows the user to create and maintain user codes for each user of
the system. Each user code is assigned a password, security levels, valid
companies they may work in, fax phone number, suffix and cover page,
whether user tracking is used and the initial menu to display. These entries, in
conjunction with the program security levels and passwords, provide maximum
security and privacy of information.

When signed on, the user’s code is displayed in the upper right corner of the
menu screen. As the users attempt to access a program, their security code is
checked against the program’s security code. The codes must match for users to
use the program.

Program security codes are assigned through the Password & Security Code
F/M. Each program is assigned to one security code. Initially, all programs are
set to 0. The user may then modify security codes and allow specific users into
specific programs.

User Inputs

The following inputs are involved in creating a user code record:

General tab
1. User Code

Enter the code to be used to identify this user (up to three characters), i.e., it is
usually the user’s initials. ALL is not accepted.

2. Name

Enter the user’s name (up to 25 characters). At lease one character must be
entered.

3. Initial Menu

Enter the initial menu displayed on the screen for the user code after signing on
to the system. F2 allows a search (ref. 3). CR initially defaults to the master
menu (MMS000).

4. Phone Number

Enter the user’s phone number (up to 20 characters). This phone number will
print on the fax cover page for the sender phone variable. This is useful to let
the fax recipient know the direct phone number or extension of the sender.

5. Fax Suffix

Enter any suffix necessary for the user when sending fax requests. The use of a
fax suffix is defined in the FaxLink Static Control F/M.
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6. Fax Cover Page

Enter the code (up to 4 characters) of the fax cover page for this user. This is the
default cover page that will be assigned when this user creates a fax request.

7. SLS/TER Code

Enter the salesperson/territory code that is assigned to this user code (3
characters).

8. Call Grace Period

Enter the number of days (0 to 999) that the user has to make a past due call.

9. Call Code

Enter the code (up to 10 characters) that this user enters to access long distance.

10. Home Directory

Enter the users home directory (up to 40 characters) or press CR. The directory
entered must be a valid. Press F2 for a search for directories. This field is
currently for informational purposes, but has been added for future use.

11. Graphical User

Enter CUI if you want this user to operate in character-based mode. Enter Win
98 if you want this user to operate in the graphical user interface (GUI)
environment using a Windows 98 operating system or Win XP if you want this
user to operate in the graphical user interface (GUI) environment using a
Windows XP operating system.

Note: If you select Win XP when you are not running Windows XP as the
operating system, you can select from the available themes: Default (Blue),
Silver, and Olive Green. If you are running Win XP, the theme is taken from the
XP Theme you selected. After you change either of these fields, you must sign
out and back in for the change to take effect.

Note: XP Style on a machine running Windows 98/2000: The XP Style can be
chosen even if the user is running Windows 98/2000. FACTS itself will have an
XP look and feel, but this will not affect any other applications. Also, since the
title bar is controlled by Windows, it will still look like a Windows 98/2000 title
bar. If you select Win XP when you are not running Windows XP as the
operating system, you can select from the available themes: Default (Blue),
Silver, and Olive Green. If you are running Win XP, the theme is taken from the
XP Theme you selected. After you change either of these fields, you must sign
out and back in for the change to take effect.

Special topic: Changes to the User Interface in XP Mode:
There are 5 main categories of changes to the user interface in XP mode:

Buttons: Buttons are rounded and have a gradient (some more than others
depending on the theme chosen). Buttons have a colored outline when the user
rolls over them with a mouse.
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Tab Folders: All tab folders have a lighter background that

clearly distinguishes them from the rest of the screen. The tabs are only as wide
as the tab title requires, instead of being justified to the width of the screen. The
active tab has a color highlight at the top.

Fonts: Fonts are smaller on tab folders and in data fields to reflect the Windows

XP style fonts. Also, the frame text colors have changed to reflect the XP
themes.

Checkboxes: Checkboxes now have colored checks.

Input Fields (Controls): Fields are flat (not "3-D") with a line around them.

Security tab

1. Password

Enter the password to be used by this user for entry into the system (up to 6
characters). F2 deletes an existing password. CR initially defaults to blank.

2. Valid Companies

Enter up to 10 valid two-character company numbers side by side which the
user may access. F3 defaults to ALL.

3. Track User

Enter N or Y to indicate whether to track the user, if the user tracking system is
setto Y (on). CR initially defaults to N.

4. Require Escape Code

Enter Y or N to indicate whether this user must enter an escape code before the
can abort out of an error. If you enter Y, the user must contact the system
administrator for the escape code when the window describing the error
condition is displayed. By doing this, you prevent users from aborting out of
programs that may be updating files without first checking with the system
administrator. If you enter N, this user will be able to abort from any error in
any type of program. From an error handling window, a user set up with N
will also be able to enter SS to escape into the workspace of the current progra

or ES to escape into the called program workspace. However, regardless of the

entry in this field, all users are able to abort from an error resulting from a
locked record.

5. Security Codes

Enter security codes side by side for this user (0-9). Security codes may be any

digit between 0 and 9 and may be assigned in any combination. F3 defaults to
ALL. CRinitially defaults to 0.

6. Administrator Privileges:

User-defined Fields

Technical Note:
Certain programs
may always require
an escape code (for
example, the DSR
update). If Z8$ is set
to “**” prior to
calling the standard
escape routine, all
users will be
required to enter an
escape code
regardless of this
flag or which error
was encountered.

Indicate whether you want to allow this user to configure user defined fields for any of the following
maintenance programs: Item F/M (ICF910), Vendor F/M (APF910), Ship-To F/M (ARF920), or

Customer F/M (ARF910).
To configure user-defined fields:

After you select the checkbox above, exit FACTS and log back in to allow this change to take effect.

Copyright © 1984-2004 Aperum, Inc.
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Access the desired file maintenance program: Item F/M (ICF910), Vendor F/M (APF910), Ship-To
F/M (ARF920), or Customer F/M (ARF910).

Access the User-Defined screen of the selected file maintenance.

Select the Configure icon or press F1, and the system displays the User-Defined Field Characteristics
Entry (SMC996) program, where you can enter user-defined fields and the characteristics associated
with the field. Refer to the User-Defined Field Characteristics Entry (SMC996) topic for additional
details.

Notes

Indicate whether you want to allow this user to this user as a Note
Administrative User.

This user has access to the Admin Menu on Note Entry (SME710). From the
Admin menu, you can access the Notes Security screen, which allows you to
determine which users have Note Entry access by security code, whether users
can create/edit categories for note types, and manage category creation by
security code

Deleting User Records
To delete a user code record, enter D at the selection prompt.

If the user code exists in the Remote User File, a message to that effect will
display. Press CR to continue.

In all cases, the following prompt will display: Are you sure you want to
delete this record? Enter N or YES to verify the deletion. CR defaults to N.
Warehouse Security

Warehouses For Order Entry Header

To access the Warehouses for Order Entry Header screen, enter the user code
and press W for Warehouse Security.

Technical Notes

5-6

FILES USED - SMCNTL, SMNAME
FILES UPDATED - SMZART
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Password & Security Code F/M (SMF420)

Function

This program allows the user to create and maintain passwords and security
codes for all programs and menus. By doing so, the user may effectively
determine those people who are allowed to use a program or menu. This
program may be used as necessary to maintain passwords and security codes.
However, it is suggested that this program be assigned a password to maintain
security. All programs initially are assigned a security code of zero. The user
may assign a security code and password to any program or menu. During
normal processing, the security code is checked and validated. If there is a
password on a program or menu it must then be entered to be accessed by the
user. The Program Designation Inquiry and Program Name Listing may be
useful to help identify the names of programs requiring a security code or
password. Each user is assigned security codes through the User Code F/M.

User Inputs

The following inputs are involved in creating or maintaining a password and security code record:
1. Program Name

Enter the program name (6 characters). The entry must be a valid program or
menu in the program names file. Entry of a valid program name displays the

program description, password (if there is one) and security code. F2 allows a
search (ref. 3).

2. Password

Enter the password used to access this program (6 characters). Press F3 to
delete an existing password. CR initially defaults to blank.

3. Security Code

Enter the program security level number (0-9). Each level is equal and there is
no hierarchy involved. Some users define security codes by module or parts of
modules. For example, AP programs are code 1, AR programs are code 2, etc.
Then users can be assigned security codes depending on the module(s) they use.
Any program within a module may have a different security code. CR initially
defaults to 0.

Technical Notes

FILES USED - SMCNTL
FILES UPDATED - SMNAME
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Security Code Setup (SMU410)

Function

This program allows the user to change security codes by any range of
programs and any selected program types.

User Inputs

The following inputs are involved in Security Code Setup:
1. Beginning Program

Enter the beginning program to change security code (6 characters). CR
defaults to FIRST.

2. Ending Program

Enter the ending program to change security code (6 characters). CR defaults to
LAST.

3. Program Type

Enter the program type(s) to change side by side (in any combination): File
maintenance, Entry, Inquiry, Print, Report, Update, Selector menu. CR defaults
to ALL.

4. Current Security Code

Enter the current security code(s) to change side by side (0-9). CR defaults to
ALL.

5. New Security Code

Enter the new one-digit security code to replace the current security code (0-9).
CR defaults to 0.

Technical Notes

FILES USED - SMCNTL
FILES UPDATED - SMNAME
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User Tracking Removal (SMU420)

Function

This program allows you to remove user tracking information. Before running
this program, run the User Tracking Report to provide an audit trail of what is
to be removed.

User tracking is only available if the Use User Tracking flag is selected or set to
Y in the System Control F/M Program (System Management — File Maintenances
- System Control F/M). User tracking keeps a record for each user of what
programs are used, the time entered into and exited from the program, total
time in program and any special notes concerning proper use of the program
(example - if escaped out of).

User Inputs

The following inputs are involved in removing user tracking information:
1. Beginning User

Enter the beginning user (up to 3 characters). CR defaults to FIRST.
2. Ending User

Enter the ending user (up to 3 characters). CR defaults to LAST.
3. Cutoff Date

Enter the date through which user tracking information will be removed (ref. 1).
CR defaults to the system date.

Technical Notes

Removal proceeds by reading through the user-tracking file (SMUSRT) for all
information that meets the criteria entered and deleting it from the file.

FILES USED - SMCNTL, SMZART
FILES UPDATED - SMUSRT
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Note Entry (SME710)

Use Note Entry to enter and maintain notes for AR documents, customers,
items, and vendors.

The system displays notes information from several points within FACTS:
System Management->Security System menu (SMS400)

Item F/M (ICF910), Vendor F/M (AP910) and Customer F/M (ARF910) - You
can access the Notes Entry window from the View menu option.

Graphical Users: Choose View->Notes from the menu bar.
Character Users: Press F10-Menus and choose View-> Notes from the menu.

The system displays the Note Entry program and any notes on file for the
selected record will appear in the browser in the lower portion of the Notes
Entry window. If you display a record for a customer or an item has an urgent
note attached to it, the system automatically displays the urgent note in the
Important Notes on File dialog box when you access the selected record.
Double click a note line to display the View Note screen, which lists the note
subject and text, note type, category, date created, and date edited.

Item Inquiry (IC1610), AP Vendor Inquiry (ARI1610), PO Vendor Inquiry
(POI610), PO Document Entry (POI1620), AR Customer Inquiry (ARI610), SO
Customer Inquiry (SOI1610) and SO Document Inquiry (SOI1620) — Notes
information is available from the Notes view and from the View menu option.
Choose View—>Notes from the menu bar. The system displays the Note view
and any notes on file for the selected record will appear in the browser in the
lower portion of the window. Select the Line Detail button to display the View
Note screen, which lists the note subject and text, note type, category, date
created, and date edited.

For Item Inquiry (IC1610), AP Vendor Inquiry (ARI610), PO Vendor Inquiry
(POI610), or Customer Inquiry (ARI610), select Options—>Item Note Entry,
Vendor Note Entry, or Customer Note Entry respectively to enter or modify
notes for the specified item or customer in the Note Entry (SME710) program.

Graphical Users: Choose View->Notes from the menu bar.
Character Users: Press F10-Menus and choose View-> Notes from the menu.

The system displays the Note view and any notes on file for the selected record
will appear in the browser in the lower portion of the window. Select the Line
Detail button to display the View Note screen, which lists the note subject and

text, note type, category, date created, and date edited.

Item Search and Customer Search — You can access notes information from
searches. You can access the Notes Entry window from the View menu option.
Choose View->Notes from the menu bar.

Character Users: Press F10-Menus and choose View-> Notes from the menu.

Type SME710 at the Access Code menu prompt to directly access Note Entry
(SMET710).
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You can view and/or enter item, vendor or customer notes (as appropriate)
from the following FACTS entry programs

SO Quote Entry (SOE110)

Quick Look in SO Entry (SOC350)

Order Entry (SOE210)

Order Confirmation (SOE310)

Direct Invoice Entry (SOE510)

Credit Memo Entry (SOE330)

Counter Sales Entry (SOE510)

Blanket Sales Order Entry (SOE710)

Customer Returns Entry (SOE810)

Hold Selection (SOE230)

Recurring Document Entry (SOE350)

PO Entry (POE120)

PO Receipt Entry (POE210)

Non-PO Receipt Entry (POE220)

Invoice Receipt Entry (POE310)

Estimate Entry (JCE110)

UM Selection & Entry (ICC170)

Quick Item Add (ICF020)

When creating or editing documents and lines, the system automatically
displays urgent notes for items, vendors, and customers in the Important Notes
on File (SMI1710) screen.

This screen displays a listing of all urgent notes, by note type and category, for
the specified customer, vendor, or item. Double click a note in the browser to
display the View Note screen, which lists the note subject and text, note type,
category, date created, and date edited. Depending on your security settings for
notes, the system displays the Note Entry (SME710) screen which allows you to

enter or modify information for notes. For detailed information on notes
processing, refer to the Note Entry (SME710) topic.

Character Users: Press F10-Menus to access Notes from the menu.
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You can also access notes directly from the main screen of programs that use the
3-Level Entry Driver instead of requiring a menu option. The programs
include: Transfer Entry (ICE320), Shipment Confirmation (ICE 330), Receipt
Confirmation (ICE340), SO Quote Entry (SOE110), Order Entry (SOE210), Order
Confirmation (SOE310), Direct Invoice Entry (SOE510), Credit Memo Entry
(SOE330), Counter Sales Entry (SOE510), PO Entry (POE120), PO Receipt Entry
(POE210), and Non-PO Receipt Entry (POE220). On the left side of the line item
browser, you can select:

C. to access Note Entry (SME710) for the customer specified in the program.
1./ to access Note Entry (SME710) for the item highlighted in line item browser.
Vi to access Note Entry (SME710) for the vendor specified in the program.

D to access Note Entry (SME710) for the transfer header record specified in the
program.

L. to access Note Entry (SME710) for the transfer line record highlighted in the
line item browser.

Character Users: In the Notes: area of the screen, just above the line item
section, the system displays CUST, VEND, TRDH, TRDL, or ITEM to indicate
that notes are present. Press F10-Menus to access Notes from the menu.

Note Categories

Notes are sorted and stored by note type and category. There are six note types
available: ARDC (AR document), CUST (customer), ITEM (item), TRDH
(transfer document header), TRDL (transfer document line) and VEND
(vendor). For each of these note types, there are system generated categories,
such as GEN. You can associate an unlimited number of categories depending
on your system’s Note Admin User setting on the Security view of Company
Control F/M. You can define a specific user as the Notes Admin User or you
can set this field to None so that note categories cannot be created for the
specified company. For the Note Admin User defined on the Security view of
Company Control F/M, the Note Entry program contains additional Admin
and Category menu options.

Menu Options

From the Admin menu, you can access the Notes Security screen, which allows
you to enter security settings for note types. On this screen you can manage
which users have Note Entry access by security code, whether users can
create/edit categories for note types, and manage category creation by security
code. Refer to the Notes Security for Customer/Item/AR Doc/Vendor Notes
topic for details.

From the Category menu, you can access programs to edit, delete, and create
note categories. Any note type can have an unlimited number of additional
information fields associated with it, and any category of notes can have an
unlimited number of additional information fields associated with it. The
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Category menu is available to the Note Admin User set on the Security view of
Company Control F/M and for general users based on setting on the Notes
Security Setting for Customer/Item/Vendor Notes screen. Refer to the Creating
Categories topic for details.

From the File menu, you can select the Print menu option to access the Print
Options screen, which is used to print notes by date range, category, or urgent
note status.

Input Descriptions
Use the following input descriptions to enter information for notes:

Note Type

The type of note you want to modify or enter: ARDC (AR document), CUST
(customer), ITEM (item), TRDH (transfer document header), TRDL (transfer
document line) or VEND (vendor). Press F2 or the # icon to search for Note
Types.

The Note Type you select determines the inputs that the system displays next.

Associated Fields: Customer, Document and Continuation # (for ARDC note
type), Customer (for CUST note type), Item (for ITEM note type), Ticket #, Ship
#, Line # (for TRNL note type), Ticket #, Ship # (for TRNH note type) or Vendor
(for VEND note type).

Enter the information for the inputs that the system displays for the Note Type
you specified. You can press F2 or the # icon to search for customers, items,
and documents.

Category

The category for the note entry, such as General or Urgent. The system displays
the category associated with the setting in the Note Type file or the user
preference file as the default. If there is only one category on file for the note
type, the system uses it as the default.

Urgent Only

Indicates that you want to display only those notes that are designated as
urgent for the Note Type, associated fields, and Category combination entered.

In the browser in the lower portion of the screen, the system displays a list of
available notes for Note Type, associated fields, and Category combination
entered. The Notes browser displays the note date and time, urgent flag,
subject and user that created the note.

Adding, Modifying, and Deleting Notes:

Graphical Users:

If there are no notes available, select + to add a note if you have the authority
to create notes and the category has not been deactivated. If notes exist you can:

Select the [ icon to make modified the highlighted note.
Select the ®® icon to add a note.

Select the > icon to delete the highlighted note.
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If you select *+ toaddor E to modify a note, the system displays the Note
Entry details screen. The Note Type, associated fields, and Category
combination entered on the main screen display for reference.

Character Users: If there are no notes available, enter A to add a note if you have the authority to
create notes and the category has not been deactivated. If notes exist you can:

Enter a note line number to modify it or enter D to delete a note.

If you select to add or to modify a note, the system displays the Note Entry details screen. The Note
Type, associated fields, and Category combination entered on the main screen display for reference.

Subject

Enter or modify the subject for the note.
Tip: Note that once you enter a subject you can save the note even if you have
not yet entered any note text or additional information.

Urgent

Indicates the note should be classed as urgent. Notes marked urgent
automatically display in Sales Order Entry programs for customers, document
header records, document line records, and items.

Note

Enter or modify the text for the note.

Contact

Enter the contact person associated with the note.

Reason

Enter the reason for the note.

After completing the inputs, you can:

Graphical Users:

Select OK to complete the note entry and return to the main screen.

For Item Notes only, you can also Exports to access the Export Selections from
Items Notes (SME711) screen, which is used to export items notes to transfer
document line notes.

Select Cancel to return to the main screen without entering a note.
When you have finished adding, modifying and deleting notes, you can select:
Print to select of a range of notes to print, and print them to the selected printer.

Lines (for Note type TRDH (transfer document header)) to access Note Entry
for transfer document lines associated with the transfer document header.

Done to exit the Note Entry (SME710) screen.

Character Users: Enter:

P-Print to access the Print Options screen that allows you to print a single note (highlighted in the
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browser). Press F10-Menus, File=>Print from the menu to access the Print Options screen that allows
you to select of a date range of notes to print for the specified notes type and selected the associated
fields (Customer, Document and Continuation # (for ARDC note type), Customer (for CUST note
type), Vendor (for VEND note type), Item (for ITEM note type)), and print them to the selected printer.

L-Lines (for Note type TRDH (transfer document header)) to access Note Entry for transfer document
lines associated with the transfer document header.

F3-Done to end Note Entry and exit the Note Entry (SME710) screen.

m 01-5pecialty Distributors, Inc.. Mote Entiy [SME710)
File Category Help

Note Type [TEM b | iem

term | 1aa M| Pallet Loading Hand Truck 1000 Ib capacity
Category [GENR 84| General Information Urgentonly [

Date/Time
i g TN GG FTi—
01/09/2003, 3:16 P h UNBYWT GFD TAFP
0105/2003, Z:17 PM ing note GUl
add

62|+

List Fram I M ]

Erint | Dane
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How to enter and maintain notes for AR documents,
transfer tickets, customers, items, or vendors

1.

2.

Type SME710 at the Access Code menu prompt to directly access Note Entry (SME710).

In the Note Type field, enter the type of note you want to modify or enter. You can select from:
ARDC (AR document), CUST (customer), ITEM (item) TRDH (transfer document header), TRDL
(transfer document line) or VEND (vendor). Press F2 or the # icon to search for Note Types. The
Note Type you select determines the inputs that the system displays next.

For the Associated Fields: Customer, Document and Continuation # (for ARDC note type),
Customer (for CUST note type), Vendor (for VEND note type), Ticket #, Ship #, Line # (for TRNL
note type), Ticket #, Ship # (for TRNH note type), or Item (for ITEM note type), enter the
information for the inputs that the system displays for the Note Type you specified. You can
press F2 or the 8 icon to search for customers, items, and documents.

In the Category field, enter the category for the note entry, such as General or Urgent. The system
displays the category associated with the setting in the Note Type file or the user preference file
as the default. If there is only one category on file for the note type, the system uses it as the
default.

Graphical Users: Select the Urgent Only checkbox to indicate that you want to display only those
notes that are designated as urgent for the Note Type, associated fields, and Category
combination entered.

Character Users: Enter Y for Urgent Only to indicate that you want to display only those notes
that are designated as urgent for the Note Type, associated fields, and Category combination
entered.

In the browser in the lower portion of the screen, the system displays a list of available notes for

Note Type, associated fields, and Category combination entered. The Notes browser displays the
note date and time, urgent flag, subject and user that created the note.

Graphical Users: If there are no notes available, select =+ t0 add a note if you have the authority
to create notes and the category has not been deactivated. If notes exist you can;

Select the E: icon to make modified the highlighted note.
Select the ** icon to add a note.

Select the * icon to delete the highlighted note.

Character Users: If there are no notes available, enter A to add a note if you have the authority to
create notes and the category has not been deactivated. If notes exist you can:
Enter a note line number to modify it or enter D to delete a note.

If you select to add or to modify a note, the system displays the Note Entry details screen. The
Note Type, associated fields, and Category combination entered on the main screen display for
reference.
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10.

11.

5-22

Enter the following information for the note:
Subject--Enter or modify the subject for the note.

Urgent--Indicate the note should be classed as urgent. Notes marked urgent automatically
display in Sales Order Entry programs for customers, document header records, document line
records, and items.

Note--Enter or modify the text for the note.
Contact--Enter the contact person associated with the note.

Reason--Enter the reason for the note.

After completing the note inputs, you can:

Select OK or F3 to complete the note entry and return to the main screen.
Select Cancel or F4 to return to the main screen without entering a note.

For Item Notes only, you can also Exports to access the Export Selections from Items Notes
(SME711) screen, which is used to export items notes to transfer document line notes.

When you have finished adding, modifying and deleting notes, you can select:
Graphical Users:

Print to access the Print Options screen that allows you to print a single note (highlighted in the
browser). Select File->Print from the menu to access the Print Options screen that allows you to
select of a date range of notes to print for the specified notes type and selected the associated
fields (Customer, Document and Continuation # (for ARDC note type), Customer (for CUST note
type), Vendor (for VEND note type), Item (for ITEM note type)), and print them to the selected
printer.

Lines (for Note type TRDH (transfer document header)) to access Note Entry for transfer
document lines associated with the transfer document header.

Done to exit the Note Entry (SME710) screen.
Character Users: Enter:

P-Print to access the Print Options screen that allows you to print a single note (highlighted in the
browser). Press F10-Menus, File>Print from the menu to access the Print Options screen that
allows you to select of a date range of notes to print for the specified notes type and selected the
associated fields (Customer, Document and Continuation # (for ARDC note type), Customer (for
CUST note type), Vendor (for VEND note type), Ticket #, Ship #, Line # (for TRNL note type),
Ticket #, Ship # (for TRNH note type) or Item (for ITEM note type)), and print them to the
selected printer.

L-Lines (for Note type TRDH (transfer document header)) to access Note Entry for transfer
document lines associated with the transfer document header.

F3-Done to end Note Entry and exit the Note Entry (SME710) screen.
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Notes Security for Customer/Item/Vendor/Transfer
Ticket/AR Document Notes

This screen is available to the Note Admin User defined on the Security view of
User Code F/M to determine which users have Note Entry access by security
code, whether users can create/edit categories for note types, and manage
category creation by security code. From the Admin menu, you can access the
Notes Security screen. You must enter a note type in Note Entry (SME710)
before you can access this screen.

Input Descriptions
Use the following input descriptions to enter information for notes:

Notes Entry Security Code

The security codes that determine which users can access Note Entry (SME710).
Security codes are assigned to users on the Security view of User Code F/M
(SMF410). The system compares the code entered here with those assigned to
users and determines whether a user has proper security to enter notes.

User Can Create/Edit Categories

Indicate whether users can create or edit categories for the note type specified.
You can select from Y-yes, N-no, or S-With Security Code. This setting
determines which Category menu options (Creating Notes and Editing Notes)
are available to user in Note Entry (SME710).

Create Category Security Code

The security codes that determine which users can access creating categories via
the Category-> Creating Categories menu option in Note Entry (SME710). This
input is only available if you select S-With Security Code for the User Can
Create/Edit Categories input (above).

Security codes are assigned to users on the Security view of User Code F/M
(SMF410). The system compares the code entered here with those assigned to
users and determines whether a user has proper security to create categories.
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Creating Categories

Use the Creating Category screen to add categories for a note type. From the
Category menu, you can access programs to edit, delete, and create note
categories. Any note type can have an unlimited number of additional
information fields associated with it, and any category of notes can have an
unlimited number of additional information fields associated with it.

Notes are sorted and stored by note type and category. Notes processing comes
with a standard category for each note type. For each note type: ARDC (AR
document), CUST (customer), ITEM (item), TRDH (transfer document header),
TRDL (transfer document line) and VEND (vendor), the system provides a
GENR-general note category. You can create additional categories using the
Creating Category screen. User-created categories have a 3 character ID.
System generated categories have only 3 characters.

Screens from the Category menu are available to the Note Admin User set on
the Security view of Company Control F/M and for general users based on
setting on the Notes Security Setting for Customer/Item/Vendor/Ar
document/IC transfer ticket Notes screen.

You can associate an unlimited number of categories depending on your
system’s Note Admin User setting on the Security view of Company Control
F/M. You can define a specific user as the Notes Admin User or you can set
this field to None so that note categories cannot be created for the specified
company.

Input Descriptions
Use the following input descriptions to enter information for notes:

Category ID

The category ID code. This code must begin with a dash and contain 3
characters.

Inactive

Indicates the category should be classed as inactive. Inactive categories cannot
be used in creating notes. Inactive note categories do not automatically display
notes.

Description
The category description.
Security Code Required to View Notes

The security codes that determine which users can view notes. Security codes
are assigned to users on the Security view of User Code F/M (SMF410). The
system compares the code entered here with those assigned to users and
determines whether a user has proper security to view notes.
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Security Code Required to Create Notes

The security codes that determine which users can create notes. The system
compares the code entered here with those assigned to users and determines
whether a user has proper security to create notes.

Allow Changing Notes

Indicate whether you allow notes in this category to be changed. You can select
from: A—Always, U—Only Notes They Created, N—Never. Select A to
indicate that you allow notes to be changed in this category with no restrictions,
U to indicate that users can only change the notes they create, or N to never
allow notes in this category to be modified.

Allow Deleting Notes

Indicate whether you allow notes in this category to be deleted. You can select
from: A—Always, U—Only Notes They Created, N—Never. Select A to
indicate that you allow notes to be deleted in this category with no restrictions,
U to indicate that users can only delete the notes they create, or N to never
allow notes in this category to be deleted.

Change/Delete Override Security Codes

Enter the security code to allow users to change and delete notes even when the
category settings (that you enter above) don’t allow it. The security code you
enter here overrides the Allow Deleting/Changing Notes settings. Users who
have this security code assigned to them can still modify or delete notes in this
category.

Defaults

Select the Defaults option to access the Category Defaults for Notes screen
where you can enter a default subject and default text to display for notes
entered in this category.

Select the OK button (character users press F3) to complete the category or the
Cancel button (character users press F4) to return to Note Entry (SME710)
without creating a category.
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m Creating Category

Category 1D I Inactive [
|
|

Description
Security Code Required to Yiew hotes gl Hone
Security Code Required to Create Notes | gl None
Allow Changing Motes IA-Aquays j
Allow Deleting Motes  [& - aways =
ChangelDelete Cverride Security Code | gl Hone
ok | Defauts | cancel |

|EnmrmecaMgawchnde(mumbemnwnhadasm

E% Note Entiy (SME710) [_]O]
Help

B1-Specialty Distributors, InNote Entry SHE71 8
Mote Type ITEN Item

Item 1116 Steel Storage Cabinet 36 x 24

Category GEHR General Information Urgent Only H

Elil ([Creating Category

tategory ID | ... Inactive M
Description
Security Code Required to Uiew Notes None

Security Code Required to Create Motes HNone
Allow Changing Notes © Always

Allow Deleting Motes A Always

Change/Delete Override Security Code HNone

Enter the category ID code {must begin with a dash}), F4-Backup
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Important Notes on File (SMI1710)

If you display a record for a customer, vendor, or an item has an urgent note
attached to it, the system automatically displays the urgent note in the
Important Notes on File dialog box when you access the selected record.

You can:
“ 01-FACTS 7.3 Development, Important Notes on File (SMI710) £ Sharing «
Help
Customer C100 Southeastern Industrial Supphy
Mote Type/Categony Urgent | Subject
: Customercoll Jufut d
CustomerGeneral Information UMYFTD Y TRD
CustomerGeneral Information i t=t
Customer@eneral Information Ikijhgfdssdfghjldghgfdsdfghjk
| | 1|

Done |

| 1\.!]1 -Specialty Distributors, Inc., Important Hotes on File [SMIT10] !IEIE

, Help

Custamer C101 Deluxe Equipment Warehouse

Mote TypesCategony Urgent | Subject

neral Information

1] | =l

Alltotes | | Wraentonl | Print | Entry Done |

(Graphical Users)

Double click a note line to display the View Note screen, which lists the note
subject and text, note type, category, date created, and date edited.

Highlight a note and select the Print button to access the Print Options screen.
You can specify to print the note to a selected printer or file and specify margin
settings for the printout.

Select the Entry button to access Note Entry (SME710), where you can edit the
urgent note, if you have permission to edit the associated note category.

Select the All Notes button to display all notes for the specified item or
customer.
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Select the Urgent Only button to display only notes marked as urgent.

Select the Done button to exit the Notes feature.

LY Customer F/M [ARF910) [_ O] =]

Help

#1-Specialty Distributors, InCustomer F/H nRFo1d

*_ Customer C188 Southeastern Industrial Supply

2. Hame Southeastern Industrial Supply

3Important Hotes on File ({SHMI718)

L4 |Customer C1868 Southeastern Industrial Supply

5

[illHote Type/Category Urgent Subject

FAlICustomer/coll jyfyt d

8 |Customer/General Inform Mow is the time

9 Customer/General Inform This is a note for customer C188. Hore not
Customer/General Inform Mow is the time... —

18| Customer/General Inform tst
Customer/General Inform 1kijhgfdssdfghjkkjhgfdsdfghjk

13

16

Urgent Only, Frint

F3-Done .

Arrows: Up=Prev, Down=Hext, Left/Right=Lines, PqUp, PgDln, Home, End First line
| 7

(Character Users)

Enter the line number for the note and press Enter to display the View Note screen, which lists the
note subject and text, note type, category, date created, and date edited.

Enter the line number for the note and press P-Print to access the Print Options screen. You can
specify to print the note to a selected printer or file and specify margin settings for the printout.

Enter the line number for the note and press E-Entry to access the Note Entry (SME710), where you
can edit the urgent note, if you have permission to edit the associated note category.

Press A-All Notes button to display all notes for the specified item or customer.
Press U-Urgent Only button to display only notes marked as urgent.

Press F3 to exit the Notes feature.
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Export selections from Item Notes (SME711)

Use this screen to select notes for the Item note type and export them to TRDL
(transfer document line) notes.

Select the Exports button to access the Export selections from Item Notes
(SMET711) screen, if there are exports defined for the specified Note Type and
Category. Highlight the note you want to export and press the Toggle button.
Click the Toggle option to cycle through the settings: Don’t Export, Export, or
Required to indicate the export setting for the item note you want to export.
When the note is selected for export the ‘Export’ column in the browser contains
the word ‘required’. If you do not want to select any notes for exporting, press
None. Press Done or F3 to export your selections (if any) and exit the screen.

\01 -7.4 Development, Export selections from Item Notes [SME711]) H= B3

[
Help

To Mote Dese Categony

TRHL Transfer Line General Information

Mone | Toggle | Done |
T\ Note Entry [SHE710] [_ Ol x]
Help
81-7.4 Development Hote Entry SHE718
Hote Type I1TEM Item
Item 1116 Steel Storage Cabinet 36 x 24
rHote Entry
Hote Type ITEN Item
Item 11168 Steel Storage Cabinet 36 x 24
rExport selections from Item Hotes {SHE711)
[AMF=port To Hote Desc Category

[ IRequired TRHL Transfer Line General Information

Hone, Toggle
F3-Done .

=Prev, Down=Next, Left/Right=Lines, PqUp, PgDn, Home, End First line

&
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Banking and Check System

All bank accounts are set up as separate banks (may have same descriptions)
through the Bank F/M program. Each bank set up is used system wide.

The banking system maintains the bank account balances through postings from
accounts payable when checks are written, from accounts receivable when cash
is posted (deposits are made) and when invoices are entered as cash invoices,
from payroll when checks are written, and from sales orders when invoices are
entered as cash invoices. Bank account balances are also maintained by the user
making adjustments (for service charges etc.) through the Adjust Bank Balance
program.

Checks are stored (from AP and PR systems) for check reconciliation. The
Reconcile Checks program allows the user to enter whether checks have cleared
the bank. The Check Listing program is then printed to list all cleared checks
and then optionally remove them.

Bank information is available for display through the Bank Inquiry program
which displays general information, ledgercards stored and checks written.
Bank notes may also be entered and displayed in the inquiry.
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LT A)

FACTS 7.4 Development- Comparny 01

o

Change Company

i

Set Day and Time

Ee

Menu Setup System Installation
&

System Management

-~ Repors & Prints
Inquiries

7

System Management

&

AdjustElank Balance

Bank Inquiry
Check Listing
Set Standard-
Compressad Print Meszages SZEE IF_;ahﬁgercard Removal

Banking and Checdk

-] ity
ecurity System e

[=

End-of-Feriod Checdhlist

Atcess Code I ﬁl

File Maintenances

Check Reconciliation F/i

™ Company 01, FACTS 7.4 Development M=l 3
Help
81/86/84 Tuesday System Management JLW TEd 1:58 pm
B1-FACTS 7.4 Developme Banking & Check System SMS50a
1. Reconcile Checks
?_. Adjust Bank Balance
3. Bank Inquiry
4. Check Listing
5. Bank Ledgercard Remowval
6. Bank F/H
7. Check Reconciliation F/H
Selection
ENTER SELECTION #, ACCESS CODE, 'OFF', ARROWS, F4-PREVIOUS HMEHU
| Y
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Reconcile Checks (SME510)

Function

This program allows the user to record the period that checks clear the bank.
After using this program, the customer may print the Check Listing to help
reconcile the bank statement.

If the flag Use Check Reconciliation is set to N through the AP static control
record, accounts payable checks are not available for reconciliation. If the flag
Use Check Reconciliation is set to N through the PR static control record,
payroll checks are not available for reconciliation.

The user may clear or unclear any checks in the check reconciliation file.
Checks are displayed in numerical order and several features make this an easy
process.

Displayed information for each check includes check number, payee (vendor
number and name or employee number and name) check date, check entry
period, clear period and check amount. If a check is a manual or void check, the
words VOID or MAN are displayed beside the check amount.

Checks are placed in the check reconciliation file by the update portion of the
AP and PR Check Registers. The Check Listing prints cleared checks, uncleared
checks, void checks or all checks to aid the user in reconciling the bank
statement.

User Inputs

The following inputs are involved in using the Reconcile Checks program:
1. Bank

Enter the bank code for the checks (2 characters). The entry must be a valid
bank code which displays the bank name. CR defaults to the first bank on file.
F2 allows a search (ref. 3).

2. Beginning Check

Enter the first check number to display (1-999999). CR defaults to the first check
on file for this bank. If the entered check is not found, the display begins with
the next highest check number in the file. An asterisk appearing next to the
check number indicates the preceding check is missing.

3. The program displays checks in numerical order until the screen is full. The
user then has the option to:

C - Clear - Allows the user to begin clearing checks by entering the
period and year the checks cleared the bank (PPYY). CR defaults to
the current period. The user now has the following options:

F1 - Skip-The check is skipped and moves to the next line.
F2 - Clear-The check is cleared and moves to the next line.
F3 - End-End the processing for this bank.
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F4 - Backup - After backing up, the user may change the clear period or
return to input #2 - beginning check by pressing F4.

U - Unclear - Begins unclearing checks. This means any check recorded
as cleared may be changed and stored as not cleared. The user must
enter the number of a cleared check in the check reconciliation file.
Entry of a valid check number highlights the check information. The
user is then asked OK TO UNCLEAR? CR defaultsto Y. Enter N if
check entered is the incorrect check.

CR - Continue - Clears the screen of currently displayed checks and
displays the next group of checks.

F3 - End - Returns to input #1 - bank code.
Technical Notes

FILES USED - SMCNTL
FILES UPDATED - SMCHKR

K% Reconcile Checks [SMES10]
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How to record the period that checks clear the bank

1.

2.

Access this program selecting System Management->Banking & Checks—>Reconcile Checks.

In the Bank input, enter the bank code for the checks (2 characters). The entry must be a valid
bank code that displays the bank name. The program defaults to the first bank on file. F2 allows
a search.

In the Beginning Check input, enter the first check number to display (1-999999).

Press Enter (CR), and the program defaults to the first check on file for this bank. If the entered
check is not found, the display begins with the next highest check number in the file. 1f an
asterisk appears next to the check number, it indicates the preceding check is missing. The
program displays checks in numerical order until the screen is full. For each check, the Reconcile
Checks program displays: Check number, Payee (vendor number & name or employee number
and name), Check date, Check entry period, Clear period, Check amount, and Void/Manual
check indicator (appears next to the check amount)

From the command prompt in the lower portion of the screen, you have the following options:
C Clear - Allows the user to begin clearing checks by entering the period and year the
checks cleared the bank (PPYY). The program defaults to the current period. The user now has
the following options:

F1 Skip-The check is skipped and moves to the next line.
F2 Clear-The check is cleared and moves to the next line.
F3 End-End the processing for this bank.

F4 Backup - After backing up, the user may change the clear period or return to input #2 -
beginning check by pressing F4.

U Unclear - Begins outstanding checks. This means any check recorded as cleared may be
changed and stored as not cleared — in other words, outstanding. Enter the number of a cleared
check in the check reconciliation file. Entry of a valid check number highlights the check
information. The program then asks OK TO UNCLEAR? The program defaults to Y. Enter N if
check entered is the incorrect check.

CR Continue - Clears the screen of currently displayed checks and displays the next group of
checks.

F3 End - Returns to the Bank code input.

When you have finished clearing/unclearing checks, press F3 to return to the Bank input where
you can enter another bank code or press F4 to exit the program.
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Adjust Bank Balance (SME520)

Function

This program allows the user to adjust the bank balance by bank code.

User Inputs

The following inputs are involved in adjusting a bank balance:
1. Bank

Enter the bank code (2 characters). CR defaults to the first bank on file. F2
allows a search (ref. 3).

Balance

The current bank balance is displayed.

2. Adjustment

Enter the adjustment amount (+/-9999999.99).
New balance

The new bank balance is calculated and displayed.

3. Date

Enter the adjustment date (ref. 1). CR defaults to the system date.

4, Memo

Enter the adjustment memo (up to 25 characters). F2 defaults to the previous
adjustment memo.

5. OK To Update?

Enter Y or N to indicate whether to update. CR defaults to Y and returns to
input #2.

Technical Notes

6-6

FILES UPDATED - SMCNTL, SMLEDG
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ES Adjust Bank Balance [SMES20]

Copyright © 1984-2004 Aperum, Inc. 6-7



Banking & Check System System Management—7.40

How to adjust the bank balance

6-8

1.

2.

Access this program selecting System Management->Banking & Checks—> Adjust Bank Balance.

In the Bank input, enter the bank code (2 characters). The program defaults to the first bank on
file. F2 allows a search. Once you enter a bank code, the system displays the current balance.

In the Adjustment input, enter the amount by which you need to adjust the balance (+/-
9999999.99). The program calculates and displays the new bank balance.

In the Date input, enter the date on which you are entering the adjustment. The program defaults
to the system date.

In the Memo input, enter a memo explaining the adjustment (up to 25 characters). Press F2 to
default to the previous adjustment memo.

The system displays the message: OK To Update? Enter Y or N to indicate whether to update.
Press Enter (CR) to defaultto Y.

The system returns to the Adjustment input where you can enter another adjustment. Press F4 to
exit the program.
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Bank Inquiry (SMI510)

Function

This program allows the user to display bank information. Available
information includes:

* General Information
* Ledgercards

*  Checks
* Notes
User Inputs

The following inputs are involved in displaying bank information:
1. Bank Code

Enter the bank code to display. Entry of a valid code displays the bank name.
CR defaults to the first bank on file. F2 allows a search (ref. 3).

2. Information

Enter the following information type to be displayed for this bank. When a type
is selected, the entire information display is highlighted. CR displays the next
bank on file and information based on the information type previously selected.

NOTE: On some implementations of Business Basic the system allows, and
prompts for, the user of arrow and function keys for special features. Please
refer to Appendix C.

G - displays general information including address, contact, phone number, bank account
number, current balance, general ledger number and use of ledgercards flag.
L - displays ledgercard information. Enter beginning date. CR defaults to the first date

with ledgercards stored. Information includes date, debit amount, credit amount,
balance, memo and register number.

C - displays check information. Enter beginning check number or CR defaults to first check
stored. Information includes check number, check date, check period, payee
number/name, check amount and clear date.

z

displays all notes recorded for this bank. If no notes exist for the bank displayed, the
system asks Enter notes for this bank? Enter N or Y to indicate whether to enter
notes for this bank. CR defaults to N and returns to the main input. If the user enters
a'Y, line numbers are assigned beginning with 010 and will automatically increment
by 10. Enter text (up to 70 characters per line). F3 ends entry of lines. F4 backs up to
the line number; enter the beginning line number. F2 allows the user to set the line
number increments (1-10). If the increment is set to one, a maximum of 999 lines may
be entered. F4 (from line #) will back up and delete the previous line.

Once notes have been added, the following options are available:
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#

Line number to change. Notes may be changed or deleted by entering the line number.
Enter whether to C-change or D-delete. If D is entered, the line is deleted. If Cis
entered, enter text (up to 70 characters). During this change routine, CR defaults to
the currently displayed value of the input. F3 ends entry of lines. F4 backs up to the
line number; enter the new line number. If a new line number is added, the old line
number is deleted. F2 allows the user to set the line number increment (1-10). F4
backs up to the main input.

L - Listline numbers. A limited number of line numbers appear on the screen at anytime.
The list function allows line numbers to be redisplayed. The user selects the
beginning line number to list.

A - Add aline number. New line numbers may be added as needed. F3 ends entry of
lines. F4 backs up to the line number; enter the new line number. F2 allows the user
to set the line number increment (1-10). F4 (from line #) will back up and delete the
previous line.

<

Move a line number. Enter beginning line number to move. Enter ending line number
to move. Enter line number where text will be moved (existing lines will be replaced)
one line at a time, or blocks of lines may be moved.

D - Delete a line number. One line or several lines of notes can be deleted at any one time.
Enter beginning and ending line numbers to delete. Enter N or YES to delete. CR
defaults to N.

Technical Notes
Information displayed is accessed primarily from the following files:

e General (SMCNTL)
e Ledger (SMLEDG)
e Check (SMCHKR)
* Notes (SMNOTE)

FILES USED - SMCNTL, SMCHKR, SMLEDG, SMNOTE, GLMSTR
FILES UPDATED - NONE
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L2 Bank Inquiry (SMIS10)
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How to display bank information

1.

2.

Access this program selecting System Management—>Checks & Banking ->Bank Inquiry.

In the Bank Code input, enter the bank code to display. Entry of a valid code displays the bank
name. The program defaults to the first bank on file. F2 allows a search.

In the Information prompt in the lower portion of the screen, enter the information type to
display for this bank.

G displays general information including address, contact, phone number, bank account
number, current balance, general ledger number and use of ledgercards flag.

L displays ledgercard information. Enter beginning date. The program defaults to the first
date with ledgercards stored. Information includes date, debit amount, credit amount, balance,
memo and register number.

C displays check information. Enter beginning check number. The program defaults to first
check stored. Information includes check number, check date, check period, payee
number/name, check amount and clear date.

N displays all notes recorded for this bank. If no notes exist for the bank displayed, the
system asks "Enter notes for this bank?" Enter N or Y to indicate whether to enter notes for this
bank. The program defaults to N and returns to the main input. If the user entersa'y, line
numbers are assigned beginning with 010 and will automatically increment by 10. Enter text (up
to 70 characters per line). F3 ends entry of lines. F4 backs up to the line number; enter the
beginning line number. F2 allows the user to set the line number increments (1-10). If the
increment is set to one, a maximum of 999 lines may be entered. F4 (from line #) will back up and
delete the previous line.

Once notes have been added, the following options are available:

# Line number to change. Notes may be changed or deleted by entering the line number.
Enter whether to C-change or D-delete. If D is entered, the line is deleted. If C is entered, enter
text (up to 70 characters). During this change routine, the program defaults to the currently
displayed value of the input. F3 ends entry of lines. F4 backs up to the line number; enter the
new line number. If a new line number is added, the old line number is deleted. F2 allows the
user to set the line number increment (1-10). F4 backs up to the main input.

L List line numbers. A limited number of line numbers appear on the screen at anytime.
The list function allows line numbers to be redisplayed. The user selects the beginning line
number to list.

A Add a line number. New line numbers may be added as needed. F3 ends entry of lines.
F4 backs up to the line number; enter the new line number. F2 allows the user to set the line
number increment (1-10). F4 (from line #) will back up and delete the previous line.

M Move a line number. Enter beginning line number to move. Enter ending line number to

move. Enter line number where text will be moved (existing lines will be replaced) one line at a
time, or blocks of lines may be moved.
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D Delete a line number. One line or several lines of notes can be deleted at any one time.
Enter beginning and ending line numbers to delete. Enter N or YES to delete. The program
defaults to N.

4.  After reviewing information for the specified bank, you can press Enter (CR) advance to the next
bank or F4 to backup.

5. Press F4 to exit the program.
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Check Listing (SMR510)

Function

This program allows the user to obtain a Check Listing. This is useful in
reconciling the checkbook to the bank statement. The optional update removes
cleared checks from the check reconciliation file. Checks are recorded as cleared
by the Check Reconciliation program. The Check Listing should be printed and
updated on a regular basis to prevent file overflow.

The user has the option to:

*  Select the bank to print.

» Select the beginning and ending check number to print.
» Select the beginning and ending period to print.

* Print accounts payable, payroll or all checks.

*  Printuncleared, cleared, voided or all checks.

Report information includes the following: module code, check number, payee
number and name, check date, check register number, type of check, check
amount, and clear date. If all checks are printed, totals are included for cleared
and uncleared checks. Report totals include total dollars of checks printed.
This report denotes checks in which the preceding check is missing by placing
an asterisk (*) beside the check number.

User Inputs

The following inputs are involved in printing the outstanding Check Listing:
1. Bank

Enter the bank code to print. The entry must be a valid bank code. CR initially
defaults to the first bank in the file. Press F2 to search existing bank codes.

2. Beginning Check

Enter the beginning check number to print (1-999999). Press F1 to enter FIRST.
3. Ending Check

Enter the last check number to print (1-999999). Press F1 to enter LAST.

4. Beginning Period

Enter the beginning check period to print (PPYY). CR defaults to the oldest
period for which there is a check on file (FIRST).

5. Ending Period

Enter the ending check period to print (PPYY). Press F1 to enter the last period
for which there is a check on file (LAST).

6. Module

Select whether to print AP-accounts payable, PR-payroll or CR to default to all
checks.
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7. Status

Enter whether to print U-uncleared, C-cleared or VV-voided for checks. CR
defaults to ALL.

If cleared checks have been printed, then upon completion of the check listing, the user has the option
of removing the records just printed.

8. Do You Wish To Remove Cleared Checks Just Printed?

Enter N or YES to indicate whether to remove the cleared checks just printed.

Technical Notes

Printing proceeds by reading through the check reconciliation file and checking
for check that meet the entered criteria.

FILES USED - SMCNTL
FILES UPDATED - SMCHKR
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¥ Check Listing (SMR510)

|
]
i
W
- Both AP and Pavroll Ghecks ||
- &l Checks -

ES Check Listing (SMR510)
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Bank Ledgercard Removal (SMU510)

Function

This program allows the user to remove ledgercards from the system by bank
and date.

Records removed by this program will no longer appear in the Bank Inquiry.
User Inputs
1. Beginning Bank

Enter beginning bank code to remove ledgercards (2 characters). CR defaults to
FIRST.

2. Ending Bank

Enter ending bank code to remove ledgercards (2 characters). CR defaults to
LAST.

3. Cutoff Date

Enter the cutoff date (ref. 1). All ledgercards prior to and including this date
will be removed. CR defaults the last GL period ending date.

4. Keep

Enter the minimum number of ledgercards to keep (not remove) per bank
regardless of cutoff date (1-99). CR defaults to NO MINIMUM.

Technical Notes

FILES USED - SMCNTL
FILES UPDATED - SMLEDG
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EX Bank Ledgercard Removal ([SMU510)
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How to remove ledgercards from the system

1. Access this program selecting System Management->Banks & Checks—>Bank Ledgercard
Removal.

2. Inthe Beginning Bank input, enter beginning bank code to remove ledgercards (2 characters).
The program defaults to FIRST.

3. Inthe Ending Bank input, enter ending bank code to remove ledgercards (2 characters). The
program defaults to LAST.

4. Inthe Cutoff Date input, enter the cutoff date. All ledgercards prior to and including this date
will be removed. The program defaults the last GL period ending date.

5. Inthe Keep input, enter the minimum number of ledgercards to keep (not remove) per bank
regardless of cutoff date (1-99). The program defaults to NO MINIMUM.

6. Press Enter (CR) to begin the ledgercard removal process.
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Bank F/M (SMF510)

Function

This program allows the user to create and maintain bank records.

Users may establish their own set of valid two-character bank codes to be used
in the banking system.

Banks are used by the following programs:

» Cash Receipts & Adjustments Register (deposits)
» Daily Sales Register (cash sales)
* AP and PR Check Registers (checks)

A valid general ledger account number for the bank (cash-in-bank) must be set
up in the general ledger Account F/M program prior to using this program.

User Inputs

The following inputs are involved in creating a bank record:

General tab
1. Bank

Enter the bank code (up to 2 characters). If one character is entered, the system
pads the input with a 0 on the left. F2 allows a search (ref. 3).

2. Bank Name

Enter the bank name (up to 30 characters).

3. Bank Address 1

Enter the first line of the bank address (up to 30 characters). If all three lines are
not required, use only the first two.

4. Bank Address 2

Enter the second line of the bank address (up to 30 characters).

5. Bank Address 3

Enter the third line of the bank address (up to 30 characters)
6. Contact

Enter the name of the person you work with at the bank (up to 25 characters).

7. Phone #

Enter the bank phone number including area code and dashes (up to 17
characters).

8. Bank Account #

Enter the bank account number (up to 20 characters).
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Current balance

This input is always skipped. Any adjustments should be made through the
Adjust Bank Balance program. This is to ensure proper audit trails.

9. Use Ledgercards

Enter N or Y to indicate whether to store ledgercards. CR initially defaults to N.
10. Bank G/L #

Enter the general ledger account number for cash in this bank. This account
number is used for the general ledger distribution of the Check Registers. The
entry must be a valid general ledger number. F2 allows a search (ref. 3).

History tab
1. AP Last Reg Check # Printed

Enter last regular accounts payable check humber printed (1-999999). During
system setup, this entry should be set to one less than the first accounts payable
check number you print on this system. CR initially defaults to 000000.

2. AP Last Man Check # Used

Enter the last manual accounts payable check number used (1-999999). This
entry should be set to the last check number used in your manual check book
when processing begins. CR initially defaults to 000000.

3. AR Last Deposit Ticket #

Enter last accounts receivable deposit ticket number (1-99999), as listed on your
preprinted deposit tickets (if applicable). CR initially defaults to 0000.

4. PR Last Reg Check # Printed

Enter last regular payroll check number printed (1-999999), as listed on your
preprinted checks (if applicable). CR initially defaults to 000000.

5. PR Last Manual Check # Used

Enter the last manual payroll check number used (1-999999). This entry should
be set to the last check number used in your manual check book when
processing begins. CR initially defaults to 000000.

Technical Notes

FILES USED - GLMSTR, GLALPX, SMLEDG, SMCHKR
FILES UPDATED - SMCNTL
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Check Reconciliation F/M (SMF520)

Function

The program allows the user to create and maintain accounts payable and
payroll check reconciliation records.

The user may choose to gather historical information, and enter it here before
processing begins, i.e., accounts payable or payroll checks written but not yet
cleared. Records will not be maintained here unless the Use Check
Reconciliation flag is set to Y in the AP and PR Static Control F/M programs.
Records are written to this file by the AP and PR Check Register updates and
records are removed from this file through the Check Listing update.

User Inputs

The following inputs are involved in creating records in the check reconciliation file:
1. Bank

Enter the bank code. The entry must be a valid code. F2 allows a search (ref. 3).

2. Check #

Enter the check number (1-999999). F3 displays the first check record on file for
this bank.

3. Period

Enter the period the check was written (PPYY). CR defaults to the CURRENT
period.

4, Module

Enter whether the check is AP-Accounts Payable or PR-Payroll. CR initially
defaults to AP.

5. Type

Enter whether the check is R-regular, M-manual, V-voided, or N-noninvoiced.
CRinitially defaults to R.

6. Date

Enter the check date (ref. 1). CR defaults to the system date.
7. Payee #

Enter the payee (vendor or employee) number (up to 10 characters). F2 allows a
search (ref. 3).

8. Payee Name

Enter the payee (vendor or employee) name (up to 30 characters). CR initially
defaults to the payee’s name of the payee’s #.
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9. Register #

Enter the Check Register number that updated this record to this file (0-9999).
CRinitially defaults to 0.

10. Amount

Enter the check amount (+/-9999999.99). CR initially defaults to 0.

11. Discount

Enter the amount of the discount for this check (+/- 9999999.99). This entry
applies to AP checks only. CR initially defaults to 0.

12. Clear Period

Enter the period the check is cleared (PPYY). CR initially defaults to no period.
13. Voided

Enter N or Y to indicate whether the check has been voided. CR initially
defaults to N.

Technical Notes

FILES USED - SMCNTL, APVEND, APVALX, PREMPL, PREALX
FILES UPDATED - SMCHKR
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FACTS

Inquiries

The System Administration inquiries enable administrators to analyze
information in various views.

The Summary Management Inquiry provides, by branch and department, the
current accounts payable and receivable balance, cash in bank, inventory
valuation, open purchase and sales order balance and sales history for the last
six periods.

The Amortization Schedule allows users to enter a loan principle, interest rate
and period of time for a loan and the loan payments will be listed on the screen.

The Terminal Inquiry displays all terminals logged into the system and the
company and program being accessed by each user.

The User Tracking Inquiry provides a list by user code itemizing which
programs are accessed and the time used (if the user tracking flag issetto Y in
the System Control F/M). (See the section on user tracking in the overview
section.)

The Program Inquiry allows the user to view in list form all the programs and
menus set up in the Program F/M on the screen along with their access codes
and security codes.

The File Usage Inquiry provides a list by file name and by percentage used of all
file specific information.
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Summary Management Inquiry (SM1610)
Function

This program allows the user to display on the terminal, by branch and department, the current
accounts payable balance, accounts receivable balance, cash in bank, inventory valuation, open
purchase order balance, and open sales order balance. Also included is sales history for the next
period and the last six periods (includes sales, cost and gross margin %).

In the Account F/M program in general ledger, each GL account number is assigned a summary
management type to be used in this inquiry. The types are cash (used to calculate cash in bank), cost
(used to calculate cost and gross margin % in sales history), inventory (used to calculate inventory
valuation), payables (used to calculate open payables balance), receivables (used to calculate open
receivables balance) and sales (used to calculate sales and gross margin % in sales history). Also in the
Account F/M program, each GL account number is assigned an account type. Next period journal
entries for GL account numbers assigned an account type of assets or liabilities are included in this
inquiry.

The open purchase orders are calculated from the purchase order file. The open sales orders are
calculated from the sales order file. The figures displayed are calculated each time the program is
used.

User Inputs

The following steps are involved in using the Summary Management Inquiry program:
1. Branch

Enter the branch. The entry must be a valid branch. CR defaults to ALL. F2

allows a search (ref. 3).

2. Department

Enter the department. The entry must be a valid department. CR defaults to

ALL. F2 allows a search (ref. 3).

The program calculates and displays the current balances and sales history
information. It includes next period transactions from General Ledger to include
the most current information available.

3. CR-Redisplay. F4-Backup

Press CR to recalculate and redisplay the figures for the same branch and
department. Press F4 to back up to input #2.

Technical Notes

The program uses the account file (GLMSTR), the account by summary management type file
(GLMSMX), the journal file (GLIRNL) and its associated sort file (GLJRNX) to calculate the accounts
payable, accounts receivable, cash and inventory balances and the sales history. The program uses the
purchase order file (PORDER) to calculate open purchase orders and the sales order file (SORDER) to
calculate open sales orders.

FILES USED - SMCNTL, GLMSTR, GLIRNL, GLMSMX, GLIRNX, PORDER,
SORDER
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FILES UPDATED — NONE

L2 Summary Management Inquiry [SMI610)
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How to display account balance information

1.

2.

Access this program selecting System Management->Inquiries> Summary Management Inquiry.

In the Branch input, enter the branch code. Press Enter (CR) to default to ALL. Press F2 to
search.

In the Department input, enter the department code, if they are used. Press Enter (CR) to default
to ALL Press F2 to search.

The program calculates and displays the current Accounts Payable balance, Accounts Receivable
balance, cash in bank, inventory valuation, open Purchase Order balance, and Open Sales Order
balance and sales history information for the next period and the last six periods (includes sales,
cost and gross margin %). It includes next period transactions from General Ledger to include the
most current information available. .

Press CR (or Enter) to recalculate and redisplay the figures for the same branch and department.
Press F4 to back up to the Department input.

You can enter another branch/department and display additional information or press F4 to exit
the program.
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Amortization Schedule (SM1620)

Function

This program allows the user to enter in certain variables to attain an Amortization Schedule. The user
enters the information and the program calculates, and either prints on the screen or the printer, the
schedule of the loan.

The user has the option to enter:
* Loan description

* Loan principle

* Interest rate

* Life of loan

« Starting month

The screen is divided into two portions. The upper portion of the screen is called the header portion
where the user information is entered, and the calculated monthly payment, total payment and total
interest are displayed. The lower portion of the screen is called the line-item portion and consists of the
information concerning the loan balance, etc., by month.

Schedule information includes the following: one line per month of a year - year, month, total
accumulated months, payment, principle, interest, total interest paid, and balance of the loan. The
information entered, calculated, and displayed is not stored by the system.

User Inputs

The following inputs are involved in using the Amortization Schedule:
1. Description

Enter the loan description (up to 40 characters).

2. Principle

Enter the principle amount of the loan (.01-9,999,999.99).
3. Rate

Enter the interest rate (.001-99.999). CR defaults to 0.
4. Months

Enter the life of the loan in months (1-999).
5. Start Month

Enter the starting month of year of the loan (1-12). CR defaults to 1.
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This concludes the user portion of the header. The system now displays the

calculated monthly payment, total payment, and total interest in the header
portion.

6. Print Schedule

Enter a T-terminal or one of the available printer numbers displayed at the
bottom of the screen to determine where to print the calculated schedule. CR
defaultsto T.

Technical Notes

FILES USED - SMCNTL
FILES UPDATED - NONE

L2 Amortization Schedule [SMI620])
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How to attain an Amortization Schedule

1. Access this program selecting System Management-> Inquiries=> Amortization Schedule.
2. (Optional) In the Description input, enter the loan description (up to 40 characters).

3. Inthe Principle input, enter the principle amount of the loan (.01-9,999,999.99).

4. Inthe Rate input, enter the interest rate (.001-99.999). Press Enter (CR) to default to 0.

5. In the Months input, enter the life of the loan in months (1-999).

6. Inthe Start Month input, enter the starting month of year of the loan (1-12). Press Enter (CR) to
default 1.

7. The system now displays the calculated monthly payment, total payment, and total interest in the
header portion. At the command prompt, the system displays the message: Print Schedule?
Enter a T-terminal or one of the available printer numbers displayed at the bottom of the screen
to determine where to print the calculated schedule. Press Enter (CR) to defaultto T.

8. In the lower portion of the screen, the system displays the following schedule information: one
line per month of a year - year, month, total accumulated months, payment, principle, interest,
total interest paid, and balance of the loan.

9.  When you have finished reviewing the amortization schedule, you can enter additional loan
parameters or press F4 to exit the program.
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Terminal Inquiry (SMI630)

Function

This program allows the user to view every terminal currently being used. This inquiry displays as
follows: terminal number, terminal description, user code, user name, program designation, program
name and company number. Terminal numbers are displayed until the screen becomes full. The user
may then press CR to display the next group of terminals.

User Inputs

No input is necessary initially. Press CR to continue displaying terminals. F4
exits the program.

Technical Notes
FILES USED - SMCNTL, SMTRCT, SMZART, SMNAME

FILES UPDATED - NONE
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How to view session information
1. Access this program selecting System Management-> Inquiries> Terminal Inquiry.

2. The system displays the following information: terminal number, terminal description, user code,
user name, program designation, program name and company number.

3. When the screen display becomes full, press Enter (CR) to continue displaying terminals.

4. Press F4 to exit the program.
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User Tracking Inquiry (SM1640)

Function

This program allows the user to display program usage information by user code. Display is limited to
user codes set up to be tracked through the User Code F/M.

Inquiry information includes for each user: date, program designation, program name, time of entry
into program, time of exit from program, time period program was in use, time period since last
program used, and special notes. The following special notes may be displayed on the screen:

IN NOF - indicates the time of entry is not on file (for example if a user gets into the program through
BASIC rather than through the menus).

OUT NOF - indicates the time the program was ended is not on file.
ABORTED - indicates the user aborted during an error (!).
ESCAPED - indicates the user escaped out of the program.

ENDED - indicates the user ended a program (example - during a report if the user presses the escape
key and uses the option F4-END.

User Inputs
The following inputs are involved in inquiring about users:
1. User

Enter the beginning user code (up to 3 characters). CR defaults to FIRST.
2. Beginning Date

Enter the beginning date to display for (ref. 1). CR defaults to the first date on
file.

Technical Notes

The inquiry proceeds by reading through the user-tracking file (SMUSRT) for all information which
meets the criteria entered.

FILES USED - SMCNTL, SMUSRT, SMZART, SMNAME

FILES UPDATED - NONE
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Program Inquiry (SMI650)

Function

This program allows the user to view program names, descriptions, access codes and security codes in
program name order. This inquiry is useful to find the six-character designation of a program. The
user may enter the beginning search characters or begin with the first program designation on file.
Names are displayed until the screen becomes full. The user may then display the next group in name
order or enter new search characters.

Program names are defined using the Program Name F/M. Security codes are assigned through the
Password & Security Code F/M.

User Inputs

The following input is involved in performing a Program Inquiry:
1. Beginning Search Characters

Enter the search characters to be used in beginning the display (up to 6
characters). CR begins with the first program designation on file. The system
searches for a match to the entered characters and begins the display with those
characters or the next name in alphabetical order. Display continues until the
screen is full. The user may then continue the display in alpha order or enter
new search characters. An efficient method of finding a program name is to
input the module code to which the program belongs. For example, to find the
name of the Cash Receipts Entry program, enter AR - the module code for
accounts receivable. All AR program names and descriptions are displayed in
alphabetical order.

Technical Notes
The system reads through the program name file (SMNAME) to display all screen information.
FILES USED - SMCNTL, SMNAME

FILES UPDATED - NONE
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L2 Program Inquiry [SMIG50)
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How to view program information

1. Access this program selecting System Management—> Inquiries=>Program Inquiry.

2. Inthe Beginning Search Characters input, enter the search characters to be used in beginning the display (up
to 6 characters). Press Enter (CR) to begin with the first program designation on file.

3. The system searches for a match to the entered characters and begins the display with those characters or
the next name in alphabetical order. Display continues until the screen is full.

4. You can continue the display in alpha order or enter new search characters.

5. When you have finished reviewing program information, press F4 to exit the program.
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File Usage Inquiry (SMI660)

Function

This program allows the user to inquire into information concerning file usage. Users may display
files based on percentage used. Inquiry information includes the following: file name, file description,
file type, key size, record size (i.e., total size of record), record number (i.e., number of records defined
for this file), records used (i.e., number of allocated records), and percent of records used.

User Inputs
The following inputs are involved in inquiring about file usage:
1. Minimum Percent

Enter the minimum percent used for a file to be displayed (1-99). CR defaults to
all files, i.e., all files are displayed regardless of percentage used.

2. Beginning File Name

Enter the beginning file name to display (6 characters). CR defaults to the first
file name (alphabetically).

Technical Notes
FILES USED - SMCNTL, SMFILE

FILES UPDATED - NONE

7-16 Copyright © 1984-2004 Aperum, Inc.



System Management—7.40 Inquiries

L2 File Usage Inquiry (SMIGG0)
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FACTS

Reports & Prints

The reports and prints programs provide lists of companies, programs, menus,
users on the system and program changes.

1. The Company Listing provides a list of all companies, addresses and
phone numbers on the system.

2. The Program Name Listing provides a list of all programs (and menus)
set up in the Program F/M along with terminal and printer validity if
selected.

3. The Program Usage Report provides a list of each program defined and
lists the menus containing the program.

4. The Menu Selections Print prints a range of menus (as determined by
the user) which may be helpful in setting up security.

5. The User Tracking Report prints a list of users using the system as to
which programs are accessed and the time used (if the user Tracking
Flag is set to Y in the System Control F/M). (See the section on the user
tracking in the overview section.)

6. The Program Change Report prints a list of program changes from the
Program Change F/M. The user (affiliate) enters program changes. If
no program changes are entered, this report will not be used.

7. The F/M Audit Report prints a list of any changes made to the file
information through file maintenance programs. This information is
limited to file maintenance programs where an audit trail is being kept
for changes (as set in the Program Name F/M).

8. The Help Text Print provides all the help text available by help code.

9. The SM Code List prints a list of various SM codes including terminals,
printers, banks, branches and files.
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Company Listing (SMR710)

Function

This program allows the user to obtain a listing of all companies set up to run
on the system. Report information includes the following: company number,
name, address, and phone number. Also included is the total number of
companies listed.

User Inputs

The following inputs are involved in printing a Company Listing:

1. Beginning Company

Enter the beginning company code to print (2 characters). Press F1 to enter
FIRST. Press F2 to search existing company codes

2. Ending Company

Enter the ending company code to print (2 characters). Press F1 to enter LAST.
Press F2 to search existing company codes.

Technical Notes

Printing proceeds by reading through the company control file (SMCNTL) and
printing the information for companies that are within the range of beginning
and ending companies entered.

FILES USED - SMCNTL
FILES UPDATED - NONE
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Program Name Listing (SMR720)

Function

This program allows the user to obtain a report of program names, descriptions,
security codes, terminal validity and printer usage. The printout may be used
as a worksheet to initially define security information and printer usage or as
reference for users.

Report information includes the following: program designation, name,
security code and access code. For each of up to 999 terminal numbers, validity
(Y or N) is printed along with the printer-selection option number and the
normal printer. Program descriptions, terminal validity and printer usage are
defined in the Program Names F/M. Security codes are issued through the
Password and Security Code F/M.

User Inputs
The following inputs are involved in printing the Program Name Listing:
1. Beginning Program

Enter the beginning program to print (up to 6 characters). Press F1 to enter
FIRST. Press F2 to search existing programs.

2. Ending Program

Enter the ending program to print (up to 6 characters). Press F1 to enter LAST.
Press F2 to search existing programs.

3. Security Codes

Enter the security code(s) in any combination side by side to print (0-9). Press
F1 to enter all.

4. Validity & Printer Information

Enter V-terminal validity, and/or P-printer information to indicate what
information is to be included on the report. Press F1 to enter NONE. If you
select NONE, the program skips the beginning and ending terminal inputs.

5. Beginning Terminal

If you entered NONE in the Validity and Printer Information input, the
program skips this entry. If you selected V or P, enter the first terminal number
that you want to appear on the report. Enter the beginning terminal number to
print (up to 3 characters). Press F1 to enter FIRST.

6. Ending Terminal

If you entered NONE in the Validity and Printer Information input, the
program skips this entry. If you entered V or P, enter the last terminal code that
should appear on the report. Press F1 to enter the LAST terminal code on
record. Press F2 to search existing terminal codes.
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7. Skip

Enter the number of lines to skip between programs (0-9). The program
defaults to 0.

Technical Notes

The program proceeds by reading through the program name file (SMNAME)
for all programs which meet the criteria entered.

FILES USED - SMCNTL, SMNAME
FILES UPDATED - NONE

;¥ Program Name Listing [SMR720)

l_l_

5": Program Hame Listing [SMR720])
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Program Usage Report (SMR730)

Function

This program allows the user to obtain a report of program designations, names
and the menus on which they appear. The report may also print only programs
that are not used on any menu. This printout is useful to purge the names of
unused programs or to alert the user to place a program on a menu.

Report information includes the following: program designation, and the name
of each menu on which the program appears. The total number of programs
printed is also included.

Program names are defined through the Program Name F/M. Menus are
constructed through the Menus F/M.

User Inputs
The following inputs are involved in printing the Program Usage Report:
1. Beginning Program

Enter the first program that should appear on the report. Program codes must
be six characters long. Press F1 to enter the FIRST record on file. Press F2 to
search existing programs.

2. Ending Program

Enter the last program that should appear on the report. Make sure the
program you enter is six characters long. Press F1 to enter the LAST program
on record. Press F2 to search existing programs.

3. Unused Only

Indicate whether you want to print only those programs not assigned to any
menu. The program defaults to N.

Technical Notes

The program proceeds by reading through the program name file (SMNAME)
for all programs which meet the criteria entered.

FILES USED - SMCNTL, SMNAME
FILES UPDATED - NONE
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Menu Selections Print (SMR740)

Function

This program allows the user to obtain a report of all menu information. Itis
useful to verify that selector menus and security codes are defined properly.

Report information includes the following: menu name, menu description,
return program, and the names, descriptions and security codes of all programs
called by the menu. The report format resembles the actual screen display.

Menus are defined through the Menu F/M and security codes are maintained
through the Password and Security Code F/M.

User Input
The following inputs are involved in printing the Menu Selections Print:
1. Beginning Menu

Enter the menu with which you want the report to begin. Press F1 to enter the
FIRST menu on record.

2. Ending Menu

Enter the menu with which you want the report to end. Press F1 to enter the
LAST menu on record.

Technical Notes

The program proceeds by reading through the menu file (SMSLCT) for menus
that meet the entered criteria. The program name file (SMNAME) is referenced
to print program descriptions.

FILES USED - SMCNTL, SMSLCT, SMNAME
FILES UPDATED - NONE
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[T
I

E% Menu Selections Print (SMR740)

8-10 Copyright © 1984-2004 Aperum, Inc.



System Management—7.40 Reports & Prints

User Tracking Report (SMR750)

Function

This program allows the user to print a listing of program usage information.
Reporting is limited to user codes being tracked by the user tracking system.

Report information includes the following for each user: user code, user name,
date, program designation, program name, security code, time of entry into
program, time of exit from program, time period program was in use, time
period since last program used, and special notes. The following special notes
may be printed:

IN NOF - indicates the time of entry is not on file (for example if a user accesses
the program through Business Basic rather than through the menus).

OUT NOF - indicates the time the program was ended is not on file
ABORTED - indicates the user aborted during an error ().
ESCAPED - indicates the user escaped out of the program.

ENDED - indicates the user ended a program (example - during a report if the
user hits the escape key and the option F4-END).

User Inputs
The following inputs are involved in printing the User Tracking Report:

1. Beginning User

Enter the beginning user (up to 3 characters). Press F1 to enter the LAST user
on record. Press F2 to search existing user codes.

2. Ending User

Enter the beginning user (up to 3 characters). Press F1 to enter the FIRST user
on record. Press F2 to search existing user codes.

3. Beginning Date

Enter the beginning date (ref. 1). Press F1 to enter the FIRST possible date in the
system.

4. Ending Date

Enter the ending date (ref. 1). Press F1 to enter the LAST possible date in the
system.

5. Program

Enter the program designation. (ie; APE120, APR220) The entry must be a
valid program. The program defaults to ALL. Press F2 to search existing
program designations.
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6. Security Codes

Enter the program security codes side by side to print (0-9). You can use 0-9, A-
Z and a-z. The program defaults to ALL of the codes. .

Technical Notes

Printing proceeds by reading through the user-tracking file (SMUSRT) for all
information which meets the criteria entered.

FILES USED - SMCNTL, SMUSRT, SMZART, SMNAME
FILES UPDATED - NONE
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Program Change Report (SMR760)

Function

This program allows the user to print a report of program changes entered
through the Program Change F/M.

The user has the option to enter the beginning and ending program and the
cutoff date.

Report information includes the following: program designation, date and
memo of changes. The report also lists total number of programs listed.

User Inputs
The following inputs are involved in printing the Program Change Report;
1. Beginning Program

Enter the beginning program to print. Press F1 to enter the FIRST program on
record. Press F2 to search existing printer designations.

2. Ending Program

Enter the beginning program to print. Press F1 to enter the LAST program on
record. Press F2 to search existing printer designations.

3. Cutoff Date

Changes entered before this date are not included on the report. The program
defaults to NO CUTOFF.

Technical Notes

FILES USED - SMCNTL, SMCHNG, SMNAME
FILES UPDATED - NONE
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;¥ Program Change Report [SMR760)
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F/M Audit Report (SMR770)

Function

This program allows the user to print a report of any changes made to file
information through F/M programs. This information is limited to F/M
programs where an audit trail is kept for changes (as set in the Program F/M).

Report information includes the following: program designation, program
name, date of changes, user code, user description, company and a list of the
old record and new (changed) information as listed in the file.

User Inputs
The following inputs are involved in printing the F/M Audit Report:
1. Beginning Program

Enter the beginning program to print. Press F1 to enter the FIRST program on
record. Press F2 to search existing programs.

2. Ending Program

Enter the ending program to print. Press F1 to enter the LAST program on
record. Press F2 to search existing programs.

3. Beginning Date

Enter the beginning date of changes to print (ref. 1). Press F1 to enter the FIRST
possible date..

4. Ending Date

Enter the ending date of changes to print (ref. 1). Press F1 to enter the LAST
possible date.

5. User

Enter the User Code to print. Press F1 to enter ALL existing user codes. Press
F2 to search existing user codes..

6. Check the Report. OK To Remove Records Just Printed?

Select OK or enter Y to remove the records. Select CANCEL or enter N to leave
the records in the system.

Technical Notes

FILES USED - SMCNTL, SMNAME, SMZART
FILES UPDATED - SMFMCH
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L? F/M Audit Report [SMR770])

ES F/W Audit Report (SMR770)
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SM Code List (SMR790)

Function

This program allows the user to print a listing of each of the following system
management codes:

0 Terminal
O Printer
0 Bank

0 Branch
O File

Each code above is entered in its own file maintenance program.

The user has the option to:

O Select the code to print.
0 Select the beginning and ending code.

Report information includes each code and the information stored with the
code. The total number of codes listed is also included.

User Inputs
The following inputs are involved in printing the SM Code List:
1. Select Number

Select the type of management code you want to print. The program defaults to
Terminal.

2. Beginning Order Choice

Select the beginning order choice to print of the code selected. Press F1 to enter
the FIRST code on record. Press F2 to search existing codes.

3. Ending Order Choice

Select the ending order choice to print of the code selected. Press F1 to enter the
LAST code on record. Press F2 to search existing codes.

Technical Notes

Printing proceeds by reading through the control file (SMCNTL) for the codes
that meet all criteria entered.

FILES USED - SMCNTL, SMFILE, SMMODS
FILES UPDATED - NONE

Copyright © 1984-2004 Aperum, Inc. 8-17



Reports & Prints System Management—7.40
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Text File Print (SMR910)

Function

This program allows the user to obtain a print out of any ASCII or text file. You

may use this program to print a copy of your configuration file or any other
ASCII file.

User Inputs
The following steps are involved in printing a text file;
1. File Name

Enter the name of the file to print. You must include any necessary path that is
in the file name.

Technical Notes

The program proceeds to print the contents of the file selected. Note that this
program will only print text files that are 20 bytes or greater in length.

FILES USED - SMCNTL
FILES UPDATED - NONE
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End of Period

The System Management End-of-Period Checklist menu provides the user with
two programs used to aid the user in running the end-of-period procedures
each period. Initially, all standard end-of-period procedures are provided in
the End-of-Period Checklist Entry program by module. If the user needs to
change any of these procedures to better fit the company’s needs, changes may
be made through this program. For example, in the accounts receivable end-of-
period checklist, there is a procedure to run the Service Charge Register. This
register is optional and may therefore be removed from the end-of-period
checklist if a company does not charge service (finance) charges. The End-of-
Period Checklist Print program prints a list of all end-of-period procedures (as
set in the End-of-Period Checklist program). The checklist should be used every
period of the year as the period procedures are completed.
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End-Of-Period Checklist Entry (SME810)

Function

This program allows the user to add procedures for all modules to the end-of-
period checklist. This is particularly useful for organizing month-end close-out
procedures.

User Inputs

The following inputs are involved in creating the end-of-period checklist:
1. Module

Enter the 2-character module code (e.g., AP) F2 allows a search (ref. 2).

2. Line Number/Description

Enter line of text (up to 70 characters per line). This should be a short
description of the task. Entries should be made in the order you would expect
to perform the task.

Once line-items have been added, the following options are available:

# - Line number to change. Notes may be changed or deleted by entering the line number.
Enter whether to C-change or D-delete. If D is entered, the line is deleted. If Cis
entered, enter text (up to 70 characters). During this change routine CR defaults to the
currently displayed value of the input. F3 ends entry of lines. F4 backs up to the line
number; enter the new line number. If a new line number is added, the old line number
is deleted. F2 allows the user to set the line number increment (1-10). F4 backs up to the
main input.

L - List line numbers. A limited number of line numbers appear on the screen at anytime.
the list function allows line numbers to be redisplayed. The operator selects the
beginning line number to list.

A - Add a line number. New line numbers may be added as needed. F3 ends entry of lines.
F4 backs up to the line number, enter the new line number. F2 allows the user to set the
line number increment (1-10). F4 (from line #) will back up and delete the previous line.

M - Move a line number. Enter beginning line number to move. Enter ending line number
to move. Enter line number where text will be moved (existing lines will be replaced)
one line at a time, or blocks of lines may be moved.

D - Delete a line number. One line or several lines of notes can be deleted at any one time.
Enter beginning and ending line numbers to delete. Enter N or YES to delete. CR
defaults to N.

F3 - Access the ending routine.

Technical Notes

FILES USED - SMCNTL, SMMODS

Copyright © 1984-2004 Aperum, Inc. 9-3



End Of Period System Management—7.40

FILES UPDATED - SMEOPL

E% End-of-Period Checklist Entry (SMES10)
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End-Of-Period Checklist Print (SMR810)

Function

This program allows the user to print an end-of-period checklist by module
code as entered in the End-of-period Checklist Entry program.

Report information includes the following: module code heading, and the
descriptions in order that they are entered in the entry program. Also,
included is the total number of modules.

User Inputs

The following inputs are involved in printing the End-of-Period Checklist:

1. Beginning Module

Enter the beginning module code (e.g., AP). Press F1 to enter the FIRST module
code on record. Press F2 to search existing module codes.

2. Ending Module

Enter the ending module code. Press F1 to enter the LAST module code on
record. Press F2 to search existing module codes..

3. Skip

Enter the number of lines to skip between steps when printing.

Technical Notes

FILES USED - SMCNTL, SMEOPL, SMMODS
FILES UPDATED - NONE
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File Maintenances

System Management file maintenance programs allow users to enter, change
and delete data. Use these programs to enter the initial data required to
configure the system (refer to the Installation Manual).

Use Company F/M to create companies in the system, along with the
authorization codes.

Use the Company Control F/M to set company-wide controls and parameters in
the system (length of item number, modules used, etc.).

Use the Terminal F/M to configure displays and special function keys for each
user.

Use Printer F/M to set up printers in FACTS, using aliases created in the
ProvideX link file utility.

Enter information from the authorization code sheet in System Control F/M, for
example software serial number, software release number, modules purchased,
etc.

2 All of these programs contain controls and flags that are critical to FACTS.
Once they have been set, do not change them. Any modifications made after
initial installation will cripple the system. (See the Installation Manual for
further information.)

Several other programs are available on this menu, and can be modified
throughout the lifetime of the system.

System Administrators or local FACTS personnel can use the Program Change
F/M to maintain any program changes made to the system.

Use Rounding Code F/M (SMF610) to enter rounding code information for
contract pricing.

The Custom Help Text Entry and Program Help F/M programs are used to
enter help text into program inputs throughout the system.
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Company F/M (SMF910)

Function

This program allows the user to create and maintain companies in the company
control file. Users establish their own set of valid companies to be set up on the
system. Companies should be numbered beginning with 01, 02, etc. The main
company must be 01.

IMPORTANT: Use the procedures outlined in the Installation Manual. There is
no quick, easy way to set up a new company for processing.

User Inputs
The following inputs are involved in creating a new company:

1. Company

Enter the (2-digit) company code. CR defaults to the first company on file. F2
allows a search (ref. 3).

2. Name

Enter the company name (up to 30 characters).
3. Address 1

Enter the company address (up to 30 characters).

4, Address 2

Enter the company address (up to 30 characters). If only two lines are needed,
use the first 2.

5. Address 3

Enter the company address (up to 30 characters).

6. Phone Number

Enter the phone number including area code and dashes (up to 17 characters).

7. Authorization Code

Enter the authorization code. This is provided by Aperum.

WARNING: You will cripple the system if you change this code without the
consent of Aperum.

Technical Notes
FILES UPDATED - SMCNTL
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Company Control F/M (SMF920)

Function

Use this program to create and maintain control parameters for a company.

CAUTION! Virtually every program in the system checks this control record
during live processing. We seldom recommend that you make changes to this
program after initial installation. Changes to certain prompts, especially those
dealing with GL numbers and number lengths, will adversely affect the system.

User Inputs

The following inputs are involved in creating the company control record.
& indicates that changing the field after initial installation may have serious
repercussions. Please check with your Affiliate before you make any changes.

General tab
6%1. Length of G/L #

Enter the length of the general ledger account number (4-10 digits). The length
includes digits only and does not include possible dashes that may be part of
the general ledger number. For example, if the G/L # is 000-00-0, the length is 6.

2. G/L # Print Mask

Enter the general ledger number print mask (4-14). For example, if five digits
are chosen as GL number length with a mask of 000-000, the GL number 15505
would be displayed as 155-05 when entered in the system. The length must be
at least as long as the general ledger number.

6*3. Branch Position

This determines the position of the branch within the general ledger number.
Even if the company does not use part of its general ledger number to designate
branch, this record must be set up. If branches are not used, enter zero. If
branches are used, enter the position of the first character of the branch in the
general ledger number. Assume, for example, in GL numbers 100-01 and 100-
02, 01 and 02 indicate the branch. The entry would then be 4, meaning the
branch starts in the fourth position of the general ledger number.

#%4. Department Position

This determines the position of the department within the general ledger
number. Even if the company does not use part of its general ledger number to
designate departments, this record must be set up. If departments are not used,
set this to zero. If departments are used, enter the position of the first character
of the department in the general ledger number. Assume, for example, in GL
numbers 100-01 and 100-02, 01 and 02 indicate the department. The entry
would then be 4, meaning the department starts in the fourth position of the
general ledger number.

File Maintenances
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6%5. Length Of Dept

Enter the length of the department number (1-4). As in the example above, the
length of the department number is 2. Any entry from the first digit to the last
digit in the GL number is accepted.

6%6. Length Of Item #

Enter the length of the item number (4-20). CR initially defaults to 20.
6%7. Item # Pad

Enter whether to pad the item number with blanks on the 1-left or 2-right. CR
initially defaults to 1.

6%8. # Of Periods/Year

Enter the number of periods in a year (4-13). Twelve is the standard entry. CR
initially defaults to 12.

9. Commission Flag

Indicate whether the system should L-always choose the lowest commission in
the hierarchy, H-always choose the highest commission in the hierarchy, or X-
calculate (always choose the commission that the hierarchy determines). The X-
calculate option means to not give preference to the highest or lowest
commission in the hierarchy, but simply follow the hierarchy order.

10. Commission Basis

Enter in priority order how to calculate commissions using S-salesperson, C-
customer I-item and P-contract price percentages (all must be entered). Note
that the P-contract price option only applies to contract prices, not level and
guantity prices.

Calculating Commissions

When calculating commissions, the system first checks the value of the
Commission Flag. If the Commission Flag is set to H- always choose the
Highest commission in the hierarchy, the system returns the highest
commission %, excluding the line’s commission %, after replacing the item’s
commission with the price’s commission if necessary. If the Commission flag is
set to “L- always choose the Lowest commission in the hierarchy”, it returns the
lowest, non-blank, commission %, excluding the line’s commission %, after
replacing the item’s commission with the price’s commission if necessary.

If the value of the Commission Flag is set to X-calculate (always choose the
commission that the hierarchy determines), the system checks the Commission
Basis for the first priority to determine which commission percentage to use. As
the priority string is being navigated, the first entry that has a commission other
than “No Priority” (or blank) will be returned as the correct commission %. If
set to SCIP the system would calculate the commission using the percentage
assigned to the salesman who sold the merchandise. If no priority is assigned to
the salesman, the second priority is checked. The system would then calculate
the commission using the percentage assigned to the customer the merchandise
was sold to. If no priority is assigned to the customer, the third priority is
checked. The system would then calculate the commission using the percentage
assigned to the item that was sold.
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If the price type is not a contract price, the position of the Price’s Commission %
in the hierarchy will be ignored, and if a Price Commission is present, it will
replace the Item’s Commission % (regardless of whether the Item’s Commission
was “No Priority”).

If the user override flag is set for the line-item during order entry processing,
the system returns the Line’s Commission as the correct commission %.

11. Gross Margin % Basis

Enter whether to use C-cost or P-price as the basis for gross margin percent
calculations. CR initially defaults to C. This flag affects the calculation of gross
margin in all programs using it .

12. Date Format Mask

Enter whether the date format to be used throughout the system is MMDDYY -
American or DDMMYY - European. CR initially defaults to MMDDYY.

13. Override Password
Enter a password (up to 6 characters) that is used for two purposes:

e to access a document that another user is currently modifying. No one
may access a document in SO, IC, or PO that is being modified by
another user unless they enter this password.

« to change the field in the Nonstatic Control F/Ms of SO, IC, and PO that
prohibits other terminals from running the indicated register.

14. Template Security

Define the security code that enables designated users to create system-wide
templates in reports.

Enter a character from a-z, A-Z or 0-9.

Authorize a user to create system-wide security by entering this code in the
User Code F/M Security Code field (System Management 2Security
System ->User Code F/M)

15. Export Security

Define the security code that enables designated users export search results to
an ASCII or Excel file.

Enter a character from a-z, A-Z or 0-9.

Authorize a user to export by entering this code in the User Code F/M Security
Code field (System Management >Security System ->User Code F/M)

16. DW Security

Define the security code that authorizes users to access the data warehouse
system. Enter a character from a-z, A-Z or 0-9.

To authorize a user for data warehousing, make sure this code appears in the
Security Code field of that user’s record in User Code F/M.
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Modules Used tab
18. Use Modules

Select the modules that this company will use. The module codes must appear
on the FACTS Authorization Sheet. In character, enter Y or N for each module
to indicate whether each module listed is used.

Technical Notes

FILES USED - SMMODS
FILES UPDATED - SMCNTL
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Terminal Type F/M (SMF880)

Use this program to specify the hex code command sequence for navigation and
function keys to use when you switch to TeleFACTS from WordPerfect. The file
maintenance is supplied with two records for the Wyse 60 terminal.

NOTE: Use this file maintenance only if you are using the WordPerfect
interface for issuing letters, and your arrow keys and function keys get
scrambled when you go to TeleFACTS. Therefore, you do not have to complete
this file maintenance unless this problem arises. At that point, you should
contact Customer Services and Solutions to help you develop the hex codes for
your terminal.

User Inputs

The following fields are involved in creating and maintaining terminal types for WordPerfect.
1. Terminal Type

Enter the terminal type that is used as the term cap variable. The entry is for all
terminals of this type using TeleFACTS. You must enter it in exact upper- and
lowercase letters as it is defined in the term cap file and the user’s term variable.
CR defaults to the current terminal type, so you can press the RETURN key to
define the record for this terminal. Press F2 to search for valid terminal types
already set up in this program. Press F3 to display the next record on file.

Navigation Keys Tab

2. Description

Enter a description of the terminal type (up to 30 characters).

3-8. Command Sequence and Description

Enter up to 6 hex code command sequences to redefine such keys as
navigational when you switch to TeleFACTS from WordPerfect. The codes can
be up to 30 characters long. For each command sequence, you can enter a
description that further explains what the hex code does (up to 30 characters).

Special Function Keys Tab

9-12. Command Sequence and Description

Enter up to 4 hex code command sequences to redefine special function keys
used when you switch to TeleFACTS from WordPerfect. The codes can be up to
30 characters long. For each command sequence, you can enter a description
that further explains what the hex code does (up to 30 characters).

When you go to TeleFACTS from WordPerfect, the system prints these hex codes to the screen, which
is transparent to the user. The hex codes redefine the keys to the proper values for FACTS.
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Technical Notes
FILES UPDATED - TMTERM

;¥ Terminal Type F/M [SMF380)

Testterminal

Work function

Haome function

E% Terminal Type F/M [SMFB80])

File Maintenances
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Terminal F/M (SMF930)

Function

This is an administrative level program. Use it to set up defaults for each
terminal, especially screen colors and special key functions.

E Terminal F/M [SMFI30) H=lE
Help

TERMIHAL F/H SHF93d
*_ TERMINHAL CODE T8
2. DESCRIPTIOH Demo Base Terminal
*_ BASE
4. HUHMBER (1]

INFUT DEFAULTS

BERAHCH #1 Atlanta Branch
DEPARTMENT 1 Wholesale. . ... enennx
. WAREHOUSE 1 Atlanta Warehouse

. SALESPERSOH 18 Ronald Patton

PRINTER 1 P3 Hull Printer

L= R = ) |

TERMIHAL COWTROL
18. 88 COLUMH
11. 132 COLUMH
12. ESCAPE KEY CTRL-EREAK
13. REVERSE VIDED ¥
14. CLIPPERSHIP WORKSTATIOH H

MATH, KEYS, COLORS
DISPLAY CODE, LH# TO CHAMGE (F2-COMTINUED), CR-MEXT, D-DELETE, F4-HEW |..

User Inputs

Main screen

FACTS maintains several of the fields found on the main screen during live
processing.

* Terminal Code
This field is display only. Using the environment variables (SSI_BASE) created

during installation, FACTS assigns permanent terminal codes to users as they
initially sign into FACTS (e.g., T1, T10, T11, T22).

Say you have five FACTS users: John, Marianne, Sean and Kathy, each are
about to sign into FACTS for the first time.

John starts a FACTS session. The system finds his SSI_BASE value and
assigns the terminal code T1. His SSI_BASE value appears in Terminal
F/M in Description (displays in all caps) and Base (displays as entered).
T1 is now permanently assigned to John until John is deleted from the
system.
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John immediately starts a second session and the system assigns the
terminal code T2, also permanently assigned to John.

Next Marianne starts a FACTS session. The system finds her SSI_BASE
value and assigns terminal code T3.

Sean signs on and the system assigns the terminal code T4. Then Kathy
signs on and gets the terminal code T5.

If Marianne starts another FACTS session, the system assigns the next
available terminal code — T6.

Each user can sign in up to nine times, which means every user can run up to
nine FACTS sessions at once. As a result, each user can potentially have nine
terminal codes permanently assigned to them. The only way the terminal code
can be separated from the user is by deleting the user from the system via User
Code F/M.

Users cannot create or edit terminal codes from this program. Terminal codes
are only created as each user sign into the system.

2. Description

The system automatically creates a terminal description for the select code from
the SSI_BASE value created during installation. You can modify this description
if you choose. The descriptions can be 25 characters long.

*, Base

The system also automatically creates the base from the SSI_BASE value, which
is an environment variable set during installation. You cannot edit values for
existing records from this program. For new records you can enter a base 1D
only in this field. See the Installation Manual for more information about
setting SSI_BASE.

4. Number

Groups of users can share one terminal number so that the system administrator
can quickly set program security or designate a default printer for the group.

For instance, a company may want to prevent salespeople from accessing
Salesperson/Territory F/M so they cannot change their own sales history and
the number of calls they are required to make. In every terminal record that
belongs to a salesperson, a system administrator can enter 1, for example, in the
terminal number prompt.

Once terminal numbers are assigned, the administrator can use them in
Program F/M to set up program level security and default printers. (Access
Program F/M by selecting System Management—>Menu Setup—>Program F/M).

You can enter terminal numbers from 0 to 980, depending on the number of
terminals set in the System Control F/M.
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Input Defaults

Whenever the system asks for branch, department, warehouse, salesperson or
printer information during live processing, the user assigned to this terminal
code can press the Enter key (referred to as CR in the software) to get these
defaults.

5. Branch

Enter the branch that should serve as the default branch for this terminal (2
digits).

6. Department

Enter the GL department that should server as the default department for this
terminal (the length of this input is set in Company Control F/M).

7. Warehouse

Enter the warehouse that should serve as the default warehouse for this
terminal (2 characters).

8. Salesperson

Enter the salesperson/territory that should serve as the default salesperson for
this terminal (up to 3 characters).

9. Printer

Enter default printer for this terminal.
Terminal Control

Use this section to set escape sequences for printing and reverse video. This
section also contains a flag that enables administrators to designate the selected
terminal as a Clippership workstation.

10. 80 Column

This input and the next is really for users who need to “Print to Terminal.”
Enter the escape sequence (up to 10 characters) that set the terminal to 80
column (normal mode) screen. The escape sequence is based on the type of
terminal and should be listed in the user’s manual for the terminal in question.
F3 defaults to none.

11. 132 Column

Enter the escape sequence (up to 10 characters) that sets the terminal to 132
column screen mode. This sequence is used when printing reports of more than
80 columns to the terminal screen. The escape sequence is based on the type of
terminal and should be listed in the terminal manual. F3 defaults to none.

12. Escape Key

Use this input to set up a description of the key sequence that enables users on
this terminal to stop processing reports or registers, for instance.

Enter up to 10 characters. For example, if you enter ESCAPE, the system will
display on screen ESCAPE TO STOP while reports and registers are processing
so that users know which key to press if they need to abort the job. CR defaults
to ESCAPE.
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If the system does not support windows and colors, the following inputs do not
appear on the screen. If the system does support windows and colors, set the
defaults for each of the inputs.

13. Reverse Video

Enter N or Y to indicate whether this terminal supports reverse video. On
monitors that support reverse video, certain information is displayed in reverse
intensities. For monitors that do not support reverse video, the background is
displayed in foreground and the foreground is displayed in background.

14. Clippership Workstation

If Clippership is not installed on the, skip this input. This flag enables you to set
the selected terminal as the Clippership Workstation. This identifies the
terminal as the lone workstation using Clippership in the Single-Workstation
processing mode, which gives the user working on this terminal the ability to
perform FACTS Confirmation and Clippership shipping simultaneously.

This feature is useful when one FACTS user performs Confirmation and
Shipping duties for a company.

Make sure this flag is set to Y for each of the terminal codes assigned to the user
who performs confirmation and shipping tasks. Set this flag to N for all other
terminal codes.
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E& Terminal F/M (SMF930) [_ O] =]
Help

TERMINAL F/H SHF932
*. TERMINAL CODE T8

—SPECIAL FUNCTIONS—

2. HELP ac CTL+L
3. PRINT SCREEH 10 CTL+P
4. CALCULATOR 18 CTL+X
5. CALEHDAR a1 CTL+A
6. 50 QUICK LODOK 82 CTL+B
7. CATALODG CD gy CTL-D
8. CASH DRAWER 17 CTL-W

MAIN, KEYS, COLORS
DISPLAY CODE, LH# TO CHANMGE (F2-COMTINUED), CR-MEXT, F4-MEW EHTRY ..

Keys tab
To access the Keys tab, enter K at the selection prompt and press Enter.

The inputs on the Terminal F/M’s Keys tab enable administrators to set up
specific special function keys, which become keyboard shortcuts to these
functions. These keys are specific to each terminal. The terminal code appears at
the top of this screen so that administrators can see which terminal they are
configuring without having to switch back to the main screen.

Administrators: When you're setting special function keys in this program,
remember that each user may have been assigned more than one terminal code.

Map navigational and other special function keys (page up, page down, arrows,
Report Writer, etc.) in the ProvideX keyboard mapping utility. For more
information about this feature and general instructions on mapping keys in
ProvideX, see Chapter 2 in the Installation Manual.

To set the following keys: Press the key or key sequence that should serve at
the keyboard shortcut for each function. Once you press the key or key
combination, the hex code that represents that keystroke will appear to the right
of the input. Press the Tab key once and enter a description of this key or key
sequence (up to six characters). For example, if you set the hotkey for Print
Screen to be the combination of the Control and X keys, enter “Ctrl+X” as the
description.

2. Help

Press the key or key sequence that should fire the on-line help system on this
terminal. The on-line help system in integrated into FACTS. This key does not
open the FACTS PDF Documentation Library.
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3. Print Screen

Press the key or key sequence that should give users the capability to perform a
screen print on this terminal.

4.  Calculator

Press the key or key sequence that should open the on-line calculator on this

terminal. This hotkey only works inside FACTS programs, not in the menu
system.

5. Calendar
Press the key or key sequence that should open the on-line calendar on this

terminal. This hotkey only works inside FACTS programs, not in the menu
system.

6. SO Quick Look

Press the key or key sequence that should run the Quick Look feature in Sales
Order Entry programs on this terminal.

7. Catalog CD

Press the key or key sequence that should open the catalog CD for electronic
price updates on this terminal. If you don’t use electronic price updates, you can
leave this blank.

8. Cash Drawer

Press the key or key sequence that opens the cash drawer on this terminal. If
you don’t use the Cash Drawer system in the Sales Orders module, skip this
prompt.

Copyright © 1984-2004 Aperum, Inc. 10-17



File Maintenances System Management—7.40

ﬁ Terminal F/M [SMF330) |_ (O] x|
Help

TERMINAL F/H SHF9231

*. TERMIHAL CODE T8
2. MEHUS 72 FOREGROUND /BACKGROUND
COLOR SELECTID

17 FG/ 18 FG/ FG/ 20 FG/ 22 FG/
25 FGY 26 FG/ FG/f FG/ 38 FG/

49 FG/ 58 FGS FG/ FG/ 5h FG/
57 FG/BK 58 FG/BEK FG/BK FG/BK 62 FG/EBK
© o BK FLE/BK
FG/EK FG/BK
BK BE FG/f BK FG/
BK BK FG/ BK FG/
FG/BK 188 FG/BK 184
FG/BE 108 FG/BE 112
BK FG/f 116 BK FG/ 128
121 FEfBK 122 FG/BEK FG/BK 126 FGSEK

SELECT COLOR FOR MEHUS (1-128), F4-BACKUP  72<

Color tab

To access the Colors tab, enter C at the selection prompt and press Enter.

The terminal code appears at the top of the screen so administrators can see
which terminal they are working on at a glance.

Foreground and background colors can be modified for menus, general
programs, help routines, searches, inquiries, messages and window borders.

To modify colors: Select a line number. Review the options in the pop-up
window that appears and enter the number corresponding to the desired color
combination (1-128).

Press Enter. Back at the Colors tab, select another line number if you wish to
edit more colors. As with special function keys, users can have more than one
terminal code assigned to them. To make their color combinations consistent
from session to session, remember to set the same colors for every terminal code
assigned to a user.

Technical Notes

Key definitions are set in the overlay SMF932. When adding a new record,
defaults will be used for all Key Codes.

FILES UPDATED - SMCNTL
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Printer F/M (SMF940)

Function

Use this program to set up printers that need to be accessed through FACTS.

In the majority of printer configurations, you will only need to set the first three
fields on this program’s main tab. However, other tabs are available and can be
accessed by entering the following codes at the selection prompt;

D - double graph

S - single graph
T - transition graph
F - fonts page 1
P - fonts page 2

For printers that support graphics and special print attributes, this program also
allows you to define these features for printing in FACTS. Options D, S,and T
are for using graphic characters in reports and forms so that, for instance,
invoices are printed with ruling boxes instead of dashes and exclamation points.
Options F and P are for printers that support special font attributes, such as
boldface and italic type.

This program is the last of four steps for configuring printers. For complete
instructions on printer configuration in FACTS and ProvideX, see Chapters 2
and 4 in the Installation Manual.

User Inputs

Main Screen

1. Printer Number

FACTS allows you to create the exact number of printers that you specified in
System Control F/M. You must assign each printer a number, beginning with
the number 0. The last printer number you assign should be one less than the total
number of printers entered in System Control F/M. Throughout the character
system, users can select FACTS printers by entering these numbers.

2. Designation

The designation is the same thing as the link file name. The printer designation
must contain three characters or fewer. Examples: LP1, P1, P2.

3. Description

Enter the Description of Output from the Printer Configuration Worksheet.
Printer descriptions can be up to 25 characters long. Make sure the description
gives users some indication of the printer being selected and the format it will
produce. For example, HP 4000 Port. 10 cpi, for a HP Laserjet 4000 that outputs
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in Portrait and 10 cpi print, or Okidata Land. Compressed to indicate an
Okidata outputting in Landscape and compressed print.

The rest of the prompts on this tab can be skipped.
4. Carriage Width

ProvideX printer drivers now handle carriage width. Accept the default. Enter
the width of the carriage on the printer (0-999). CR initially defaults to 132.

5. Bar Code On

Applies to CodeLight users. Enter hex code to turn bar code on. CR initially
defaults to none.

6. Bar Code Off

Applies to CodeLight users. Enter hex code to turn bar code off. CR initially
defaults to none.

7. Bar Code Select

Applies to CodeLight users. Enter hex code to select the specific bar code type
needed to print. CR initially defaults to none.

8. Landscape

ProvideX printer drivers handle orientation. Skip this prompt. If the printer
supports landscape printing, enter the hex code sequence to initiate printing.

9. Portrait

Provides printer drivers handle printer resets. Skip this prompt. Enter the hex
code sequence to return to portrait printing from landscape printing.

Double Graph tab

This tab only becomes available after you set the required fields on the main tab. Then, from any tab
in this program enter G.

This screen allows you to enter ASCII codes that produce graphical double lines. For each of the
following fields, enter the appropriate ASCII code for the printer. The window in the lower-left corner
of the screen shows a picture of the graphic for which you are entering the ASCII code. CR defaults to
000 for each.

2. double horizontal line 8. double cross

3. double vertical line 9. double top “T”

4. double upper-left corner 10. double bottom “T”
5. double upper-right corner 11. double left “T”

6. double lower-left corner 12. double right “T”

7. double lower-right corner
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Single Graph tab

File Maintenances

You can access the single graph screen after you have completed all prompts on the main screen and
have added the record. Then, from any screen in this program enter S.

This screen allows you to enter ASCII codes for graphics of single lines. For each of the following
fields, enter the appropriate ASCII code for the printer. The window in the lower-left corner of the
screen shows a picture of the graphic for which you are entering the ASCII code. CR defaults to 000

for each.

. single horizontal line

. single vertical line

. single upper-left corner

. single upper-right corner
. single lower-left corner

. single lower-right corner

~NOoO o W

Transition Graph tab

8. single cross

9. single top “T”
10. single bottom “T”
11. single left “T”
12. single right “T”

You can access the transition graph screen after you have completed all prompts on the main screen
and have added the record. Then, from any screen in this program enter T.

This screen allows you to enter ASCII codes for graphics to intersect double and single lines. Fields
#20-23 are for fill patterns. For each of the following fields, enter the appropriate ASCII code for the
printer. The window in the lower-left corner of the screen shows a picture of the graphic for which

you are entering the ASCII code. CR defaults to 000 for each.

e Tointersect a vertical single line to horizontal double lines:

2. upper-left corner 7.top “T”

3. upper-right corner 8. bottom “T”
4. lower-left corner 9. left“T”

5. lower-right corner 10. right “T”
6. cross

e Tointersect horizontal double lines to a vertical single line:

11. upper-left corner 16. top “T”

12. upper-right corner 17. bottom “T”
13. lower-left corner 18. left “T”

14. lower-right corner 19. right “T”
15. cross

e For fill patterns:
20. lightest box
21. medium box
22. dark box
23. darkest box

Copyright © 1984-2004 Aperum, Inc.
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Fonts Page 1 tab

System Management—7.40

You can access the font screen—page 1 after you have completed all prompts on the main screen and
have added the record. Then, from any screen in this program enter F.

This screen allows you to enter hex codes for special print attributes, such as italic and boldface print.
For each of the following fields, enter the appropriate hex code for the printer. CR defaults to blanks

for each.

2-3.

4-5.

6-7.

8-9.

10-11.

12-13.

14-15.

16-17.

Fonts Page 2

start and end reverse print

start and end double underline
start and end boldface print
start and end italic print

start and end shaded print

start and end drop shadow print
start and end outline print

start and end subscript print

You can access the font screen—page 2 after you have completed all prompts on the main screen and
have added the record. Then, from any screen in this program enter P.

This screen lets you continue defining special print attributes. For each of the following fields, enter
the appropriate hex code for the printer. CR defaults to blanks for each.

2.-3.

4.-5.

6.-7.

8.-9.

10.

11.

12.

13.

14.

start and end superscript print

start and end tall character print

start and end wide character print

start and end tall and wide character print
start 10 characters per inch print

start 12 characters per inch print

start 15 characters per inch print

start 17 characters per inch print

start 6 lines per inch print

10-22
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15. start 8 lines per inch print

16. start 12 lines per inch print

Technical Notes
FILES UPDATED - SMCNTL, SMFNTS

ES Printer F/M (SMF940)

File Maintenances

Most users only need to use the first three prompts in the program. The rest of the inputs and tabs are

rarely needed.

Copyright © 1984-2004 Aperum, Inc.
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System Control F/M (SMF950)

Function

Use this program to enter FACTS-related authorization code information, such
as total number of terminals, modules purchased, etc. Make sure you have your
FACTS Authorization Code Sheet ready when you’re setting up this program.

When entering data, make sure answers you provide are accurate and consistent
with what is printed on the Authorization Code Sheet. Every program in the
FACTS system checks this record. Any inaccuracies will crash the system.

DO NOT CHANGE the software level, serial number, modules purchased,
main company name, ASCII Bit Set and maximum number of terminals after
initial installation without contacting Aperum. Unauthorized changes to these
fields will crash the system.

User Inputs

To set up the System Control F/M, complete the following fields.
*1. ASCII Bit Set

Enter whether to use ASCII 0-low or 1-high order bit set. CR initially defaults to
0. On most machines it should be set to 0. On Basic Four MPX machines, it is set
to 1.

2. Number Of Printers

Enter the number of logical FACTS printers (0-99). Refer to the Printer
Configuration Worksheet you filled out from the PIA manual. CR initially
defaults to 1.

*3. Maximum Terminals

Enter the maximum number of terminals that can be logged onto FACTS at any
time as determined by your purchase agreement. This appears on the
Authorization Code Sheet as Max FACTS Users. CR initially defaults to 20.

NOTE: If you are increasing the number of terminals, you must perform the
following steps only with the help of your Affiliate:

- First, expand the SMNAME file by 4 bytes for each terminal. Do this before entering this
program and changing the Maximum Terminals field.

- Increase the number of terminals in this field. The following message will be displayed:
SMNAME will have to be updated to use the new terminals. CR-continue. When you
save the changed record and press F4 to exit the program, the following message is
displayed: Update SMNAME to use the new terminals? (Y/N).
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- Enter Y to access the screen for the Device Usage Expansion Program (SMU340). Complete
the prompts for your installation.

4. Use User Tracking

Leave this input defaulted to N. User Tracking enabled on a system-wide level
quickly depletes disk space.

5. Menu Timeout

The menu timeout is a security feature that lets you set the number of minutes
users can leave a terminal inactive before the system automatically signs them

off the system. The menu timeout does not work while users are working in a
program.

Set the timeout for anywhere between one and 99 minutes. Enter a 0 if you
never want the timeout feature to activate. CR initially defaults to 10 minutes.

*6. Facts Level

This field is set to default to the current revision level. Accept this default by
pressing the Enter key (referred to as CR in the software).

*7. Serial Number

Enter the FACTS Serial Number that appears in the upper left-hand portion of
the FACTS Authorization Code Sheet. Make sure what you enter exactly
matches the number that appears on the sheet.

*8. Main Company Name

Enter the Main Company Name that appears on the FACTS Authorization Code
Sheet. Make sure the name you enter exactly matches the name that appears
on the sheet. This field is case sensitive.

9. Affiliate Name

Enter the name of the local Affiliate office. This name can be up to 30 characters
long and appears on the Banner Screen (in character mode) or the Sign On
Screen (in graphical mode).

10. Phone Number

Enter the Affiliate office’s phone number, including area code and dashes (up to
17 characters). The phone number is displayed on the FACTS Banner Screen in
character mode. In GUI, this phone number and other Affiliate information
appears when users press the Affiliate button on the Sign On screen.

11. IC Verify Licenses

Enter the number of IC Verify licenses purchased. The system will support up
to 999 licenses.

Technical Notes

FILES USED - SMNAME, SMMODS
FILES UPDATED - SMCNTL
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Uze ASCI Low (Mormal) or High Order Bit Set (0/1)

S_l,lstem Control F/M [SMF950] M=l B3

Help

#1-Specialty Distributors, InSystem Control F/H SHF95d
13. Modules Purchased

1. ASCII Bit Set AP A

2. # of Printers AR 50

3. Haximum Terminals GL R

4. Use User Tracking IC FL

5. Menu Timeout Hone JG TF

6. FAGCTS Level JS SR

7. Serial Humber HC Du

8. Main Company Hame oA RH

9. Affiliate Hame 1]

19. Phone PR

11. ICVerify Licenses ER

12. ALF Expiration EC

Changes to these fields can void the authorization codet
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Branch F/M (SMF955)

Function

This program allows the user to enter and maintain branches to be used
throughout the system.

The branch may be imbedded (inserted) in the GL account number and
transaction from AP, AR, IC, JC, MC, PO, PR and SO may be posted to general
ledger by branch. The branch is separate from the department. Branches may be
set up as separate profit centers where departments may be set up within
branches. Financial reports may be printed by branch; therefore, whenever a
branch is entered or used for a warehouse, the branch defaults to the branch
assigned to the terminal. The warehouse branch (where applicable) takes
precedence over the terminal branch. In accounts payable a branch is assigned
to each document; most AP reports print by branch. In accounts receivable a
branch is assigned to each customer; each AR invoice document is assigned the
branch assigned to the customer. In sales orders each invoice document is
assigned the branch assigned to the warehouse (except the Statement Print).

In all AR reports, the branch assigned to the document takes precedence over
the branch assigned to the customer. The Statement Print sorts the documents
assigned to the customer and prints the customers by branch. In payroll a
branch is assigned to each employee; most PR reports print by branch.

In inventory control, sales orders, purchase orders and manufacturing control, a
branch is assigned by the branch assigned to the warehouse.

User Inputs

The following steps are involved in entering and maintaining branches:
1. Branch

Enter the branch code (2 digits). F2 allows a search (ref. 3).

2. Description

Enter the description of the branch (up to 30 characters).
3. Bank

Enter the default bank for the branch. The entry must be a valid bank. F2 allows
a search (ref. 3).

Technical Notes
FILES UPDATED - SMCNTL
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;¥ Branch F/M [SMF355]

E% Branch F/M [SMF955]
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Rounding Code F/M (SMF610)

Use Rounding Code F/M (SMF610) to enter rounding code information for contract pricing. This
maintenance program allows you to establish rounding rules for contract prices, then indicate on the
contract which rounding code (if any) to use.

You can set rounding rules by several methods:

e The percentage change limit for action, and you can indicate the action to be taken when the
percentage change limit is reached

»  The dollar minimum to met for action to be required, and you can indicate the action to be
taken when the percentage change limit is reached.

e The program or algorithm to use for the rounding rule.

* How to round dollars and/or cents for contract pricing.

User Inputs

The following prompts are required to enter rounding code information:
1. Rounding Code

Enter the rounding code (e.g., AP or 1,) (2 characters).

2. Description

Enter rounding description (e.g., Basic Rounding .05) (up to 30 characters).

Note that during processing the system checks the $ Minimum value first and performs the $ Action
before checking the % Limit value and performing the % Action.

3. % Limit

Enter the percentage change limit for action to be required. For example if you
enter 5 in this input the system reads it as: Take % action is changer is greater
than 5%.

4. % Action

Enter the action to be done when the percentage limit is met. You can select
from: N—Do Not Round, C-Round Cents Only, or A-Use Another Rounding
Code.

5. AltCode

If you select to use an alternate rounding code enter it in the Alt Code input
adjacent to the Action % input.

6. $Minimum

Enter the dollar minimum for action to be required. For example if you enter
10 in this input the system reads it as: Take $ Action if price is less than 103.
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7.  $ Action

Select the action to be done when the dollar minimum is not met. You can select
from: N—Do Not Round, C-Round Cents Only, A-Use Another Rounding
Code

8. AltCode
If you select to use an alternate rounding code enter it in the Alt Code input
adjacent to the $ Action input.

Note that you can enter a rounding procedure (input #9) or select how you want to round dollars and
cents (inputs 10-11). You cannot enter both a rounding procedure and use the Round Dollars and
Round Cents inputs in one rounding code record.

9. Procedure

Enter the program and label to use a customer rounding algorithm.
10. Round Dollars

Enter the Select how you want the dollars rounded. You can select from:
N-Do Not Round dollars, 1-Up to the next increment of, 2-Down to the next
increment of, 3-To nearest increment of, 4-Up to end with, 5-Down to end
with, 6-To nearest number ending with, or 7-Force dollars to

In the adjacent input, enter the value to use in how you selected to round
dollars in contract prices that use this rounding code.

11. Round Cents
Select how you want the cents rounded. You can select from: N-Do Not Round
Cents, 1-Up to the next increment of, 2-Down to the next increment of, 3-To

nearest increment of, 4-Up to end with, 5-Down to end with, 6-To nearest
number ending with, or 7-Force Cents to

In the adjacent input, enter the value to use in how you selected to round
dollars in contract prices that use this rounding code.

12. Try It!

Enter a value to test the rounding rule against. The system displays the
rounded value to the right side of this input.
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Program Change F/M (SMF960)

Function

This program allows the user to keep track of any programming changes made
on the system. The Program Change Report lists program changes in this file.

User Inputs

The following prompts are involved in entering program changes:
1. Program

Enter the program designation of the program modified (6 characters).

2. Sequence Number

The sequence number (e.g., 01-1st change, 02-2nd change, etc.) is assigned by
the system automatically. The user may back up to it from input #3.

3. Date

Enter the date the change was made (ref. 1). CR defaults to the system date.
4. Memo 1

Enter the memo on the change (i.e., line # changed, change made, reason for
change)(up to 60 characters).

5. Memo 2

Enter the memo on the change (up to 60 characters).

6. Memo 3
Enter the memo on the change (up to 60 characters).

Technical Notes

FILES UPDATED - SMCHNG
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E% Program Change F/M [SMF960)
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File F/M (SMF970)

Function

This program allows the user of the FACTS system to add or modify file names,
if files are to be added or changed in the standard system. This information is
used with the survey system. All necessary entries are included with your
system when purchased.

User Inputs

The following prompts are involved in entering file names:

1. File Name

Enter file name (e.g., ARCUST) (6 characters).

2. Description

Enter file description (e.g., customer file) (up to 40 characters).

3. File Type

Enter whether the file type is D-direct, M-multikeyed, S-sort, or I-indexed
(maximum 1 character). CR initially defaults to D.

Technical Notes

FILES USED - SMCNTL
FILES UPDATED - SMFILE
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;¥ Data File description F/M (SMF370)

ES File F/M [SMF970)
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Module Code F/M (SMF980)

Function

This program allows the user to add module codes. The necessary information
is included with your system, no entries are required initially. The module
codes are used in the survey system.

User Inputs

The following prompts are involved in entering module codes:
1. Module Code

Enter the module code (e.g., AP) (2 characters).

2. Description

Enter module description (e.g., Accounts Payable) (up to 30 characters).

3. Program Bytes

Enter number of bytes for all of this module’s programs in thousands (e.g., 676)
(0-9999).

Technical Notes

FILES USED - SMCNTL
FILES UPDATED - SMMODS
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{:* Module Code F/M [SMFI980)

ESi Module Code F/H [SMF980)
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Custom Help Text Maintenance (SME910)

Function

This program allows the user to add and maintain customized help text. Help
text is entered by code. Each code contains a description and lines of text that
may be assigned to any input of any program in the system. Help text is on-line
documentation designed to provide more information on the screen for the user
when needed.

Help codes are user defined and each code may contain up to 999 lines of text.
Once help codes are set up through this program, the user may use the Program
Help F/M program to assign the help code(s) to the appropriate prompts of
programs throughout the system.

Standard or customized help codes can be entered here. Once standard help
text is changed, it becomes customized and can never be overwritten by
standard help text.

Users may add, change or delete help text at any time.
User Inputs

The following steps are involved in entering help text:
1. Help Code

Enter the help code (up to 15 characters). F1 allows standard help text codes to
be entered. F2 allows a search (ref. 3).

2. Description

Enter the description of the help code (up to 50 characters).
3. Begin With Standard Help Text for This Code?

Enter Y or N to indicate whether to start changes by pulling in existing standard
help text. If Y is entered here, standard help text is displayed for the entered
code, and changes may be made to this. If N is entered here, no help text is
displayed, but may be entered. If help text is entered here for an existing help
text code, the entered help text will overwrite the previous help text. CR
defaultsto Y.

Line numbers are assigned beginning with 010 and automatically increment by 10. Enter text (up to
70 characters per line).

F3 ends entry of lines. F4 backs up to the line number; enter the beginning line number. F2 allows the
user to set the line number increments (1-10). If the increment is set to one, a maximum of 999 lines
may be entered. F4 (from line #) will back up and delete the previous line.
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Once help text lines have been added, the following options are available:

# - Changes a line number. Text lines may be changed or deleted by entering the line
number. Enter whether to C-change or D-delete. If D is entered, the line is deleted. If C
is entered, enter text (up to 70 characters). During this change routine, CR defaults to the
currently displayed value of the input. F3 ends entry of lines. F4 backs up to the line
number; enter the new line number. If a new line number is added, the old line number
is deleted. F2 allows the user to set the line number increment (1-10). F4 backs up to the
main input.

L - Lists line numbers. A limited number of line numbers appear on the screen at any time.
The list function allows line numbers to be redisplayed. The user selects the beginning
line number to list.

A - Adds a line number. New line numbers may be added as needed. F3 ends entry of lines.
F4 backs up to the line number; enter the new line number. F2 allows the user to set the
line number increment (1-10). F4 (from line #) will back up and delete the previous line.

M - Moves a line number. Enter beginning line number to move. Enter ending line number
to move. Enter line number where text will be moved (existing lines will be replaced)
one line at a time, or blocks of lines may be moved.

D - Deletes a line number. One line or several lines of notes can be deleted at any one time.
Enter beginning and ending line numbers to delete. Enter N or YES to delete. CR
defaults to N.

P - Pulls in standard help text. This option is only available if N was entered at the Begin
with standard help text for this code? prompt, and either no custom help text was
entered, or custom help text was entered, but then deleted. It allows standard help text
to be pulled in after custom help text is entered and then deleted.

Technical Notes

FILES USED - SMCNTL, SMMODS
FILES UPDATED - SMHELP, SMHLPX
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DESCRIPTIOH AP CHECKS
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LH#t TEXT

G168 There are four types of checks in the Accounts Payable system:

828 printed checks, manual checks, void checks, and noninvoice checks.
838 The Check Print Program is used to print checks generated from the
840 payment selection list. When you are satisfied with the 1list and
858 are ready to print checks, you use this program. One check

860 prints for each vendor and pays the documents listed on the

G760 payment selection list.

875

G868 The Manual Check Entry Program is used to enter and record manual
890 checks {written manually by the user) paying invoices in the open
188 documents file. HManual checks are usually entered after the check has
1168 been written. VYou enter the vendor, manual check number, date

128 and amount and then select the documents paid by the manual check.
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LIHE # TO CHAMGE, OPTION CODE, F2-CHAMGE HEADER, F3-EHD

10-40 Copyright © 1984-2004 Aperum, Inc.



System Management—7.40 File Maintenances

Program Help F/M (SMF990)

Function

This program allows the user to assign help codes set up in the Custom Help
Text Entry to prompts in programs throughout the system.

Each input of each program may be assigned up to four help codes. These codes
are then displayed in order when help text is accessed when the user needs
further instruction for entering data at the input.

Help codes are entered with unlimited text in the Custom Help Text Entry
program.

User Inputs

The following steps are involved in assigning help codes to program prompts:

1. Program

Enter the program designation (name of the program that contains the input
where help text is to be displayed (up to 6 characters). The entry must be a valid
program designation. F2 allows a search (ref. 3).

2. Help Number

Enter the help number , (i.e., the input number of the program entered in input
#1) where help text is to be displayed (1-99).

3-6. Help Code

Enter up to four valid help codes (one for each input) to be displayed when
accessing help text at Help Number. F2 allows a search (ref. 3). At the help code
search, press F1 to toggle between custom help codes and standard help codes.

Technical Notes

FILES USED - SMCNTL, SMNAME, SMHELP
FILES UPDATED - SMHLPR
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Rebuild SM Sort Files (SMU990)

Function

This program allows the user to rebuild system management sort files.

Sort files are used throughout the FACTS system to enable the user to report or
retrieve information in an order other than the order in which the main file is
stored. For example, the records of the customer files are stored in customer
number order. To access this file in alphabetical order requires a sort file which
is stored by an alpha lookup by customer number. The corresponding record in
the main file may then be accessed for the needed information.

The Rebuild SM Sort Files program should only be run under the supervision of
your affiliate.

User Inputs

The following prompts are required to rebuild SM sort files:
1. SMNAMZ

Enter N or Y to indicate whether to rebuild SMNAMZ. This file is the SM menu
access code program designation to the program name file (SMNAME). This file
is used when typing an access code from any menu. The system checks to find
the program assigned to this access code. CR defaults to N.

Technical Notes

FILES USED - SMCNTL, SMNAME, SMFILE
FILES UPDATED - SMNAMZ
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E% Bebuild SM Sort Files (SMU990)
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User-Defined Field Characteristics Entry (SMC996)

Function

Use this program to configure user-defined fields in the following file maintenances, Item F/M
(ICF910), Vendor F/M (APF910), Ship-To F/M (ARF920), or Customer F/M (ARF910), and to have the
fields available in inquiries for information only. User-defined fields (UDFs) give the end-user the
ability to establish the fields meaning and characteristics.

To access this program your (your user code) must be setup with administrator privileges for User-
defined Fields on the Security tab of User Code F/M (SMF410).

When an authorized user accesses a file maintenance that has user defined fields available, you will
have the menu option to edit the field characteristics. Once you set the field characteristics, exit the
File Maintenance program and reentering the program will update the screen with the new field
values. Entering and editing the data in the user defined fields functions exactly like it does for any
other field.

To configure user-defined fields:

1.  After you select the administrator privileges for User-defined Fields setting on the Security tab of
User Code F/M (SMF410).above, exit FACTS and log back in to allow this change to take effect.

2. Access the desired file maintenance program: Item F/M (ICF910), Vendor F/M (APF910), Ship-
To F/M (ARF920), or Customer F/M (ARF910).

3. Access the User-Defined screen of the selected file maintenance.

4. Select the Configure icon or press F1, and the system displays the User-Defined Field
Characteristics Entry (SMC996) program, where you can enter up to five user-defined fields and
the characteristics associated with the field.

Limitations/Exclusions
«  When you change/set characteristics of UDF’s from a file maintenance program, you must
exit the file maintenance and re-enter the file maintenance for those changes to take effect.

» UDF’s may only be Dates, Strings, or Numerics. They cannot be paragraph fields, validated
GL Number fields, or validated Period fields without a modification.

* No UDF may be more than 50 characters long.
 UDFs are not be available in searches without a modification.

« Users cannot establish validation procedures or search procedures for UDFs without a
modification.

* No more than 20 valid values may be established for a validated list.
e Aperum does not support entering UDFs for Temporary Ship Tos.

» User-Defined Fields are available in the file maintenances and on an inquiry view, but they
are not automatically available as columns in searches or appear on reports.
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User Inputs

The following prompts are required to configure user-defined fields:
1. Screen Label

The field name (up to 10 characters) to display for the user defined field of the
file maintenance program.

2. Prompt Text

The command line text (up to 62 characters) to display when the cursor accesses
the user defined field of the file maintenance program.

3. Tool Tip

The text (up to 100 characters) to display when the mouse pointer focuses on the
user defined field of the file maintenance program.

In the Data Definition section of the screen, complete the following:
4. Field Type

The type of user defined field you are configuring: T-Text (default), D-Date, N-
Numeric.

5. Length

The length of the data (up to 50) for the field you are defining.

6. Justification

The justification positioning for the user defined field: 0-Left Justified, 1-Right
Justified.

7. Force Case

GUI Users: Select this checkbox to indicate you would like to force the data entered in the user-defined
field to be upper-case.

CUI Users: Enter Y-yes toindicate you would like to force the data entered in the user-defined
field to be upper-case. & herwi se enter N-no.

8. Required

GUI Users: Select this checkbox to indicate you would like the user-defined field to be a required
entry.

CUI Users: Enter Y-yes toindicate you would like the user-defined field to be a required entry.
O herwi se enter N no.

9.  Numeric Mask

Select the numeric mask for the user defined field. Note this prompt is only
available for user-defined fields with a field type of Numeric and must equal
the length of the data specified.

In the Security section of the screen, complete the following:
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10. Password

Enter the password (if any) you want to require for the user-defined field.
11. User Code

Enter the user code (if any) you want to require for the user-defined field.

\ User-Defined Field Setup for INVENTORY MASTER FILE. Field 1

Field for User data

Field far User data
Field for User data

0 - Left Justified -

Ty ltem F/M [ICF910)
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FACTS

Job Stream

The FACTS Job Stream System allows the user to set up a sequence of programs
to run in a series without user’s interaction.

Job Stream is a timesaving module in that various reports including end-of-
period reports may be set up and run without user’s supervision. The user may
set up a job stream to include up to 99 reports and can let it run overnight
without having to watch and start each report individually.

The Job Stream System is efficient and flexible in allowing the user to set up as
many job streams as needed. Each job stream asks questions about each
program entered which assists the user in the actual running of the job stream.
It also allows the user, at the time of setting up the job stream, to enter in the
inputs for each program. For example, if the user wants to run four customer
lists in four different sort orders, he can enter the customer list four times
varying the inputs each time.

When a job stream is complete, the user may run a Results Print program to find
out the status of how a particular job stream ran, the time each report took to
print, if an error was encountered, etc.

The job stream module also includes a Job Stream Listing which prints what job
stream programs were included, how the user answered the questions
associated with the program, and what the inputs were for each program. Job
streams may be entered, changed or deleted at any time.
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Job Stream Entry (JSE110)

Function

This program allows the user to create and maintain records in the job stream
file. A job stream is where the user may set up a series of programs to run
without user interaction.

The Job Stream Entry Screen consists of two sections. The upper portion of the
screen is called the header portion where general information such as job stream
code, description and date last run are entered. The lower portion of the screen
is called the line-item portion where each program and information such as
number of pages, number of copies, etc., is entered.

A number of questions are asked about every program set up in the job stream
to aid the user:

»  Continue with rest of job stream if an error occurs in this program?
* Run this program if an error occurs in a previous program?
*  Printer used?

* Isaspecial form required?

e Paper width?

» Paper length?

» Change paper before running the program?

e Number of parts paper?

*  Number of copies to print?

*  Number estimated pages for this program?

» If there is an update involved, what should the system do?

After the above questions are asked, the program proceeds to the actual inputs
for each program (see User Inputs documentation on the specific program).

A listing of all job streams entered is available by running the Job Stream Listing
program. Job streams are executed by running the Job Stream Run program
and results of those job streams are available by running the Job Stream Results
Print program.

User Inputs

The following inputs are involved entering a job stream:
1. Job Stream

Enter the job stream code (up to 6 characters). Example: END may be set up to
run the end-of-period reports. F2 allows a search (ref. 2).

2. Description
Enter the job stream description (up to 30 characters).

This concludes the header portion of the Job Stream Entry program. At this time the header is
created. After the header record is created only the description may be changed. The job stream code
can only be changed by deleting and re-entering the job stream code.
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Line numbers are assigned automatically beginning with 010 and incrementing by 10 for each
additional line/program up to 990. In the rare case where 99 entries have been made, the program
advances to the prompt-selection input and refuses further entries.

3. Program

Enter the program name. The entry must be a valid program in the program
names file and the program must be job streamable, i.e., it must be a print,
report or update program. F3 ends line program entries after at least one line
has been created. F4 removes the line and backs up to the previous line
number. F2 allows a search (ref. 2).

4, Error-C

Enter N or Y to indicate whether to continue with the rest of the job stream if an
error occurs in this program of this job stream. CR defaults to N.

5. Error-R

Enter N or Y to indicate whether to run this program if an error occurs in a
previous program of this job stream. CR defaults to N.

Printer - The following inputs are questions regarding the printer.
6. P#

Enter the printer number to use (up to 999). CR defaultsto 0 - LP. F2 allows a
search (ref.2).

7. SF (Special Form)

Enter N or Y to indicate whether a special form is required (this is a memo
field). CR defaults to N.

8. WID (Width of Paper)

Enter the paper width in inches (.1 to 99.9) (this is a memo field); it is used for
reporting purposes only and does not control the program. CR defaults to 14
for standard green bar computer paper.

9. LEN (Length of Paper)

Enter the paper length in inches (.1 to 99.9) (this is a memo field); it is used for
reporting purposes only and does not control the program. CR defaults to 11.

10. CH (Change)

Enter N or Y to indicate whether you need to change the printer paper for this
program. CR defaults to N. If Y is entered, the job stream will stop and wait for
a RUN to begin the program after a paper change.

11. PT (Parts)

Enter the number of parts paper i.e. thickness, to run on (1-99)(this is a memo
field); it is used for reporting purposes only and does not control the program.
CR defaults to 1.

12. CPY (Copy)

Enter the number of copies to print (1-99). CR defaults to 1.

11-4 Copyright © 1984-2004 Aperum, Inc.



System Management—7.40 Job Stream

13. # PGS (Pages)

Enter the estimated number of pages needed to run this program (1-9999). This
number is used in aiding the user at the time the job stream is run in adding up
the estimated number of pages (this is a memo field). CR defaults to 0.

14. UP (Update)

If there is an optional update following this print, enter S-to skip the update, R-
to run the update or O-for operator selection, i.e., the user must enter whether
to update at the time when the program is running. CR defaults to S.

15. After the above questions, the user now answers the questions for the specific program.
Enter the inputs (see User Inputs section of documentation on the program).

This concludes an entry in the line program portion of the job stream entry program. At this time, a
line program record is created in the job stream file. The line number is incremented by ten,
displayed, and the program returns to the program input for the next line program. F3 ends entries
for the current job stream.

The prompt-selection input allows the operator to perform a number of functions;

# - Changes a line program. Line programs may be C-change, D-delete, M-move, S-show
the original answers, or A-answer questions for this line by entering the line number
to be changed.

C - Change routine allow the user to change the programs job stream information. During

this change routine, F1 allows the currently displayed value to remain the same.
D - Delete routine delete the entire line.

M - Move routine allow the user to enter the new line number and the system renumbers
and moves the entire line.

S - Show routine display all answers entered for the job stream.
A - Answer routine allow the user to answer questions for the specific program.

A - Addsaline program. Line programs may be added as needed. F2 allows a search (ref.
2). F3ends entries.

L - Lists line programs. A limited number of line programs appear on the screen at any
one time. The list function allows line programs to be re-displayed. The operator
selects the beginning line number to list.

F2 - Changes header. This allows the operator to change the job stream description. CR
allows the currently displayed value to remain the same.

D - Deletes the job stream. The job stream may be deleted at any time. All line program
records are removed. The screen is then cleared and the program returns to the job
stream code input to await further entries.

F3 - Accesses the ending routine. F3 ends entries for the current job stream.
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Technical Notes

At the conclusion of the header portion, a header record is created in the job
stream file (JSJOBS). At the conclusion of a line program, a line-item record is
created in the job stream file.

FILES USED - SMCNTL, SMNAME, SMTRCT
FILES UPDATED - JSJOBS

B Job Stream Entry (JSE110)
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How to create and maintain records in the job stream

file
1.

2.

Access this program by selecting Job Stream—>Job Stream Entry.

In the Job Stream input, enter an existing job stream code (up to 6 characters) or create a new one.
For example, END may be the name of the job stream code you use to run the end-of-period
reports. F2 allows a search of existing codes.

If you're creating a new code, enter a description for it in the input. The description can be up to
30 characters long. If you have selected an existing code, the description automatically displays.

After you complete the header section, press Enter (CR) to access the Job Stream Entry line-item
section:

In the Program input, enter the program name. The entry must be a valid program in the
program names file and the program must be compatible with the Job Stream system — that is, it
must be a print, report or update program. You can press F3 to end line program entries after at
least one line has been created, F4 to remove the line and back up to the previous line number, or
press F2 to search.

In the Error-C input, enter N or Y to indicate whether to continue with the rest of the job stream if
an error occurs in this program during this job stream. Press Enter (CR) to default to N.

In the Error-R input, enter N or Y to indicate whether to run this program if an error occurs in a
previous program of this job stream. Press Enter (CR) to default to N.

In the Printer section, the following inputs are questions regarding the printer.

P# Enter the printer number to use (up to 999). Press Enter (CR) to defaultto 0 - LP. F2
allows a search.

SF (Special Form) Enter N or Y to indicate whether the program prints to a special form
(this is a memo field). Press Enter (CR) to default to N.

WID (Width of Paper) Enter the paper width in inches (.1 to 99.9) (this is a memo field); it is
used for reporting purposes only and does not control the program. Press Enter (CR) to default
to 14 for standard green bar computer paper.

LEN (Length of Paper) Enter the paper length in inches (.1 to 99.9) (this is a memo field); it is
used for reporting purposes only and does not control the program. Press Enter (CR) to default
to 11.

CH (Change) Enter N or Y to indicate whether you need to change the printer paper for this
program. Press Enter (CR) to default to N. If Y is entered, the job stream will stop and wait for a
RUN to begin the program after a paper change.

PT (Parts) Enter the number of parts paper i.e. thickness, to run on (1-99)(this is a memo
field); it is used for reporting purposes only and does not control the program. Press Enter (CR)
to default to 1.
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10.

11-8

CPY (Copy) Enter the number of copies to print (1-99). Press Enter (CR) to default to 1.

# PGS (Pages) Enter the estimated number of pages needed to run this program (1-9999). This
number helps you add up the estimated number of pages at the time the job stream is running
(this is a memo field). Press Enter (CR) to default to 0.

UP (Update) If there is an optional update following this print, enter S-to skip the update, R-to
run the update or O-for operator selection, i.e., the user must enter whether to update at the time
when the program is running. Press Enter (CR) to default to S.

After the above questions, the system displays questions for inputs in the specific program. Enter
the inputs for the program specified as you normally would. Repeat these steps for each program
you want to add to the job stream.

When you finish adding programs, press F3 to end entries. The following options can be accessed
from the prompt-selection input once you have created line items and ended entries.

# Line # to change. At the selection prompt, enter the number of the line that you want to
modify. The options are C-change, D-deleted, M-moved, S-show the original answers, or A-
answer questions for this line.

C Change. Allows you to change any information on that line, including program name and
any printing specifications. If you decided you want to leave the information as it is, press F1 to
keep the currently displayed information.

D Delete. Allows you to delete the line you selected.

M Move. Allows you to move this line, which changes the order in which the program runs.
The program asks you for a new line number.

S Show. Displays all answers you supplied for the job stream.

A Answer. Allows you to answer questions for the specific program.

The rest of the options affect the line-item entry section, rather than an individual line.

L Lists line programs. Since a limited number of line programs appear on the screen at any
one time, the list function lets you display additional lines. Select the beginning line number that
you want to see listed.

A Adds a line program. Once you’ve finished making line entries, you may decide you
want to add additional programs to the job stream. Enter A at the prompt. Press F2 to search for a

program name. Press F3 to end entries.

F2 Changes header. This allows you to change the job stream description. CR allows the
currently displayed value to remain the same.

D Deletes the job stream. The job stream may be deleted at any time. All line program
records are removed. The screen is then cleared and the program returns to the job stream code
field to await further entries.

F3 Accesses the ending routine. F3 ends entries for the current job stream.
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11. When you have finished entering job stream information, press F4 to exit the program.
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Job Stream Run (JSU110)

Function

This program allows the user of the FACTS system to run a job stream
previously entered into the Job Stream Entry program.

The Job Stream Run program executes every program set up in the job stream
according to the questions answered and the inputs entered. ALWAYS be sure
that stored inputs for each program are correct before running a job stream.

User Inputs

The following inputs are involved in running a job stream:
1. Job Stream

Enter the job stream code to run. The entry must be a valid job stream name. A
valid entry displays the job stream description. Also displayed is the form size

and the number of pages needed to complete the job stream (estimated number
of pages). F2 allows a search (ref. 2).

2. Results for this job stream are still on file. Remove them?

If there are no results on file for this job stream, this input is skipped. Results
are created during the Job Stream Run program and may either be removed by
the optional update of the Job Stream Results Print program or at this input.
Results must be removed in order to run a job stream. Enter N or Y to indicate
whether to remove the results. CR defaults to N and returns to input #1. If Y is
entered, the records are removed and the program continues.

3. Minutes To Begin

Enter the number of minutes to wait before beginning the job stream. CR
defaults to zero minutes.

Press F1 to enter the start date and time instead of the number of minutes to
wait.

If you pressed F1, the system displays additional inputs:

4. Start Date

The start date for the job stream. Press Enter (CR) to default to the system date.
5. Start Time

The start time for the job stream. Press Enter (CR) to default to the system time.

Technical Notes

Processing proceeds by reading through the job stream file (JSJOBS) for the job
stream being run. Results are written to the results file (JSRSLT), the terminal
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keeps track of which job stream is running (JSTERM) and the last date job
stream run is written to the job stream file.

FILES USED - SMCNTL, SMNAME
FILES UPDATED - JSIOBS, JSRSLT, JSTERM

ESJob Stream Run [JSU110)

Copyright © 1984-2004 Aperum, Inc. 11-11



Job Stream System Management—7.40

How to run a job stream

1.

2.

11-12

Access this program by selecting Job Stream-> Job Stream Run.

In the Job Stream input, enter the code for the job stream you want to run. The entry must be a
valid job stream name. A valid entry displays the job stream description. Also displayed is the
form size and the number of pages needed to complete the job stream (estimated number of
pages). Press F2 to a search.

At the command prompt in the lower portion of the screen the system displays the message:
Results for this job stream are still on file. Remove them?

If there are no results on file for this job stream, this input is skipped. Results are created during
the Job Stream Run program and may either be removed by the optional update of the Job Stream
Results Print program or at this input. Results must be removed in order to run a job stream.
Enter N or Y to indicate whether to remove the results. Press Enter (CR) to default to N and
return to input #1. Enter Y to remove records and continue.

In the Minutes To Begin input, enter the number of minutes to wait before beginning the job
stream. Press Enter (CR) to default to zero minutes. Press F1 to enter the start date and time
instead of the number of minutes to wait.

(Optional) If you pressed F1, the system displays additional inputs:

Start Date: Enter the start date for the job stream. Press Enter (CR) to default to the system date.

Start Time: Enter the start time for the job stream. Press Enter (CR) to default to the system time.

Press Enter (CR) to run the job stream or F4 to backup.
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Job Stream Results Print (JSR110)

Function

This program allows the user to print a listing of the results of previously run
job streams. Job stream results are only available after the job stream has been
entered and run. There is an optional update at the end of the program to
remove the records printed.

Report information includes the following: job stream code and description,
date last run, each program name and description run within the job stream,
date run, start time, number of copies completed, and the status of completion.
The total number of completed programs listed is also included.

User Inputs

The following inputs are involved in printing Job Stream Results:
1. Beginning Job Stream

Enter the beginning job stream to print. CR defaults to FIRST.
2. Ending Job Stream

Enter the ending job stream to print. CR defaults to LAST.

3. Remove printed records from the results file?

After printing the results, enter YES or N to indicate whether to remove the
records just printed.

Technical Notes

Printing proceeds by reading through the job stream results file (JSRSLT) and
printing results for those job streams which meet the criteria entered. If results
are removed, the system removes results from the job stream results file.

FILES USED - JSIOBS, SMNAME
FILES UPDATED - JSRSLT
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K% Job Stream Results Print (JSR110]
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Job Stream Listing (JSR120)

Function

This program allows the user to print a listing of all the job streams.

Job streams are entered through the Job Stream Entry program and executed by
running the Job Stream Run program.

Report information includes the following: job stream code, description, date
last run, program name and description, answers to questions (optional), and
inputs. The total number of programs listed is also included.

User Inputs

The following inputs are involved in printing a Job Stream Listing:
1. Beginning Job Stream

Enter the beginning job stream to print. CR defaults to FIRST.
2. Ending Job Stream

Enter the ending job stream to print. CR defaults to LAST.

3. Include Answers

Enter N or Y to indicate whether to include current answers (inputs) stored for
each program within each job stream in the listing. CR defaults to N.

Technical Notes

Printing proceeds by reading through the job stream file (JSJOBS) and printing
job stream information for job streams meeting the criteria entered.

FILES USED - SMCNTL, JSJOBS, SMNAME
FILES UPDATED - NONE
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Office Automation

The Office Automation module is a system that was designed to help run the
user’s office internally. All employees should be set up to use it. The system
allows users to enter phone directories, record phone messages, send general
messages, view phone and general messages, use a sign-out board, enter
schedules and maintain and print mailing labels.

Office Automation is broken down into the following menus: Sign In/Out,
Messages, Calendar/Scheduler, Inquiries, Reports & Prints and File
Maintenances.

Employees are set up through the Employee F/M program. As employees are
set up, they are assigned to a user. Once set up, whenever employees sign in to
the system using their user code, the Office Automation system recognizes the
user code validating it with the employee. An Employee Listing may be printed
to verify employees. Once employees are set up, the user may enter group
codes. Group codes are set up with employees assigned to them.

Group codes are set up with the purpose of sending messages to group codes
rather than every employee within the group code. For example, there might be
10 employees in the sales & marketing department. A group code called SALES
would be set up with each sales & marketing employee assigned to that group
code. When the director of the sales & marketing department needs to
announce a meeting for the entire department, rather than entering the same
message for each individual employee in the department, the director may enter
one message for the group code. Each employee in the SALES group code,
when retrieving messages, will receive the message.

Phone directories may be set up through Office Automation. Employees may
set up general phone directories for all employees to access. Employees may
also set up personal directories which are only accessible by the employee (user
code) who entered the record initially. General and personal phone directories
may be printed by running the Phone Directory Print program.

The Office Automation system keeps track of an employee’s whereabouts
through the use of a sign out board. When employees are leaving the office the
Sign In/Out program is used. Employees enter the time, where they are going,
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the expected return time and where they can be reached. The Sign Out Board
Inquiry program may be used to locate an employee’s whereabouts at any time.
When employees return to the office the Sign In/Out program is used again to
sign back into the office. At the time when an employee signs in the system
displays a welcome communication, and if the employee has any messages on
file, a communication is displayed indicating that there are messages.

General and phone messages may be entered for employees. There is a Phone
Message Entry program where users enter phone messages including message
options (example, please call back, etc.). There is also a General Message Entry
program where users enter general messages to be sent to an individual
employee or a group code (group of employees).

If an employee has any new phone or general messages that have not been read,
a message to that effect will display on any menu screen the employee accesses.
Messages may then be retrieved through the Message Viewing/Disposition
Program. Once a message has been viewed, employees may indicate the
message has been read, delete the message or send the message to another
employee.

Employees can maintain their schedules through the Calendar/Scheduler
program. The calendar is available to display one day at a time (where
scheduled activities may be entered for each half hour), one week at a time
(display only) and one month at a time (display only). Company calendar notes
may be entered on the daily calendar through the Company Calendar Notes
F/M. Employees’ schedules are then available for printing through the
Schedule Print program including unscheduled time.

The Office Automation System contains a Mailing Label System. Each mailing
label must be entered into the system through the Mailing Label F/M Program.
Each label entered may be assigned up to 5 mail codes. Mail codes must be
previously set up through the Mail Code F/M program. An example of mail
codes might be PRO - prospects or GEN - general company mail-out. Mail
codes are used to select and sort mailing labels to print. The Mailing Label
Report lists mailing labels by mail code along with selected file information.
Mailing labels may be printed for specific mail codes through the Mailing Label
Print F/M program.
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Sign In/Out (OAE110)

Function

This program allows the user to sign in and out. In order to run this program,
the user must be set up for OA (must be a valid employee).

The system keeps track of employees, i.e., if they are in or out. If the employee
is previously signed in, the program knows the employee is signing out. If the
employee is previously signed out, the program knows the employee is signing
in.

When this program is run, the user is prompted to enter the employee code at
the bottom of the menu screen. When this employee is signed in, the sign-in
message is displayed. If this employee has any messages, YOU HAVE
MESSAGES is displayed along with the sign-in message.

Employees that are signed out are displayed in the Sign-Out Board program.
Sign-out information is stored in the employee file.

User Inputs

The following inputs are involved in signing in/out:
1. Employee

Enter the employee code (up to 8 characters). This must be a valid employee in
the employee file. CR defaults to the user’s employee code.

2. Areyou in?

If the employee has been previously signed out, enter Y-yes or N-no. CR
defaults to Y. If Y is entered, the employee is signed in and the sign-in message
is displayed. The user is notified if the employee has messages, CR to continue
and inputs are ended, the employee’s sign-out information is removed from the
employee’s file, and the program ends.

If the employee has not been signed out, the sign-out screen is then displayed.
3. Out Date

Enter the sign-out date (ref. 2). CR defaults to the system date.
4. Out Time

Enter the sign-out time (HH:MM ?M) (example 10:30 AM). CR defaults to the
system time.

5. Expected Date

Enter the date that the employee is expected back (MMDDYY). CR defaults to
the out date.

6. Expected Time

Enter the time that the employee is expected back (HH:MM ?M). CR defaults to
one hour after the out time.
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7. Reach At Phone

Enter the phone number where the employee may be reached at while signed
out (including dashes, area code and extension) (up to 17 characters).

8. Memo 1

Enter the first memo line (up to 25 characters).
9. Memo 2

Enter the second memo line if needed (up to 25 characters). If no memo is
entered in input #8, this input is skipped.

10. Update
CR to update the employee file.

After the update, this program returns to the menu.

Technical Notes

The employee file (OAEMPL) records employee sign-in/out information.
FILES USED - SMCNTL, SMZART, OAPHMS, OAGNMT
FILES UPDATED - OAEMPL

Li¥ Sign In/Out [OAE110)
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How to sign in and out of the OA system

1. Access this program by selecting Office Automation->Sign In/Out.

2. Inthe Employee input, enter your employee code (up to 8 characters).
Press Enter (CR) to default to your employee/user code. If the program
doesn’t recognize the code, the screen will remain blank and the cursor will
keep flashing at the selection prompt. This means that your code needs to
be created in Employee F/M.

3. If you have not signed out, the system displays the message: Are you in?
Enter Y-yes or N-no. Press Enter (CR) to default to Y, which tells the
system and other users that you are in the building. You are notified if you
have messages, press Enter (CR) to continue, and the system removes your
employee sign-out information from your employee file, and the program
ends.

--OR--

If you have not signed out, the sign-out screen displays instead. Complete
the following to sign out:

Out Date—Enter the sign-out date. Press Enter (CR) to default to the
system date.

Out Time—Enter the sign-out time (HH:MM ?M) (example 10:30 AM).
Press Enter (CR) to default to the system time.

Expected Date—Enter the date you expect to return (MMDDYY). Press
Enter (CR) to default to the same date entered in the out date field.

Expected Time—Enter the time you expect to return (HH:MM ?M). Press
Enter (CR) to default to one hour after the out time.

Reach At Phone—Enter a phone number where you can be reached while
you are out. Include dashes, area code and extension. This field accepts up
to 17 characters.

Memo 1—(Optional) If you wish to enter a memo about where you are,
how you can be contacted, etc., enter up to 25 characters on the first memo
line. Press CR to leave the memo line blank and skip the next field.

Memo 2—If you entered a memo in the previous field, you can enter
another 25 characters in this field to extend the memo. If you left the
previous prompt blank, the program skips this field.

4. Press Enter (CR) to update your file. After the update, the program returns
to the Office Administration master menu.

12-6 Copyright © 1984-2004 Aperum, Inc.



System Management —7.40 Office Automation

Messages

Function

The Office Automation message program allows the user to send phone and/or
general messages to valid employees, view messages sent to a valid employee,
and update and/or delete these messages.

1. The Phone Message Entry program allows the user to enter, update,
send or delete phone messages for employees.

2. The General Message Entry program allows the user to enter, update,
send or delete general messages for employees.

3. The Message Viewing/Disposition program allows the user to read,
send or delete phone and/or general messages for employees.
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Phone Message Entry (OAE210)

Function

This program allows the user to enter, change or delete phone messages for an
employee.

Phone messages are written to the phone messages file and may be viewed in
the Message Viewing/Disposition program.

User Inputs

The following inputs are involved in entering phone messages:
1. For

Enter a valid employee that is to receive the phone message. F2 allows a search
(ref. 5).

2. Msg #

This input is initially skipped and the next available phone message number is
assigned from the Nonstatic control file and is displayed at the top of the screen.
To enter a different message number, enter an existing phone message number
(1to0 9999). This allows the user to change or delete an already existing phone
message by backing up to the user inputs or deleting the phone message after it
is displayed on the screen.

3. MR/MS

Enter name of person this phone message is from (up to 25 characters).

4. Of

Enter the company of the message sender (up to 25 characters).
5. Phone

Enter the message sender’s phone number (including dashes, area code and
extension) (up to 17 characters).

6. Message Option(S)

Enter the message option(s) side by side which apply in any combination: 1-
Telephoned, 2-Returned your call, 3-Will call again and/or 4-Came to see you.
CRinitially defaults to 1.

7. Request Option(S)

Enter the request option(s) side by side which apply in any combination: 1-
Please call, 2-Please stop by, 3-Urgent.

8. Memo

Enter up to three memo lines (up to 70 characters each). CR initially allows the
user to end memo inputs.
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9. Is this ok?

Enter Y-yes to send message or N-no to change or delete message. CR defaults
to.

After sending the message, the screen is cleared of input information and the program returns to
input #1 to await further entries.

Technical Notes

FILES USED - OAEMPL
FILES UPDATED - SMCNTL, OAPHMS

E: Phone Message Entiy [DAE210)
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How to enter, change or delete phone messages

1.

2.

10.

11.

Access this program by selecting Office Automation->Message—>Phone Message Entry.

In the For input, enter the code for the employee for whom the message belongs. Press F2 to
search.

In the Msg # input the system automatically assigns the message number based on information
provided by the OA Nonstatic Control F/M. The message number displays in the top right-hand
corner of the screen. Press F4 to back into this field and change the message number. Message
numbers range from 1 to 9999. This allows you to change or delete an existing phone message.

In the MR/MS input, enter the name of person who left the message. This field accepts up to 25
characters.

In the Of input, enter the company this person is with. This field accepts up to 25 characters.

In the Phone input, enter the phone number at which this person can be reached. Include dashes,
area code and extension. This field accepts up to 17 characters.

In the Message Option(S) input, enter all applicable message option(s) side by side in any order.
You can select from: 1-Telephoned, 2-Returned your call, 3-Will call again and/or 4-Came to see
you. Press Enter (CR) to initially default to 1.

In the Request Option(S) input, enter all applicable request option(s) side by side in any order.
You can select from: 1-Please call, 2-Please stop by, 3-Urgent. Press CR to leave request options
blank.

(Optional) In the Memo input, enter up to three memo lines — up to 70 characters per line. Press
Enter (CR) to skip over the memo section.

The system displays the message: Is this OK? Press Enter (CR) ( Y-yes) to send the message or
enter N-no to change or delete message.

After you send the message, the screen clears and the prompt returns to the first field so you can
enter additional messages. Press F4 to return to the menu system.
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General Message Entry (OAE220)

Function

This program allows the user to enter, change or delete general messages for an
employee. In order to run this program, the user must be set up for OA (must
be a valid employee). General messages are written to the general message file
and may be viewed in the Message Viewing/Disposition program.

The General Message Entry screen consists of two sections. The upper portion
of the screen is called the header portion where the message number and
employee, etc., is entered. The lower portion is called the line-item portion
where each message line is entered.

User Inputs

The following inputs are involved in entering general messages:
1. Msg#

This input is initially skipped and the word NEXT is displayed until the next
general message number is automatically assigned. To enter a different
message number, enter an existing general message number (1-9999). This
allows the user to change or delete (if the user is the original author of the
message) an existing general message.

2. From

This input is initially skipped and the user’s employee code is assigned to the
employee. If the message is not from the user, enter the valid employee. F2
allows a search (ref. 5).

3. Regarding

Enter reference of general message (up to 30 characters). At least one character
must be entered.

4. Reply Required
Enter N or Y to determine if a reply is required. CR defaults to N.

This concludes the header portion of the General Message Entry program. At this time, the message
number is automatically assigned from the Nonstatic control file and is displayed at the top of the
screen. After the header record is created, all the header inputs are accessible through the change
header routine.

The line-item portion of the program allows entry of up to 999 message lines. In the rare case where
999 line-items have been entered on a single message, the program advances to the prompt-selection
input and refuses further entries.

5. Message

Enter the message (up to 70 characters per line). The message line number’s are
automatically assigned. F3 ends entry of lines. F4 backs up to the line number;
enter the beginning line number. F2 allows the user to set the line number
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increments (1-10). If the increment is set to one, a maximum of 99 lines may be
entered. F4 (from line #) backs up and deletes the previous line.

Once messages have been added, the following message edit inputs are
available:

# - Changes line number. Messages may be changed or deleted by entering the line number.
Enter whether to C-change or D-delete. If D is entered, the line is deleted. If C is
entered, enter text (up to 70 characters). During this change routine, CR allows the
currently displayed value of the input to remain the same. F3 ends entry of lines. F4
backs up to the line number; enter the new line number. If a new line number is added,
the old line number is deleted. F2 allows the user to set the line number increment (1-
10). F4 backs up to the main input.

L - Lists line numbers. A limited number of line numbers appear on the screen at anytime.
The list function allows line numbers to be redisplayed. The user selects the beginning
line number to list.

A - Adds a line number. New line numbers may be added as needed. F3 ends entry of lines.
F4 backs up to the line number; enter the new line number. F2 allows the user to set the
line number increment (1-10). F4 (from line #) backs up and deletes the previous line.

M - Moves a line number. Enter beginning line number to move. Enter ending line number
to move. Enter line number where text will be moved (existing lines will be replaced)
one line at a time, or blocks of lines may be moved.

D - Deletes a line number. One line or several lines of messages can be deleted at any one
time. Enter beginning and ending line numbers to delete. Enter N or YES to delete. CR
defaults to N.

This concludes the line-item portion of the General Message Entry program.
F3 - Ends edit message inputs and goes to the prompt-selection input which allows the user

to perform a number of functions.

D - Deletes the entire general message. If the user is the original author of the message, then
the sort files are updated, all message line records are removed and then the header
record is removed. The screen is then cleared of most of the input information and the
program returns to input #3 to await further entries.

F1 - Changes message. This takes the user to the edit message inputs where message lines
may be changed, added, moved and/or deleted as necessary.

F2 - Changes header. Header information in the upper portion of the screen may be changed
as necessary.

F3 - Sends. This ends the prompt-selection inputs and the program proceeds to the send
message inputs.

The send message inputs allow the user to perform a number of functions;

E - Employee. Enter an employee to receive the message (ref. 3).

G - Group. Enter the group code of the employees to receive the message (up to 4
characters). The entry must be a valid group code which has been set up in the Group
Code F/M program. F2 allows a search (ref. 5).
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F2 - Displays receivers. The message line section of the screen is cleared, the message
receivers are numbered and displayed so that the user may delete an existing receiver
for this message by entering its corresponding line number.

F3 - Ends inputs. The screen is cleared of the line-item information and the program returns
to input #3 to await further entries.

chnical Notes

At the conclusion of the header portion, a message number is automatically
assigned and a header record is created in the general message file (OAGNMS).
As each message line is entered, it is also written to the general message file.

The direct file for employee viewing and the sort on employees file are updated
for each employee and group that the message is sent to.

FILES USED - SMZART, OAEMPL
FILES UPDATED - SMCNTL, OAGNMS, OAGNMX, OAGNMT

m General Message Entry [DAE 220) =13
Help

@1-Specialty Distributors, I GEHERAL MESSAGE ENTRY HSGH# HEXT onE22d
FROM GUI George U. Invencent

REGARDIHNG | .............................. REFLY REQUIRED

LH# MESSAGE
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How to enter, change or delete general messages

1.

2.

10.

Access this program by selecting Office Automation> Messages—>General Message Entry.

In the Msg# input, the system displays the word NEXT until you complete the header. To enter
a different message number, enter an existing general message number from 1-9999. If the system
has not assigned a message number, it will not let you enter it. This allows you to change or
delete an existing general message as long as you originally created the message.

In the From in input, the program automatically uses the employee code that belongs to the
person entering the message. If the message you are entering a message for another employee,
enter that person’s employee code. Press F2 to search.

In the Regarding input, enter the message’s general subject. This entry can be up to 30 characters
long. Enter at least one character.

In the Reply Required input, enter N or Y to designate that a reply is required. Press Enter (CR)
to default to N.

The message number displays in the top right-hand corner of the screen. To return to the header
once you are in the line-entry section, press F2.

In the Message input, enter your message. Each line can be up to 70 characters long. The program
automatically assigns the message line numbers.

When you finish entering the message, press Enter (CR) so that your cursor is on a blank line and
then press F3.

You can:

Press F4 to back up to the line number input, where you enter the beginning line number.
Press F2 to set line number increments (1-10). If the increment is set to one, a maximum of 99
lines may be entered.

Press F4 from the line number field if you want to back up and delete the previous line.

(Optional) If you need to modify any of the message lines, enter the line number and press Enter
(CR). The following message edit inputs are available:

L Lists line numbers. Since a limited number of line numbers appear on the screen at
anytime, the list function lets you display additional line numbers. Enter L and then the
beginning line number to list.

A Adds a line number. New line numbers may be added as needed. F3 ends entry of lines.
F4 backs up to the line number; enter the new line number. F2 lets you set the line number
increment (1-10). F4 (from line #) backs up and deletes the previous line.

M Moves a line number. Enter beginning line number to move. Enter ending line number
to move. Enter line number where text will be moved (existing lines will be replaced) one line at
a time, or blocks of lines may be moved.

D Deletes a line number. One line or several lines of messages can be deleted at one time.
Enter beginning and ending line numbers to delete. Enter N or YES to delete. CR defaults to N.
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During this change routine, press Enter (CR) to leave the selected as is.
11. (Optional) You can:
e -Press F4 to back up to the line number and enter the new line number. Keep in mind that
you are deleting the old line number when you do this. Use F2 to set the line number
increment (1-10).
e -Press F4 to back up to the previous memo line from the line number field.
12. (Optional) Press F3 when you finish editing the message.
13. This returns the cursor to the prompt-selection input, where you can perform the following:
D Delete the entire general message. If you are the original author of the message, then the system
deletes the message and updates the sort files. All message lines are removed, as well as the header

information. The screen clears everything except the information entered in the first two prompts.

F1 Change message. If you decide you need to make additional changes to the message you can
press this key. The message edit inputs will appear on screen.

F2 Change header.
F3 Send Message
14. When you press F3 to send the message, the following send options become available:

E Employee. Enter employee code for individual receiving the message. If the program does not
accept the code, the user needs to be set up in Employee F/M. F2 allows a search.

G Group. Enter a group code. F2 allows a search.

F2 Display receivers. If you entered a group code, the distribution list appears on screen. This gives
you the opportunity to remove employees from the distribution list for this message only. Enter the
number next to the user you want to remove and press CR. Repeat to remove additional users.

F3 Abort/Ends inputs. This essentially gives you one last chance to abort the message. If you press
F3 instead of Enter (CR), the screen clears all but the first two fields and waits for you to enter another
message.

Enter (CR) Send the message.

15. Press Enter (CR) to send the message. Press f4 to exit the program.
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Message Viewing/Disposition (OAE230)

Function

This program allows the user to read, send, and/or delete general and/or
phone messages to a specified employee.

User Inputs
The following inputs are involved in running the Message Viewing/Disposition program:

1. Employee

Enter the valid employee whose messages are to be viewed. CR defaults to the
user’s employee code (ref. 3).

If the employee has no messages, a message NO PHONE OR GENERAL MESSAGES - CR-
CONTINUE is displayed. CR returns the user to prompt #1 then the user may either press CR to
enter another employee or F4 to end.

2. Phone/General

This input is initially skipped unless the employee has both phone and general
messages. Enter P to view phone messages or G to view general messages. CR
defaults to P.

If the phone messages are viewed, the displayed information includes: R (if the message has been
read), date and time of the message, who the message is from and the phone number, selected
messages and requests.

The Initial Phone Message inputs allow the user to select a phone message for further viewing, view
a list of more phone messages, and/or delete all of the employee’s phone messages.

Ln# - Line number. Enter the number of the phone message to display more information (at the
bottom of the screen) including: memos, the message number, if this message was originally sent
to another employee, and who the message was routed from. The program will then proceeds to
the Secondary Phone Message inputs which allows the user to perform a number of functions
including those concerning the selected phone message.

CR - Next. CR clears the screen and continues to display more phone message information.
D - Deletes all. The user may remove all of this employee’s phone messages from the phone
messages file. The screen is then cleared of most of the information and the program returns to
the phone/general input to await further entries.
The Secondary Phone Message inputs allow the user to select another phone message, view a list of
more phone messages, delete the phone message, determine if the phone message has been read

and/or send the phone message to another employee.

Ln# - Line number. If the user wishes to select another phone message, enter the number
associated with it.
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CR - Next. CR clears the screen and continues to display more phone message information.

D - Deletes. The user may remove the selected phone message from the phone message file. The
screen is then cleared of most of the information, the phone message information is displayed
from the beginning of the phone message file, and the program returns to the Initial Phone
Message inputs to await further inputs.

R -Reads. The user may mark certain phone messages as R-read as to distinguish them from
phone messages that have not yet been viewed. This would cause an R to be placed beside the
line number of the read phone message.

S - Sends. The user may send a phone message to another valid employee. When an employee
receives the phone message, the sender of the message is displayed at the bottom of the screen
when the appropriate message line number is selected.

If the general messages are viewed, the displayed information includes: R (if the message has been
read), date and time of the message, who the message is from, what the message is in regard to and if
there is a reply required.

The initial general message feature allows the user to select a general message for further viewing,
view a list of more general messages and/or delete all of the employee’s general messages.

Ln# - Line number. Enter the number of the general message to display more information on the
text portion of the message and the message number. The program then proceeds to the
Secondary General Message input which allows the user to perform a number of functions
including those concerning the selected general message.

CR - Next. CR clears the screen and continues to display more general message information.

D - Deletes all. The user may remove all general messages for this employee. The screen is then
cleared of most of the information and the program returns to input #2 to await further entries.

The Secondary General Message inputs allow the user to view a list of more general messages, delete
the general message, determine if the general message has been read and/or send the general
message to another employee.

CR - Next. CR clears the screen and continues to display more general message information.

D - Deletes. The user may remove the selected general message. The program then returns to
the initial general message feature to await further inputs.

R - Reads. The user may mark certain general messages as R-read as to distinguish them from
general messages that have not yet been viewed. This causes an R to be placed beside the line
number of the read general message.

S - Sends. The user may send a general message to another valid employee.

Technical Notes

The phone messages file (OAPHMS) is updated whenever a phone message is
deleted, read and/or sent, the direct file for to employee viewing is updated

when a general message is deleted, read and/or sent, the sort on to employees
file is updated when a general message is deleted and/or sent and the general
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messages header and detail files may be updated when a general message is
deleted if there are no more employees to which this message is sent.

FILES USED - SMCNTL, OAEMPL, SMZART
FILES UPDATED - OAPHMS, OAGNMS, OAGMNT, OAGNMX

LY Message Yiewing/Disposition (OAE230]
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How to read, send and delete general and phone
messages

1.

2.

12-20

Access this program by selecting Office Automation—>Messages—>Message Viewing/Disposition.

In the Employee input, enter code for the employee whose messages you want to see. Press Enter
(CR) to default to your own user code.

If the employee has no messages, NO PHONE OR GENERAL MESSAGES - CR-CONTINUE
appears. Press Enter (CR) to return to the first field. You can either enter a new user code or press
F4 to return to the menu system.

In the Phone/General input, select the type of messages to view. Enter P to view phone messages
or G to view general messages. Press Enter (CR) to default to phone message. If you don’t have
phone messages, the program automatically defaults to general messages.

If you are displaying phone messages, the system displays the date and time the message was
entered, who left it, that person’s phone number and any selected message and request options.
An R appears next to each message that has been read.

--OR--
If you are displaying general messages, the displays the date and time the message was entered,
who sent the message, the message’s subject and whether a reply is required. An R appears next

to each message that has been read.

At the main screen, you can s elect from the following options. These options generally affect all
messages for the selected user.

Ln# - Line number. Get more information on a particular phone or general message by entering
its line number. Once you have selected a line, a set of secondary message inputs become
available. These options only affect the message you selected.

Ln# Line number. Allows you to select another message by entering another line number.

CR Next. Takes you back to the main screen so you can view more messages.

D Delete. Allows you to delete the selected phone or general message from the system.
R Read. Marks the selected message read. An R will appear next to the line number.

S Send. Forwards a message to another employee in the system. When that employee

receives it, your employee code displays at the bottom of the screen when the line is selected.
CR - Next. CR lets you scroll through the list of messages.

D - Delete all. Use this feature to remove all general or phone messages for this employee. When
all messages are deleted, the cursor returns phone/general field so you can switch message types.

Press F4 to back up and select another user.
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7. Toexit the program, press F4 again.
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Calendar/Scheduler (OAE310)

Function

This program allows the user to view company calendar notes, enter, change or
delete an employee’s scheduled events and daily memos. This program consists
of three screens: daily, weekly and monthly. All entries that appear are entered
on the daily screen, except company notes. Company notes are entered in the
Company Calendar Notes F/M program.

User Inputs

The following inputs are involved in running the Calendar/Scheduler program:
1. Employee

Enter the valid employee whose events and daily memos are to be scheduled
and/or viewed. CR initially defaults to the user’s employee code (ref. 3). F2
allows a search (ref. 5).

2. Date

Enter the date when to start scheduling and/or viewing events and daily
memos (ref. 2). CR initially defaults to the system date.

3. View

Enter D-to view the daily screen. The daily screen allows the user to enter
appointments, memos and events, which will appear also on the weekly and
monthly screen. No entries can be made on the weekly or monthly screens.
Enter W-to view the weekly screen or M-to view the monthly screen. CR
defaults to M initially or to whichever screen is presently displayed.

Daily Screen

Time-Time to schedule. Enter the time to schedule an event. The time may be
entered in several formats (3.5, 3.50, 3:30 and 3:3). After entering the time, the
user is prompted to enter the scheduled event (up to 70 characters), and is
asked UNTIL WHAT TIME? where the user enters the ending time of the
event. An * (asterisk) is then printed in the scheduled periods. The user may
delete a scheduled event by entering a blank at the appropriate time.

M - Memo. Enter the daily memo (up to 70 characters). The user may delete a
memo by entering a blank. The memo field can be used to remind an employee
of a special event.

F1 - Scrolls back. F1 allows the user to scroll the scheduled times back until no
earlier than 12:00 a.m.

F2 - Scrolls forward. F2 allows the user to scroll the scheduled times forward
until no later than 11:30 p.m.

F3 - Next day. F3 allows the user to view, enter, change or delete entries for the
next day. An * (asterisk) beside the numbered day indicates the employee has
an appointment on that specific date.
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Weekly Screen

The weekly screen allows the user to view appointments and events. No
changes can be made on the screen. If there is a corresponding daily memo, its
first nine characters are listed at the bottom along with the first nine characters
of the corresponding company calendar note (if it exists). The first nine
characters of each scheduled event must be viewed under the corresponding
dates. The weekly screen allows the user to enter a day to display. It also
allows the user to scroll the schedule times forward or back. The times start
with the schedule start time from the static control record.

Day-Day to display. Enter the number of the corresponding date to view or
schedule on the daily screen. The day must be displayed on the weekly screen
to be valid. The program then proceeds to the daily screen.

F1- Scrolls back. F1 allows the user to scroll the scheduled times back until no
earlier than 12:00 a.m.

F2- Scrolls forward. F2 allows the user to scroll the scheduled times forward
until no later than 11:30 p.m.

F3- Next week. F3 allows the user to view the next week.

Monthly Screen

The monthly screen allows the user to view 28 days at a time in a format
similar to a calendar with each numbered square representing a specific date.
No changes can be made on the screen. An *(asterisk) in the right-hand corner
of a square indicates the employee has an appointment on that specific date. If
there is a corresponding daily memo, the second line in the square would
display the first ten characters of that memo and if there is a corresponding
company calendar note, the third line would display the first ten characters of
the note. The monthly screen also allows the user to enter a day or a week to
display, to scroll the calendar back one week at a time or to scroll the calendar
forward one week at a time.

Day - Day to display. Enter the number of the corresponding date to view or
schedule on the daily screen. The day must first be displayed on the monthly
screen to be valid. The program then proceeds to the daily screen.

Week- Week to display. Enter the week to view on the weekly screen
(W1/W2/W3/W4). The program then proceeds to the weekly screen.

F1 - Scrolls back. F1 allows the user to scroll the calendar back one week.

F2 - Scrolls forward. F2 allows the user to scroll the calendar forward one week.

Technical Notes

All notes, memos and scheduled events are kept in the calendar notes file
(OACALD). Notes are distinguished by blanks in the employee field and
memos by blanks in time field.

FILES USED - SMCNTL,SMZART, OAEMPL
FILES UPDATED - OACALD
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L Calendar/5cheduler [DAE310]

L Calendar/Scheduler [DAE310)
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How to enter, change or delete an employee's
scheduled events and daily memos

1.  Access this program by selecting Office Automation—->Calendar—> Calendar/Scheduler

2. In the Employee input, enter the valid employee whose events and daily memos are to be
scheduled and/or viewed. Press Enter (CR) to initially default to the user’s employee code. Press
F2 to search.

3. Inthe Date input, enter the date when to start scheduling and/or viewing events and daily
memos. Press Enter (CR) to initially default to the system date.

4. Inthe View input, enter :
D-to view the daily screen. The daily screen is where you enter appointments, memos and
events, which will also appear on the weekly and monthly screens. Weekly and monthly screens
are read-only views.

W-to view the weekly screen.

M-to view the monthly screen. Press Enter (CR) to default to M initially or to whichever screen is
presently displayed.

5. (Optional) To schedule events:
Select an employee and enter the date of the event. Select the Daily screen.

Enter the time to schedule, or the time the event begins, for example 3.5, 3.50, 3:30 and 3:3. (The
daily planner is set up on half-hour increments. It will not let you enter times such as 3:15 or 4:45.)

Enter the name of the scheduled event, up to 70 characters.

When the program asks UNTIL WHAT TIME? enter the time the event is expected to end.
Asterisks appear on the planner to show the event’s duration.

To delete a scheduled event, select the beginning time and press the space bar.

6. (Optional) You have the following options while scheduling events:
M-Memo. Use the memo field to add information about the event or provide reminders. For
example, an employee may have been asked to present information at a meeting. It may be
helpful to enter a memo reminding them to bring handouts. Memos can be up to 70 characters
long. The first nine characters appear on the Weekly and Monthly screens.

To delete a memo, select the memo field and press the space bar.

F1-Back and F2-Forward. Use these two keys to scroll "up" and "down" through the daily planner.
Events can be scheduled as early as 12:00 a.m. and as late as 11:30 p.m.

F3-Next day. Use the F3 key to jump to the next day on the calendar. To return to a previous day,
press F4 until you get to the Date prompt and select a previous day.
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10.

11.

12-26

(Optional) To view Weekly calendars:

Select W after you enter the date in the second prompt. Use this screen to view appointments and
events a week at a time. The first nine characters of any events, memos or company notes appear
on screen. Asterisks show the duration of each event.

(Optional) You have the following options while viewing weekly calendars:

Day-Day to display. To return to the Daily screen, enter just the number corresponding to the
day you want to view. The day must appear on screen to be valid. Use this option to edit

scheduled events or memos.

F1-Back and F2-Forward. Use these two keys to scroll "up" and "down" through the times. Events
can be scheduled as early as 12:00 a.m. and as late as 11:30 p.m.

F3- Next week. Use this key to skip to the next week.

(Optional) To view Monthly calendars:

Select M after you enter the date in the second prompt. The monthly screen gives you 28 days at a
time in a format similar to a calendar, with each numbered square representing a specific date.
This is a read-only view. To make changes, return to the Daily screen.

If an *(asterisk) appears in the right-hand corner a square, it indicates the employee has an
appointment on that date. If a daily memo was entered, the second line in the square displays the
first 10 characters. If there is a corresponding company calendar note, the first 10 characters
appear on the third line.

(Optional) You have the following options while viewing monthly calendars:

Day-Day to display. To return to the Daily screen, enter just the number corresponding to the day
you want to view. The day must appear on screen to be valid. Use this option to edit scheduled

events or memaos.

Week- Week to display. Use this option to switch to the Weekly screen. Enter the week you want
to view — W1/W2/W3/W4.

F1-Back and F2-Forward. Use these keys to scroll backward or forward through the calendar, one
week at a time.

Press F4 to exit the program.
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Inquiries

The Office Automation inquiries allow the user to perform office and personal
phone number alpha searches, inquiries on employees and inquiries on
employees who have signed out.

1. The Phone Directory Search allows the user to display office and
personal phone number information in alphabetical order.

2. The Sign Out Board allows the user to display information on
employees who have (or have been) signed out in employee order.

3. The Employee Inquiry allows the user to display employee
information in employee order.
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Phone Directory Search (OAI610)

Function

This program allows the user to display office or personal phone number
information in alphabetical order if the user is set up for OA (a valid employee).

After choosing the office or personal phone directory, the user may enter the
beginning alphabetical sort key or page through the phone number and
information file in alphabetical order. For each record, the displayed
information includes the following: alpha sort key, name, phone number and
memo. If the user wishes to display more information concerning a displayed
phone number, its corresponding line number may be entered. When a
particular line number is chosen, the displayed detail information includes the
following: the contacts, the phone numbers, memos, address, city, state and zip.

User Inputs

The following inputs are involved in displaying the phone number information:
1. Office or Personal

Enter O-office or P-personal as the directory to search. CR defaults to O.

2. Enter Beginning Alpha To Search, Line # To Display

Enter the alphabetical sort key to begin the search (up to 10 characters). CR
initially begins with the first alpha sort key on file. Once the maximum amount
of records (12) have appeared on the screen, CR clears the screen and continues
to display phone number information in alpha sort key order. Once records are
displayed, the user can enter the line number of the record for detail
information to be displayed at the bottom of the screen.

Technical Notes

The program displays phone number information by reading the phone number
alpha sort file (OAPHOX) and then checking the phone number and
information file (OAPHON) for the information to display.

FILES USED - SMCNTL, OAPHON, OAPHOX, SMZART
FILES UPDATED - NONE
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E% Phone Directory Search [DAIG10)
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How to display office or personal phone number

information

1. Access this program by selecting Office Automation->Inquiries=>Phone Directory Search.

2. Inthe Office or Personal input, select a directory: O for office or P for personal. Press Enter (CR)
to default to the office directory.

3. Atthe Enter Beginning Alpha To Search, Line # To Display prompt, you can enter the
alphabetical sort key to begin the search (up to 10 characters). Press Enter (CR) to initially begin
with the first alpha sort key on file. Once the maximum amount of records (12) have appeared on
the screen, press Enter (CR) to clear the screen and continue to display phone number
information in alpha sort key order.

4. Once records are displayed, you can enter the line number or highlight the line and press Enter
(CR) to display detail information at the bottom of the screen.

5. When you are finished reviewing phone records, press F4 to exit the program.
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Sign Out Board (OAI620)

Function

This program allows the user to display which employees are signed out and
the associated sign-out information.

The user may enter the beginning employee or page through the employee file
in employee order. For each signed-out employee, displayed information
includes the following: employee code, name, sign-out time, sign-out date,
expected sign-in time and sign-in date if other than sign-out date. If the sign-
out date field is blank, this blank indicates the system date. If the user wishes to
view more information concerning a displayed employee, the corresponding
line number may be entered. The phone number and memo are displayed for
the signed-out employee.

User Inputs

The following input is involved in displaying the sign-out information:
1. Enter Beginning Employee To Search, Ln# To Display

Enter the employee code to begin the search (up to 8 characters). Initially, CR
begins with the first employee on file. Once the maximum amount of records
(14) has appeared on the screen, CR clears the screen and continues to display
sign-out information in employee order. Once records are displayed, the user
may enter the line number of the record for detail information to be displayed at
the bottom of the screen.

Technical Notes

The program displays sign-out information by reading the employee file
(OAEMPL) and checking this file for the information to display.

FILES USED - SMCNTL, OAEMPL
FILES UPDATED - NONE
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L Sign Out Board [DAIG20])
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How to display which employees are signed out

1.  Access this program by selecting Office Automation->Inquiries=> Sign Out Board.

2. Press Enter (CR) to display the employee list. If necessary, use the arrow keys and Page Up and
Down keys to scroll through the list.

3. For each employee listed, the Sign Out Board displays the employee’s code, name, sign-out time,
sign-out date, expected sign-in time and sign-in date (if it’s different than the sign-out date). If
the sign-out date field is blank, it indicates system date.

4. To see if a signed-out employee left a phone number or a memo, enter the line number at the
prompt. Any information entered will appear at the bottom of the screen.

5. When you are finished reviewing information, press F4 to exit the program.
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Employee Inquiry (OAI630)

Function

This program allows the user to display employee information in employee
order.

The user may enter the beginning employee or page through the employee file
in employee order. For each employee, displayed information includes the
following: employee code, name, department, location, and work phone
number. If the user wishes to view more information concerning a displayed
employee, its corresponding line number may be entered and the following
detail information is displayed: title, home phone number, address and memo.

User Inputs

The following input is involved in displaying the Employee Inquiry information:
1. Enter Beginning Employee To List, Ln # To Display

Enter the employee code to begin the search (up to 8 characters). CR initially
begins with the first employee on file. Once the maximum amount of records
(14) has appeared on the screen, CR clears the screen and continues to display
employee information in employee order. Once records are displayed, the user
may enter the line number of the record for detail information to be displayed at
the bottom of the screen.

Technical Notes

The program displays employee information by reading the employee file
(OAEMPL) and checking this file for the information to display.

FILES USED - SMCNTL, OAEMPL
FILES UPDATED - NONE
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E% Employee Inquiry (DAIG30)
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How to display employee information in employee

order

1.  Access this program by selecting Office Automation->Inquiries>Employee Inquiry.

2. Tolook up employee information, press Enter (CR). Use the arrow and Page Up and Down keys
to scroll through the list.

3. The Employee Inquiry displays every user set up in the OA system, as well as their employee
code, department, location, and work phone number. You can look up additional information, if
provided, on each user by entering the line number or highlighting the line and pressing Enter
(CR). Title, home phone number, address and memo will appear across the bottom of the screen.

4.  When you are finished reviewing employee information, press F4 to exit the program.
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Reports & Prints

Excluding the Office Automation phone directory, the OA report programs
have the option of printing in different orders (depending on the user’s desired
information on the report). The OA report programs allow the user to choose
the range of information to print. For example, the Employee Listing allows the
user to print the listing in employee or department order. If the user chooses to
print in employee order, the user would then need to choose the beginning and
ending employee. Except for the Mailing Label Print, these reports also allow
the user to determine what standard information is to be included.

1. The Telephone Directory allows the user to print either an office or a
personal directory, both in alpha order. The personal directory only
prints if the user is set up for OA (must be a valid employee).

2. The Employee Listing allows the user to print employee information in
employee or department order.

3. The Calendar/Scheduler Print allows the user to print an employee’s
schedule of appointments, memos, events, etc., for any period of time.
The user may also include unscheduled time.

4. The Mailing Label Report allows the user to print the report in mailing
label or mail code order. The user may also determine which mailing
labels are to print by selecting their corresponding mail codes.

5. The Mailing Label Print allows the user to print in mailing label, mail
code and/or zip code order. The user may also determine which
mailing labels are to print by selecting their corresponding mail codes.
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Telephone Directory (OAR710)

Function

This program allows the user to print a telephone directory using the
information stored in the phone number file.

The personal directory only prints if the user is set up for OA (must be a valid
employee) and has personal records entered through the Personal Phone
Directory F/M.

The user has the option to:

» Select the directory (office or personal).
» Select the beginning and ending alphas to print.
*  Print contact, address, and/or ID.

Report information includes the following: alpha, name, address, phone(s),
memo(s), contact(s) and ID. The total number of phone listings printed is also
included.

User Inputs

The following inputs are involved in printing the Telephone Directory:

1. Office/Personal

Enter whether to print O-office or P-personal directory. CR defaults to O.

2. Beginning Alpha

Enter the beginning alpha to print (up to 10 characters). CR defaults to FIRST.
3. Ending Alpha

Enter the ending alpha to print (up to 10 characters). CR defaults to LAST.

4. Include

Enter whether to print C-contact, A-address, and/or I-ID information. CR
defaults to NONE.

Technical Notes

Printing proceeds by reading through the phone number alphabetic sort file
(OAPHOX). The phone number and information file is then checked for the
information needed to print the directory.

FILES USED - SMCNTL, OAPHON, OAPHOX, SMZART
FILES UPDATED - NONE
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E% Telephone Directory (DAR710)
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Employee Listing (OAR720)

Function

This program allows the user to print an employee listing using the information
stored in the employee file.

The user has the option to:

» Select the print order - employee or department.
* Print standard information for each employee (home phone number,
address and/or department information).

Report information includes for each employee the following: employee code,
name, address, title, department, location, work phone number and home
phone number. The total number of employees printed is also included.

User Inputs

The following inputs are involved in printing the Employee Listing:
1. Order

Select whether to print the listing in E-employee or D-department order. CR
defaults to E.

2. Beginning Order Choice

Select the beginning order choice to print, e.g., if E was chosen above, the user
would enter the beginning employee to print. CR defaults to FIRST.

3. Ending Order Choice

Select the ending order choice to print, e.g., if E was chosen above, the user
would enter the ending employee to print. CR defaults to LAST.

4. Include

Enter whether to print H-home phone number, A-address, and/or D-
department information on the report. CR defaults to none.

Technical Notes

Printing proceeds by reading through the chosen file - the employee file or the
department/employee sort file (OADEPX). The employee file is then checked
for employees that meet all criteria entered.

FILES USED - SMCNTL, OAEMPL, OADEPX
FILES UPDATED - NONE
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E% Employee Listing (0AR720)
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Calendar/Scheduler Print (OAR740)

Function

This program allows the user to print a schedule of appointments, memos or
events set up by the user through the Calendar/Scheduler program.

The user has the option to:

»  Select employee to print schedule for.

» Select beginning and ending schedule date to print.

*  Print unscheduled time slots.

» Select beginning and ending time to print, if printing unscheduled time
slots.

» Print a new page for each day, if printing unscheduled time slots.

Report information includes the following: employee code and name.

* Scheduled time: day, date, time (and AM or PM) and scheduled event.
Daily memos are also included.

* Unscheduled time: day, date, time (and AM or PM) and a blank line
indicating that the time slot is empty.

User Inputs

The following inputs are involved in printing the Calendar/Schedule Print:
1. Employee

Enter the employee number to print the schedule. The entry must be a valid
employee. CR defaults to the employees signed in for the terminal.

2. Beginning Date

Enter the beginning date of the schedule to print (ref. 2). CR defaults to the
system date.

3. Ending Date

Enter the ending date of the schedule to print (ref. 2). CR defaults to the system
date.

4. Unscheduled Time

Enter N or Y to indicate whether to print unscheduled time, i.e., print a time slot
when no data has been entered in the Calendar/Scheduler program for it. CR
defaults to N.

The following inputs #5-8 are skipped if N is entered for unscheduled time in input #4.
5. Beginning

Enter the beginning time to print for the schedule (HH:MM ?M - example 10:00
AM). CR defaults to the start time set in the OA company static control record.
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6. Ending

Enter the ending time to print for the schedule (HH:MM ?M - example 5:00
PM). CR defaults to nine hours after the beginning time.

7. Weekends

Enter N or Y to indicate whether to print unscheduled time for weekends. CR
defaults to N.

8. New Page

Enter N or Y to indicate whether to print a new page for each date of the
schedule. CR defaults to N.

Technical Notes

Printing proceeds by reading through the calendar/scheduler file (OACALD)
for records meeting criteria entered.

FILES USED - SMCNTL, OACALD, SMZART, OAEMPL
FILES UPDATED - NONE

L Calendar/Schedule Print [DAR740]
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Mailing Label Report (OAR730)

Function

This program allows the user to print a report using the information stored in
the mailing labels file.

The user has the option to:

»  Select the beginning and ending mailing label code to print.

»  Select the mailing labels corresponding mail codes.

*  Print by mail code order.

» Select what standard information is to be included for each mailing label
(memo and/or mail codes).

Report information includes for each mailing label the following: mailing label
code, name, address, city, state, zip code, attention line, memo and mail codes.

User Inputs

The following inputs are involved in printing the Mailing Label Report:
1. Beginning Label Code

Select the beginning mailing label code to print. CR defaults to FIRST.
2. Ending Label Code

Select the ending mailing label code to print. CR defaults to LAST.
3. Mail Code

Enter up to ten 3-character mail codes side by side to print. CR defaults to ALL.
4. Mail Code Sort

Enter N or Y to indicate whether to sort the mailing labels by mail codes. CR
defaults to N.

5. Include

Enter whether to print M-memo and/or C-mail codes information. CR defaults
to NONE.

Technical Notes

Printing proceeds by reading through the mailing labels file (OALABL) which is
also checked for the information needed to print the report. If sorted by mail
code, the program creates a temporary sort file (SMSRT?) which sorts the mail
codes into correct order.

FILES USED - SMCNTL, OALABL
FILES UPDATED - SMSRT
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L Mailing Label Report [DAR730)
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Mailing Label Print (OAP710)

Function

This program allows the user to print mailing labels by label code, zip code
and/or mail code from the information stored in the mailing labels file.

The user has the option to:

»  Select the beginning and ending mailing label code.
* Print by selecting mailing label corresponding mail codes.
»  Print the mailing labels in mail code and/or zip code order.

Mailing label information includes the following: name, address, city, state, zip
code and attention line. The program prints on 11 1/2 by 15 inch paper and
prints four (4) labels across.

User Inputs

The following inputs are involved in printing the mailing labels:
1. Beginning Label Code

Select the beginning label code to print. CR defaults to FIRST.
2. Ending Label Code

Select the ending label code to print. CR defaults to LAST.
3. Mail Code

Enter up to ten 3-character mail codes side by side to print. CR defaults to ALL.
4. Mail Code Sort

Enter N or Y to indicate whether to sort the mailing labels by mail codes. CR
defaults to N.

5. Zip Code Sort

Enter N or Y to indicate whether to sort the mailing labels by zip code. CR
defaults to N.

6. Alignment

Enter Y or N to indicate whether to print an alignment. CR defaultto N. If Y is
entered, the alignment pattern prints immediately and the program returns to
this prompt.

Technical Notes

Printing proceeds by reading through the mailing labels file (OALABL) which is
checked for the information needed to print the mailing labels. If sorted by mail
code and/or zip code, the program creates a temporary sort file (SMSRT?)
which sorts the mail codes and/or the zip codes into correct order.

FILES USED - SMCNTL, OALABL
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FILES UPDATED - SMSRT?

L Mailing Label Print [DAP710])
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File Maintenances

File maintenance programs allow the user to enter, change and delete data.
These programs are used to enter the initial data required to set up the system
(refer to Installation Manual).

The user can add, change and delete the records in a file. This is called
maintaining the file. Some file maintenance programs may be used often
(example, Office Phone Directory F/M) while others are used less frequently.
There is an Infrequent File Maintenances menu for the latter programs; most of
these are used only one time during the initial setup of the system. However,
the information in the infrequent file maintenances may be updated by the
system. An example would be the Nonstatic Control F/M which keeps track of
the last office phone ID # used, the last personal phone ID # used, the last
phone message entry # and the last general message entry #.

All files, once set up by the system, are maintained and updated by the system.

12-50 Copyright 1984-2004 Aperum, Inc.



System Management —7.40 Office Automation

—\,FAETS 7.4 Distribution Software - Office Automation [DAS000)

istribution Solutions

WLV ad) FACTS 7.4 Development - Company 01 01/06/04 - 2:31 pm

ha |

Office Automation File Maintenances Tasks:

FPersonal Phone Directory FIM
Caompany Calendar Motes Fikd
Mailing Label F/M
CalendarrSchedule Mote Removal

-

Sign IndOut Meszages CalendawScheduler Infrequent File Maintenances...

] -
== ...__J
Inquiries Feports & Frints File Maintenances

@ Access Code I m

| | Y

™ Company 01, FACTS 7.4 Development M= E3
Help

81786704 Tuesday Office Automation JLW T5d 2:34 pm
81-FACTS 7.4 Developme ——— File Maintenances ——— ons9@88

1. OFfice Phone Directory F/H

2. Personal Phone Directory F/H
3. Company Calendar Hotes F/H

4_ Hailing Label F#H

5. Calendar/3chedule Hote Removal

6. Infrequent File Haintenances

Selection

ENTER SELECTION #, ACCESS CODE, ‘OFF', ARROWS, F4-PREUIOUS WMEMU

Copyright © 1984-2004 Aperum, Inc. 12-51



Office Automation System Management — 7.40

Office Phone Directory F/M (OAF910)

Function

This program allows the user to create and maintain office phone number
records in the phone number and information file. Each record contains an ID
number along with general information. These records may be displayed
through the Phone Directory Search program or may be used to print the
Telephone Directory. 1D numbers may be automatically assigned by the
program. Any OA user may access these records because they are part of the
office phone number directory.

User Inputs

The following inputs are involved in creating office phone number records:
1. ID#

Enter the ID number (1-9999). CR assigns the next available ID number from
the Nonstatic control file. The word NEXT is displayed until all inputs have
been entered and then the actual number is displayed before the record is
added to the file. F2 allows a search (ref. 5).

2. Name

Enter the associate’s name (up to 25 characters).
3. Phone Number

Enter the associate’s phone number including area code and dashes (up to 17
characters).

4. Alphal

Enter an alphabetical sort key (up to 10 characters) to be used to sort associates
alphabetically for printouts or displays. In most cases, the first 10 characters of
the associate’s name would make a good sort key. If more than one associate
has the same first 10 characters, you may wish to make the sort key unique.
You also may use the first 10 characters of this associate’s company president’s
name or that of a person you work with at this associate’s office.

5. Alpha?2

Enter a second alphabetical sort key if needed (up to 10 characters).

6. Alpha3

Enter a third alphabetical sort key if needed (up to 10 characters).
7. Alpha 4

Enter a fourth alphabetical sort key if needed (up to 10 characters).

8. Memo

Enter the memo concerning this associate if desired (up to 20 characters).
9. Address 1
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Enter the associate’s address (up to 25 characters). If only one address line is
needed, use the first.

10. Address 2

Enter the second line of the associate’s address if needed (up to 25 characters).
If only two address lines are needed, use the first two.

11. Address 3

Enter the third line of the associate’s address if needed (up to 25 characters).
12. Contact #1, Phone, Memo

Enter the name of the person you work with at this associate’s office (up to 25
characters), this person’s phone number (up to 17 characters), and a memo

concerning this person if desired (up to 25 characters). F3 ends inputs. If only
one contact is needed, use the first.

13. Contact #2, Phone, Memo
Enter the name of a second person you work with at this associate’s office (up to

25 characters), this person’s phone number (up to 17 characters), and a memo
concerning this person if desired (up to 25 characters). F3 ends inputs.

14. Contact #3, Phone, Memo

Enter the name of a third person you work with at this associate’s office (up to
25 characters), this person’s phone number (up to 17 characters) and a memo
concerning this person if desired (up to 25 characters). F3 ends inputs.

15. Contact #4, Phone, Memo

Enter the name of a fourth person you work with at this associate’s office (up to
25 characters), this person’s phone number (up to 17 characters) and a memo
concerning this person if desired (up to 25 characters).

Technical Notes

The office phone number records are distinguished from the personal phone
number records in the phone number file by the automatic insertion of blanks
into the key in place of the employee code by this program.

FILES UPDATED - SMCNTL, OAPHON, OAPHOX
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E% Personal Phone Directory F/M [DAF920]
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Personal Phone Directory F/M (OAF920)

Function

This program allows the user to create and maintain personal phone number
records in the phone number information file. Each record contains an ID
number along with general information. These records can be displayed
through the Phone Directory Search program or may be used to print the
Telephone Directory.

ID numbers may be automatically assigned by the program. The personal
phone number records may only be viewed if the user is set up for OA (must be
a valid employee).

Employees may only view their own personal phone numbers through this
program. This is because each employee has an assigned user code and only
that code may view the personal phone numbers of the employee.

User Inputs

The following inputs are involved in creating personal phone number records:
1. ID#

Enter the ID number (1-9999). CR assigns the next available ID number from
the Nonstatic control record. The word NEXT is displayed until all inputs have
been entered and then the actual number is displayed before the record is
added to the file. F2 allows a search (ref. 5).

2. Name

Enter the associate’s name (up to 25 characters).

3. Phone Number

Enter the associate’s phone number including area code and dashes (up to 17
characters).

4. Alphal

Enter an alphabetical sort key (up to 10 characters) to be used to sort associates
alphabetically for printouts or displays. In most cases, the first 10 characters of
the associate’s name would make a good sort key. If more than one associate
has the same first 10 characters, you may wish to make the sort key unique.

You also may use the first 10 characters of this associate’s company president’s
name or that of a person you work with at this associate’s office.

5. Alpha?2

Enter a second alphabetical sort key if needed (up to 10 characters).

6. Alpha3

Enter a third alphabetical sort key if needed (up to 10 characters).
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7. Alpha 4

Enter a fourth alphabetical sort key if needed (up to 10 characters).

8. Memo

Enter the memo concerning this associate if desired (up to 20 characters).
9. Address 1

Enter the associate’s address (up to 25 characters). If only one address line is
needed, use the first.

10. Address 2

Enter the second line of the associate’s address if needed (up to 25 characters).
If only two address lines are needed, use the first two.

11. Address 3

Enter the third line of the associate’s address if needed (up to 25 characters).

12. Contact #1, Phone, Memo

Enter the name of the person you work with at this associate’s office (up to 25
characters), this person’s phone number (up to 17 characters), and a memo
concerning this person if desired (up to 25 characters). F3 ends inputs. If only
one contact is needed, use the first.

13. Contact #2, Phone, Memo

Enter the name of a second person you work with at this associate’s office (up to
25 characters), this person’s phone number (up to 17 characters), and a memo
concerning this person if needed (up to 25 characters). F3 ends inputs.

14. Contact #3, Phone, Memo

Enter the name of a third person you work with at this associate’s office (up to
25 characters), this person’s phone number (up to 17 characters) and a memo
concerning this person if desired (up to 25 characters). F3 ends inputs.

15. Contact #4, Phone, Memo

Enter the name of a fourth person you work with at this associate’s office (up to
25 characters), this person’s phone number (up to 17 characters) and a memo
concerning this person if desired (up to 25 characters).

Technical Notes

FILES USED - SMZART
FILES UPDATED - SMCNTL, OAPHON, OAPHOX

12-56 Copyright 1984-2004 Aperum, Inc.



System Management —7.40 Office Automation

E% Personal Phone Directory F/M (0AF920)
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Company Calendar Notes F/M (OAF930)

Function

This program allows the user to create and maintain company calendar notes in
the calendar file. These notes are displayed on a specific date through the
Calendar/Schedule program.

User Inputs

The following inputs are involved in creating company calendar notes:

1. Date

Enter the date the note is to appear on the calendar (ref. 2). CR defaults to the
system date.

2. Note
Enter the note for the calendar (up to 70 characters).
Technical Notes

The company calendar notes are distinguished from other records in the
calendar file by the automatic insertion of blanks into the employee code and
time fields which are both a part of the key to this file (OACALD).

FILES USED - SMCNTL
FILES UPDATED - OACALD

m Company Calendar Motes F/M [0OAF930]

ﬂEﬂ'p

81-Specialty Distributors, I COHMPAHY CALEHDAR HNOTES F/H 0AF934

*=_ DATE |[@1/29/83 <
2. HOTE

Next Record I EndI
ENTER DATE NOTE IS TO APPEAR ON CALENDAR/SCHEDULE, F3-NEXT RECORD, F4-END OK]|
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Mailing Label F/M (OAF940)

Function

This program allows the user to create and maintain records in the mailing label
file. Each record contains a mailing label code and general information relevant
to the mailing label.

Before entering mailing labels, the user must set up at least one mail code in the
Mail Code F/M program.

After entering mailing label records, these records may be printed by the
Mailing Label Report and the Mailing Label Print programs.
User Inputs

The following inputs are involved in creating mailing label records:
1. Label Code

Enter the label code (up to 10 characters). In most cases, the first 10 characters
of the associate’s name would be a good label code.

2. Name

Enter the associate’s name (up to 25 characters).
3. Address 1

Enter the associate’s address (up to 25 characters). If only one address line is
needed, use the first.

4. Address 2

Enter the second line of the associate’s address if needed (up to 25 characters).
5. City

Enter the city where the associate is located (up to 15 characters).

6. State

Enter the state where the associate is located (up to 2 characters).
7. Zip Code

Enter the associate’s zip code (up to 10 characters).

8. Attention

Enter the attention line (up to 25 characters). The system automatically prints
ATTN: on the attention line.

9-13. Mail Codes

Enter up to five valid 3-character valid mail codes. F2 allows a search (ref. 5).
CR defaults to the first mail code on file otherwise the mail code of the record
just entered. F3 ends mail code inputs.
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14-16. Memos
Enter up to 3 memos (up to 25 characters each). F3 ends inputs.

Technical Notes

FILES USED - SMCNTL
FILES UPDATED - OALABL

ES Mailing Label F/M (0DAF940)
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Calendar/Schedule Note Removal (OAU910)

Function

This program allows the user to remove employee’s daily memos and
scheduled events through a specified cutoff date.

User Inputs

The following inputs are involved in removing calendar/schedule notes:

1. Employee

Enter the valid employee code to remove calendar/schedule notes (up to 8
characters). CR defaults to ALL.

2. Cutoff Date

Enter the cutoff date to remove calendar/schedule notes through (ref. 2). Any
records with a date prior to or equal to the date entered are removed. Press F1
for No Cutoff date. CR defaults to the ending date of the last GL period closed.

Technical Notes

FILES USED - SMCNTL, OAEMPL
FILES UPDATED - OACALD

L# Calendar/S chedule Note Removal [DALI910) [_[O]x]
Help

81-Demo Company CALENDAR/SCHEDULE HOTE REHMOUAL Uﬂu91j
THIS PROGRAM REMOUEE CALEHDAR/SCHEDULE HOTES BASED OH THE CRITERIA EWTERED BELO

EMPLOYEE AlLL

CUTOFF DATE |..........

ENTER EMPLOYEE FOR WHOM TO REMOUE CALENDAR/SCHEDULE HOTES (CR=ALL}), F4-EHND
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Infrequent File Maintenances

File maintenance programs allow the user to enter, change and delete data.
These programs are used to enter the initial data required to set up the system
(refer to the Installation Manual).

The user can add, change and delete the records in a file. This is called
maintaining the file. Some file maintenance programs may be used often where
others are used less frequently. There is an Infrequent File Maintenances menu
for the latter programs; most of these are used only one time during the initial
set up of the system. However, the information in the infrequent file
maintenances may be updated by the system. An example would be the
Nonstatic Control F/M which keeps track of the sales orders period and all the
register trace numbers.

All files, once set up, are maintained and updated by the system. Most file
maintenances in the sales orders system do not need to be maintained by the
user and it is unlikely that they will be used.
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Employee F/M (OAF950)

Function

This program allows the user to create and maintain records in the employee
file. Each record contains an employee code and general information relevant
to the employee. This file is the backbone of the office automation system and is
referenced by virtually all programs in the OA system.

Before entering employees, the user must know the employee’s user code. At
least one user code must be set up. User codes are entered in the User Code
F/M program.

An employee record cannot be deleted in this program if the employee code is
also defined in the Technical Support Employee File.

User Inputs

The following inputs are involved in creating employee file records:
1. Employee

Enter the employee code (up to 8 characters). In most cases, the employee’s first
name, nickname or the first eight characters of the employee’s last name would
be a good employee code. F2 allows a search (ref. 2).

2. Name

Enter the employee’s name (up to 25 characters).
3. Title

Enter the employee’s title (up to 25 characters).

4. Department

Enter the department in which the employee is located (up to 4 characters).

5. Location

Enter where the employee is located (up to 10 characters).

6. Work Phone

Enter the employee’s work phone number including area code, dashes and
extension, if needed (up to 17 characters).

7. Home Phone

Enter the employee’s home phone number including area code and dashes and
extension, if needed (up to 17 characters).

8. Address 1

Enter the employee’s address (up to 25 characters). If only one address line is
needed, use the first.
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9. Address 2

Enter the second line of the employee’s address if needed (up to 25 characters).
If only two address lines are needed, use the first two.

10. Address 3

Enter the third line of the employee’s address if needed (up to 25 characters).
11. Memo

Enter the memo concerning the employee (up to 25 characters).

12. User Code

Enter the employee’s user code (up to 3 characters). The entry must be a valid
user code.

Technical Notes

FILES USED - SMCNTL, TSEMPL

FILES UPDATED - OAEMPL, SMZART, OADEPX, OAPHMS, OAGNMT,
OAGNMX, OACALD, OAPHON

ES Employee F/M [DAF950)
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Group Code F/M (OAF960)

Function

This program allows the user to create and maintain the group codes file.
Group codes can be used to group employees by departments or by employee
classifications (such as: sales & marketing or clerks). The codes allow the user
flexibility in the general message entry program. This program can send
messages to employees based on group codes or to an individual employee.
Using group codes would relieve the burden of sending messages to every
single employee within a department or classification.

The user establishes his/her own set of valid group codes and their
descriptions. The user should assign codes that are easy to remember; for
example, sales department (SALE).

Each valid group code may represent up to 40 employees.
User Inputs

The following inputs are involved in creating a group code record:
1. Group Code

Enter the group code (up to 4 characters). F2 allows a search (ref. 2).

2. Description

Enter the group code description (up to 25 characters).

3-42. Employee
Enter up to 40 employee codes (ref. 3).

Technical Notes

FILES USED - OAEMPL
FILES UPDATED - SMCNTL
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E% Group Code F/M [(OAFI60)
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Mail Code F/M (OAF970)

Function

This program allows the user to create and maintain the mail codes file. Mail
codes can be used to group classifications of customers for mailing purposes
(such as: industrial or office supply customers). The codes allow the user
flexibility in the Mailing Label F/M, Mailing Label Report and Print programs.
The Mailing Label Report and Print programs list and print mail labels based on
the mail code. Using these codes would relieve the burden of unwanted labels
being printed. The user establishes his/her own set of valid mail codes and
their descriptions. The user should assign codes that are easy to remember; for
example, industrial (IND).

User Inputs
The following inputs are involved in creating a mail code record:

1. Mail Code

Enter the mail code (up to 3 characters). Any character combination is
acceptable except for all blanks or the word ALL.

2. Description

Enter the mail code description (up to 25 characters).

Technical Notes

FILES UPDATED - SMCNTL
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B Mail Code F/M [DAF970)
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Static Control F/M (OAF980)

Function

This program allows the user to create and maintain the OA static control
record. The user establishes information concerning the Sign-In/Out program
and the Calendar/Scheduler program.

User Inputs

The following inputs are involved in creating the company static control record:
1. Sign-ln Message

Enter the message to display when a user signs in (up to 25 characters).
2. Schedule Start Time

Enter the schedule start time (HH:MM ?M). This time must be on the hour and
also on or before 4:00 p.m.

Technical Notes
FILES UPDATED - SMCNTL

E% Static Control F/M [DAF980)
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Nonstatic Control F/M (OAF990)

Function

This program allows the user to create and maintain the company OA Nonstatic
control record. The OA Nonstatic control record is critical to the proper
functioning of the OA system. The record contains information which the OA
system references in performing various functions.

CAUTION! It is strongly advised that a password be used for this program.
Changes should be made only with extreme caution and under the supervision
of your affiliate.

User Inputs

The following inputs are involved in creating the OA Nonstatic control record:
*1-4. 1D and Entry Numbers

These numbers keep track of the last phone ID and message entry numbers
used. The last number used is incremented by one. Upon installation, these
fields should be set to 0. These fields will automatically be updated through
normal processing. CR initially defaults to 0.

* indicates that changing the field after initial installation may have serious

repercussions. Please refer to your affiliate before any changes are made.

Technical Notes

FILES UPDATED - SMCNTL
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E% Monstatic Control F/M [0AF990])
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Rebuild OA Sort Files (OAU990)

Function

This program allows the user to rebuild sort files that may not be up to date
with the rest of the system.

Sort files are used throughout the FACTS system to enable the user to report
and retrieve information in an order other than the order in which the main file
is stored. For example, the records of the employee file are stored in employee
code order. To access this file in department order requires a sort file that is
stored in department by employee code order. The corresponding record in the
main file may then be accessed for the needed information.

User Inputs

The following inputs are involved in rebuilding OA sort files:
1. OAPHOX

Enter Y or N to indicate whether to rebuild OAPHOX. This file is the OA 1D
number by alphabetic sort file to the phone number and information file
(OAPHON). This sort file is used in the Phone Directory Search where phone
numbers can be searched for in alpha order. This sort file is also used in the
Telephone Directory where phone numbers and related information can be
printed in alpha order. CR defaults to N.

2. OADEPX
Enter Y or N to indicate whether to rebuild OADEPX. This file is the OA
employee by department sort file to the employee file (OAEMPL). This sort file

is used in the Employee Listing where employee information can be printed by
department. CR defaults to N.

3. OAGNMX

Enter Y or N to indicate whether to rebuild OAGNMX. This file is the OA
employee by general message number sort file to the general messages header
file and the direct file for employee viewing (OAGNMT). This sort file is used
in the General Message Entry program where employees receiving a certain
general message may be displayed. This sort file is also used in the Message
Viewing/Disposition program where a general message may be deleted by an
employee who is the only receiver of that message. CR defaults to N.

Files will be rebuilt for all companies.

Technical Notes

FILES USED - OAPHON, OAEMPL, OAGNMT, SMCNTL, SMFILE
FILES UPDATED - OAPHOX, OADEPX, OAGNMX
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ES Rebuild DA Sort Files [0AU990)
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FACTS

Data Warehouse (SMS750)

The programs on the Data Warehouse menu allow Aperum.

e-info users to export data from certain FACTS File Maintenance programs and
the Daily Sales Register in XML format to the Data Warehouse Server so they
can create Web-accessible sales history reports.

The following programs appear on this menu:
Data Warehouse Update
Data Warehouse Static Control F/M
Data Warehouse NonStatic Control F/M

Data Warehouse Load is accessible by typing the DWL access code in the menu
system.
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FACTS Data Warehousing Basics

FACTS is just one of four components that comprise Data Warehouse:

FACTS. This is also referred to as the source system because it supplies data in
XML format from various file maintenance programs as well as the Daily Sales
Register.

Staging area. This is where FACTS uploads the XML documents it generates. In
most cases, the staging area resides on the Data Warehouse server.

Data Warehouse. This is a SQL Server 7.0 database running on a Windows NT
system. The Data Warehouse is divided into Data Marts, which focus on
information related to a specific business process, such as sales.

Database Query Tools. Seagate Analysis and Seagate Info 7 are the approved
reporting and querying tools for the Aperum Data Warehouse system. These
programs enable administrators to create any number of reports from the
information in the data warehouse.

Seagate Info and Analysis are free and can be downloaded at
www.seagatesoftware.com.

For instructions on setting up FACTS for data warehousing and e-info, refer to
Configuring FACTS for Data Warehouse on the FACTS Affiliate Nexus.

About Data Marts

The initial release of the Aperum Data Warehouse ships with one data mart —
Sales History. More data marts are planned for future releases. EACToid

The Sales History
Data Mart provides

Data Warehouse much of the

information found in
the FACTS Sales
Analysis module.

Sales
Histary
Data
Mart
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The Sales History Data Mart contains all the invoice line-item data exported
from the Daily Sales Register and the following F/Ms:

Branch, Company, Customer, Customer Class, Customer Price Class,
Department, Item, Item Class, Item Price Class, Region, Route,
Salesperson/Territory, Ship-To, Ship Via, Vendor, Vendor Class and
Warehouse.

2 You do not have to configure these F/Ms to export. Each of the programs is
pre-configured to export XML documents to the staging area.

At this release, you cannot set additional F/Ms to export to the Sales History
Data Mart.

Data Warehouse Process Flow (Daily Processing)

The following process flow provides an overview of how the Data Warehouse
module fits into daily operations.

1. FACTS users create, update, and delete records in the File Maintenance
programs configured to export to the Data Warehouse. Each of these
activities generates an XML document in the staging area.

A FACTS user Runs the Daily Sales Register. The DSR in turn creates an
XML document for each invoice it updates.

2. After the final DSR update, an Administrator or technical user runs the
Data Warehouse Update program, creating Ready to Import files in the
staging area. This file is a list of XML documents that are ready to be
loaded into the Data Warehouse database.

3. Anadministrator runs the Data Warehouse Server Update program on the
Data Warehouse Server. This program updates each XML document in the
staging area that appears in the Ready to Import files. The server update
can be set to run automatically (see the Data Warehouse Installation and
Administration document on the e-info Install CD and Microsoft's NT
documentation for details).

4. The Data Warehouse Server Update program prepares the data for the
Data Warehouse database by using pre-defined tables in the Data
Warehouse Setup program. It also updates the Data Warehouse database.
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Data Warehouse Update (SMU720)

We recommend that you run this program after you run the final Daily Sales
Register update for the day.

How frequently you run the update depends on how current you want the data
to be in the Data Warehouse.

This program does not update the Data Warehouse database. Instead, it creates
lists of XML documents that are ready to be loaded by the Data Warehouse
database. This list is called the Ready to Import file

It sends these files to the staging area, where the Data Warehouse Server

Update program reads them to see which of the XML documents in the staging
area it can update.

2 The Data Warehouse Update is cumulative. This means if a Ready to

Update file already exists in the staging area, this Update appends the file
rather than replaces it.

L# Data Warehouse Update (SMU710) [_ [O] x|
Help
81-Demo Company Data Warehouse Update SHU716

Data Hart Sales History

Sales History Data HMart last updated 61/01/20808 12:80 AM.

End of inputs. Enter 'YES' to continue, F4-Backup |-..

To run the Data Warehouse Update:

1. Access the program by choosing System Management >Data
Warehouse 2Data Warehouse Update.

2. Select the Sales History Data Mart (the default) and type Yes.

If you defined Export Procedure in the Data Warehouse Static Control F/M, the
Update runs that procedure after it creates the Ready to Import files.
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Data Warehouse Static Control F/M (SMF991)

Access this program by choosing System Management 2>Data Warehouse »Data
Warehouse Static Control F/M in the menu system.

L DW Static Control F/M [SMF91) M= E
Help FACToid.
Access any of the
: Data Warehouse
Export Directary  [M:U<MLY programs by typing
Export Frocedure | the access code
[ Use sales Histary Mart DW.
gave | ¥ Delete || ew | @ Eadt |
| Enter the data warehouse export directary

! m DW Static Control F/M [SMF391)
. Help

,@1-Specialty Distributors, InDW Static Control F/H SHF991||

' 1. Export Directory E:\DEUELOPHMENTA7B\BHESS\XHLY
2. Export Procedure
3. Use Sales History Hart H

Line to Change {(F2-Cont}, D-Delete, F10-Menu, FA4-End .

&

Use the DW Static Control F/M to control the XML export process.

1. Enter the Export Directory. This is the directory where you want FACTS to
create the XML documents it exports.

We recommend that you export to the Staging directory on the Data
Warehouse Server. Make sure that the Staging Directory is mapped so the
FACTS Application Server can see it.

If you use this configuration, the export directory and the staging area are
the same thing.

Alternative configuration: You can create an export directory the FACTS
Application server. In this case, you are actually creating two staging areas
— one on the FACTS side and one on the Data Warehouse server side. You
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must be able to move the exported XML documents from the Export
Directory to the staging area directory.

2. Enter the path to the Export Procedure. An export procedure is only
necessary when the Export Directory is not the Staging directory on the
Data Warehouse Server.

It enables you to tell FACTS how to get the XML files to the Data
Warehouse server. For instance, you may want to FTP the files to the
Staging directory.

The procedure can be a batch file, script or executable — depending on
which operating system you are using — that you have written.

When you run the Data Warehouse Update, it runs the procedure you
define in this field.

3. Make sure the Use Sales History Mart is selected (or set to Y).

2 Do not change this flag once the Data Warehouse system goes live.
Data corruption occurs when they flag changes during processing.
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Data Warehouse Nonstatic Control F/M (SMF990)

Access this program by choosing System Management 2>Data Warehouse »Data
Warehouse Nonstatic Control F/M in the menu system.

L# DW Nonstatic Control F/M (SMF990) HiE B2
Help

Last Update to Sales History |DBIDSIQDDD 11:42 AM|

Mext File Nurnber hDDEDB
Terminal Running Update I gl Not Running

gave | ¥ Delete || Mew | § Euit

| Erter date and time of last update to Sales History

! E DWW Monstatic Control F/M [SMF390)
. Help

,81-Specialty Distributors, InDW Nonstatic Control F/M SHF99

! 1. Last Update to Sales History 06/28/2000 82:22 PH
2. MHext File Humber BOB1894

3. Terminal Running Update Mot Running

Line to Change {(F2-Cont), D-Delete, F18-Henu, Fh—Endl.

A

You do not have to enter information in the DW Nonstatic Control F/M during
initial setup.
This program maintains information during live processing that enables FACTS

to coordinate exports and updates to the Data Warehouse staging area. It also
creates the six-digit numbers that become XML file names.

1. Last update to Sales History. Displays the date on which the Data
Warehouse Update was last run.

2. Next File Number. Displays the number that will be assigned to the next
XML document.

3. Terminal Running Update. When the Data Warehouse Update is running,
this field displays the terminal ID, indicating from which terminal or PC
the update is running.
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<2 If the update locks for any reason, choose the Cancel button or press F1
to clear the field. You may need to run the update again to make sure
FACTS data updated correctly and is not corrupt.
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Data Warehouse Load (SMU720)

Use this program to perform the initial load of XML documents required to set
up the Sales History Data Mart — and the data sources that build the data mart
— during live processing.

2 All users should be logged out of FACTS before you run this program.

L:# Company 01 - FACTS 7.0 Maintenance

To perform the initial warehouse load:

1. Enter the access code DWL in the menu system (this program does not
appear on a menu).

2. Choose the data mart you want to load (Sales History is the only option at
initial release).
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1.

DATE Dates will be displayed according to the format set in the Company Control Record. For
viewing purposes, all dates will be displayed with a two digit year. For editing purposes, all dates
will allow the entry and display of a four digit year. An entry date can be viewed in its entirety by
using the left and right arrow keys or by using the HOME and END keys to scroll through the date
field. The system will allow the full date or a partial date to be entered.

Special dates that were previously displayed and stored as 01/01/00 and 12/31/99 will no longer be
handled in the same manner. Tag names such as NONE, ASAP, FIRST, LAST, etc. will now be used
in place of “generic” dates. These tag names will also be accepted as the valid input dates in some
data entry prompts.

The Rule of 50: FACTS programs use a “rule of 50” logic to expedite date processing. If the two digit
year is greater than or equal to 50, the system will assume the date to be in the 1900s; if the two digit
year is less than 50, the system will assume the date to be in the 2000s.

During data entry, if the system is unable to interpret the date entered, the date mask will be
displayed in the prompt. If the system is able to interpret the date entered, the date will be displayed
in the prompt. Dates prior to 01/01/1800 or after 12/31/2199 are not allowed during date entry.

FACTS programs contain 8-character and 10-character date fields. The date editing/entry display
varies slightly depending on whether it is an 8-character or 10-character field. When editing a date,
using the right arrow or the END key, will advance the cursor to the end of the date field and using
the left arrow or the HOME key, will advance the cursor to the beginning of the date field.

8-Character Date 10-Character
Field
Date Field
When entering a date in the 1900s (as defined by the
50-rule), the date will be displayed as follows:
ORDERED ORDERED
01/02/96< 01/02/96 <
Use the right arrow key or the END key to display
the full 4-digit year:
ORDERED ORDERED
/02/1996< 01/02/1996<
A plus sign at the end of the date field indicates that
the year is not in the default century.
ORDERED ORDERED
01/02/96+ 01/02/2096<
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2. END OF INPUTS In all report and update programs, this is the last input prior to processing. This
gives the user a chance to check all the information entered for accuracy. If something needs to be
changed, enter F4 to back up and change. Once everything is correct, press CR or type YES and the
program will continue.

3. SEARCH The search feature allows the operator to search for various fields (example: bank code)
when little or no information is known about them. The search displays at the bottom of the screen a
number of the fields at a time. The operator may enter a search key (usually F2), continue to view the
search fields, select the line number of one of the fields displayed, or return to the program input.

Job Stream

1. END OF INPUTS In all report and update programs, this is the last input prior to processing. This
gives the user a chance to check all information for accuracy. If something needs to be changed, enter
F4 to back up and change. Once everything is correct, press CR or type YES and the program will
continue.

2. SEARCH The search feature allows the operator to search for various fields (example: bank code)
when little or no information is known about them. The search displays at the bottom of the screen a
number of the fields at a time. The operator may enter a search key, continue to view the search
fields, select the line number of one of the fields displayed, or return to the program input.

Office Automation

1. ALIGNMENT An alignment check is often desired to ensure that forms paper is correctly aligned in
the printer. Enter Y or N to indicate whether to print an alignment. CR defaults to N and no
alignment check is printed. If Y is entered, the alignment check prints immediately and the program
returns to this input.

2. DATE The format mask of the date is set in the company control record and is either American
(MMDDYY) or European (DDMMYY). When entering dates, valid dates within the mask must be
entered (i.e., always enter two digits for the month (or day), day (or month) and year). With an
incorrect entry, the input mask is displayed in the input.

Users may enter one or two digits at the date input and the system assumes the digits entered are the
day of the current month and year and the full 6-digit date is displayed. Users may also enter three or
four digits at the date input and the system assumes the digits entered are the day and the month
(entered in correct order based on date mask) of the current year and the full 6-digit date is displayed.
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3. EMPLOYEE When entering the employee, the employee code must be entered. This code is padded
to the correct length automatically. The code entered must be that of a valid employee in the
employee file. F2 allows the employee search. This displays at the bottom of the screen a number of
employees at a time, the employee code and the name. This feature is useful in finding a specific
employee. The user may enter the beginning employee to search, continue, select the employee
displayed, or return to the entry program.

4. END OF INPUTS In all report and update programs, this is the last input prior to processing. This
gives the user a chance to check all the information for accuracy. If something needs to be changed,
enter F4 to back up and change. Once everything is correct, press CR or enter YES and the program
will continue.

5. SEARCH The search feature allows the user to search for various fields (example:
salesperson/territory) when little or no information is known about them. The search displays at the
bottom of the screen a number of the fields at a time. The user may enter a search key, continue, select
the line number of one of the fields displayed, or return to the program input.
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APPENDIX B: Glossary of Terms

DEPARTMENT A department is a memo field used to describe in what department (sales, marketing,
administrative) the employee works within the company. Departments may print on the Employee
Listing. Departments in office automation are not tied in with GL departments.

EMPLOYEE Employees are set up through the OA Employee F/M program. Each employee is
assigned a valid user code. When a user signs on, the system recognizes the employee assigned to the
user code.

FUNTION BUTTONS In the FACTS graphical user interface, the buttons located at the bottom of the
screen and sometimes next to fields. Pressing one of these buttons performs an action in either the
program or the field.

GENERAL MESSAGE A general message is a message sent to an employee other than a phone
message. A general message may be sent to an individual employee or a group of employees through
the General Message Entry program.

GROUP CODE Group codes are set up through the Group Code F/M. Group codes are used to
categorize employees so that OA mail messages can be easily sent to a group. For example, all
employees in the sales department could be in a sales group. A message may then be sent to one
group rather than to each of the employees when a sales meeting is announced.

GUI An acronym that stands for graphical user interface.

LABEL CODE Label codes are set up through the Mailing Label F/M. A label code is assigned to
each company name and address entered in the system that prints a label for mailing purposes.

MAIL CODE Mail codes are set up through the Mail Code F/M. Mail codes are used to identify
types of mailings (general company mailings, customers, prospects, etc.).
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OFFICE PHONE DIRECTORY The office directory, set up through the Office Phone Directory F/M,
contains company names, addresses, phone numbers and contacts. The office directory is available for
display for all employees through the Phone Directory Search, and may be printed through the
Telephone Directory Print.

PERSONAL PHONE DIRECTORY The personal directory, set up through the Personal Phone
Directory F/M, contains names, address, phone numbers and contacts for each employee in office
automation to access. The personal directory is available for display through the Phone Directory
Search and may be printed through the Telephone Directory Print.

PHONE MESSAGE A phone message may be sent to an individual employee through the Phone
Message Entry program.

TITLE BAR An element of a window in all GUI software. Title bars most often display the software
logo, the name of the software and the program or file that you are working in.

USER CODE User codes are set up through the SM User Code F/M. User codes are set up for users
to sign on the system. Without a user code, the FACTS menus are not accessible.

B-2
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APPENDIX C:

PROGRAM

SMR510
SMR710
SMR720
SMR730
SMR740
SMR750
SMR760
SMR770
SMR780
SMR810
SME710

PROGRAM

JSR110
JSR120

PROGRAM

OART710
OART720
OAR730
OART740
OAPT710

Sample Reports

SYSTEM MANAGEMENT

NAME

CHECK LIST

COMPANY LISTING
PROGRAM NAME LISTING
PROGRAM USAGE REPORT
MENU SELECTIONS PRINT
USER TRACKING REPORT
PROGRAM CHANGE REPORT
F/M AUDIT REPORT

HELP TEXT PRINT
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System Management—7.40 Sample Reports

DATE: 03/22/02 DEMO COMPANY SMR510 PAGE: 1
USER. SSI Tz4 CHECK LI ST TIME: 6:01 PM

BANK 01 FI RST NATI ONAL BANK OF ATLANTA
ALL CHECKS FI RST TO LAST
PERI CD FI RST TO LAST

CLEAR
CHECK PAYEE NAME DATE  MOD REG# TYPE AMOUNT PERI OD
001346* E102 MARY ELI ZABETH JONES 09/ 05/ 02 PR 0404 REG 199.02 09/02
001347 E106 RONALD PATTEN 09/05/02 PR 0404 REG 190.19 09/02
001348 E107 SALLEY FURNESS 09/05/02 PR 0404 REG 140.78 09/02
001349 E109 NEIL J. ERI CKSON 09/ 05/ 02 PR 0404 REG 201.29 09/02
001350 E110 TAMW A. FOSTER 09/05/02 PR 0404 REG 264.09 09/02
001351 VA DED VO DED 09/05/02 PR 0406 *VO D* .00 09/02
001352 E100 GREGORY BI LLI NGS 09/ 05/ 02 PR 0406 REG 1004.29 09/02
001353 E101 DALE A MNARTIN 09/ 05/ 02 PR 0406 REG 578.31 09/02
001354 E103 ROBERT JOHNSON 09/05/02 PR 0406 REG 882.09 09/02
001355 E104 STEPHEN S. | NVI NCENT 09/ 05/ 02 PR 0406 REG 1037.75 09/02
001356 VA DED VA DED 09/ 14/ 02 PR 0407 *VvVA D* .00 09/02
001357 E102 MARY ELI ZABETH JONES 09/ 14/ 02 PR 0407 REG 209.42 09/02
001358 E106 RONALD PATTEN 09/ 14/ 02 PR 0407 REG 173.55 09/02
001359 E107 SALLEY FURNESS 09/ 14/ 02 PR 0407 REG 105.40 09/02
001360 E109 NEIL J. ERI CKSON 09/ 14/ 02 PR 0407 REG 201.29 09/02
001361 E110 TAMW A, FOSTER 09/ 14/ 02 PR 0407 REG 257.16 09/02
001362 E102 MARY ELI ZABETH JONES 09/21/02 PR 0409 REG 209.42 09/02
001363 E106 RONALD PATTEN 09/21/02 PR 0409 REG 173.55 09/02
001364 E107 SALLEY FURNESS 09/21/02 PR 0409 REG 105.40 09/02
001365 E109 NEIL J. ERI CKSON 09/21/02 PR 0409 REG 201.29 09/02
001366 E110 TAMW A. FOSTER 09/21/02 PR 0409 REG 257.16 09/02
001367 VA DED VO DED 09/21/02 PR 0411 *VA D* .00 09/02
001368 E100 GREGORY BI LLI NGS 09/21/02 PR 0411 REG 984.29 09/02
001369 E101 DALE A MNARTIN 09/21/02 PR 0411 REG 578.31 09/02
001370 E103 ROBERT JOHNSON 09/21/02 PR 0411 REG 831.62 09/02
001371 E104 STEPHEN S. | NVI NCENT 09/21/02 PR 0411 REG 1037.75 09/02
003046* V102 S.E. | NDUSTRIAL PROD. & EQUIP. 09/07/02 AP 0346 *VvO D* .00 09/02
003047 V103 OFFI CE PRODUCTS | NTERNATI ONAL 09/ 07/02 AP 0346 REG 628.83 09/02
003048 V105 WAREHOUSE EQUI PMENT UNLIM TED 09/07/02 AP 0346 REG 5567.57 09/02
003049 V106 SAN TATI ON SERVI CES, | NC. 09/07/02 AP 0346 REG 1841.94 09/02
003050 V113 ATLANTA CRANE & HO STS 09/07/02 AP 0346 REG 693.21 09/02
003051 V114 LINDA'S FLOWER SHOP 09/07/02 AP 0346 REG 21.47 09/02
MOD=MODULE, *=PRECEDI NG CHECK M SSI NG
CHECKS: 32 END OF REPORT
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DATE: 03/22/02
USER. SSI Tz4

COWPANY FI RST TO LAST

CO NAME

DEMO COMPANY
COWPANY LI STI NG

ADDRESS

SMR710 PAGE: 1
TIME: 6:02 PM

PHONE

01 DEMO COVPANY

02 SECOND DEMO COVPANY

COWPANI ES: 2

Copyright © 1984-2004 Aperum, Inc.

69 SOUTH PEACHTREE STREET
ATLANTA, GA 30030

3401 ROSVEELL RD.
SU TE 100
ATLANTA, GA 30301

(404) 962-9900

(404) 458-6610

END OF REPORT

Sample Reports

c-4



System Management—7.40

DATE: 03/22/02
USER. SSI Tz4

PROGRAM SMES810 TO SMJU990

DEMO COVPANY
PROGRAM NAME LI STI NG

Sample Reports

SMR720 PAGE: 1
TIME: 6:07 PM

----------------------- TERM NAL # ------mmmmmmmm e
SECURI TY ACCESS 1111111111
PROGRAM NAVE CODE CODE 01 2 3 456 78 9 01 2 3 456 7 8 9
SME810 End-oC- Period Checklist Entry 0 VALIDFORUSE Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y'Y
PRRNTER OCPTION N N N N N N N N N N N N N N N N N N N N

NCORVAL PRI NTER
SME910 Hel p Text Mui ntenance 0 HELP VALIDFORUSE Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y YY
PRRNTER OPTION N N N N N N N N N N N N N N N N N N N N

NORVAL PRI NTER
SMENPF Switch to EDI 0 DALE VALIDFORUSE Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y YY
PRRNTER OCPTION N N N N N N N N N N N N N N N N N N N N

NORVAL PRI NTER
SMF210 Message Entry 0 VALIDFORUSE Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y YY
PRRNTER OCPTION N N N N N N N N N N N N N N N N N N N N
NCRVAL PRRNTER 0 0 0 0 0 0 0 0 0 0 0 0 0 O 0 0 0 0 0 O
SMF310 Program F/ M 0 PROG VALIDFORUSE Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y YY
PRRNTER OCPTION N N N N N N N N N N N N N N N N N N N N

NORVAL PRI NTER
SMF320 Menu F/'M 0 MENU VALIDFORUSE Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y YY
PRRNTER OCPTION N N N N N N N N N N N N N N N N N N N N
NORVAL PRRNTER 0 0 0 0 0 0 0 0 0 0 0 0 0 O 0 0O 0 0 0 O
SMF410 User Code F/M 0 VALIDFORUSE Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y YY
PRRNTER OPTION N N N N N N N N N N N N N N N N N N N N

NORVAL PRI NTER
SMF420 Password & Security Code F/'M 0 VALIDFORUSE Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y YY
PRRNTER OPTION N N N N N N N N N N N N N N N N N N N N

NORVAL PRI NTER
SMF430 Escape Code Entry 0 ES VALIDFORUSE Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y YY
PRRNTER OCPTION N N N N N N N N N N N N N N N N N N N N

PROGRAMS: 9

Copyright © 1984-2004 Aperum, Inc.

NORVAL PRI NTER

END OF REPORT
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DATE: 03/22/02
USER. SSI Tz4

PROGRAM SME510 TO SMJU990

DEMO COMPANY
PROGRAM USACGE REPCRT

SMR730 PAGE: 1
TIME: 6:11 PM

ALL PROGRAMS
PROGRAM NAME e MENUS ---------------
SME510 Reconcil e Checks SMS500
SME520 Adj ust Bank Bal ance Sl S128 SMS500
SME810 End-oC-Period Checklist Entry SMS800
SME910 Hel p Text Mai ntenance SMS900
SMENPF Switch to EDI
SMF210 Message Entry SM5200
SMF310 Program F/ M SMS300
SMF320 Menu F/' M SMS300
SMF410 User Code F/' M SI S050 SMs400
SMF420 Password & Security Code F/M  SMs400
SMF430 Escape Code Entry
SMF440 OVERRI DE CODE/ MULT WHSE | N SO
SMF510 Bank F/' M SI S126  SMS500
SMF520 Check Reconciliation F/'M SMS500
SMF666 Search Paraneters File
SMF880 Terminal Type F/'M SMB900 TFS910
SMF910 Conpany F/ M SMS900
SMF920 Conpany Control F/ M SMS900
SMF930 Terminal F/'M SI S050 SMS900
SMF940 Printer F/M SI S050 SMS900
SMF950 System Control F/' M SMS900
SMF955 Branch F/ M Sl S125 SMS900
SMF960 Program Change F/' M SMS900
SMF970 File F/IM SMS900
SMF980 Mbdul e Code F/' M SMS900
SMF990 Program Help F/' M SMS900
SMHASH Hash Error Abort Codes
SM 410 Subnmitted Filelist Queue
SM 510 Bank | nquiry SMS500
SM 610 Summary Managemnent | nquiry SM5600
SM 620 Anortization Schedul e SMS600
SM 630 Ternminal Inquiry SMS600
SM 640 User Tracking I nquiry SMS600
SM 650 Program | nquiry SMS600
SM 660 File Usage |nquiry SMS600
SMLOOK Sm ook
PROGRAMS: 36 END OF REPORT

Copyright © 1984-2004 Aperum, Inc.
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DATE: 03/22/02
USER. SSI Tz4

MENUS FI RST TO LAST

DEMO COVPANY

MENU SELECTI ONS PRI NT

SMR740 PAGE: 1
TIME: 6:14 PM

SECURI TY ACCESS

MENU PROGRAM CODE CODE
APS000 Account s Payabl e

BACKUP TO MVS000 Master Menu
APS100 1. Docunent Entry 0 AP1
APS200 2. Paynent & Hold Sel ection 0 AP2
APS300 3. Checks 0 AP3
APS600 4. Inquiries 0 API
APS700 5. Reports & Prints 0 APR
APS800 6. End of Period 0 APE
APS900 7. File Mintenances 0 APF
APS100 Account s Payabl e

BACKUP TO APS000 Docunent Entry
APE110 1. Docunent Entry 0
APE120 2. Docunent Adjustnent Entry 0
APF110 3. Docunent Change F/'M 0
APS110 4. Recurring Docunents 0
APR110 5. Docunent Entry & Adj Register 0
APS110 Account s Payabl e

BACKUP TO APS100 Recurring Docunents
APE130 1. Recurring Docunent Entry 0
APE140 2. Recurring Docunent Review 0
APR120 3. Recurring Docunent Listing 0
APU110 4. Post Recurring Docunents 0

MENUS: 22

Copyright © 1984-2004 Aperum, Inc

END OF REPCRT

Sample Reports



System Management—7.40

DATE: 03/22/02
USER. SSI Tz4

DEMO COMPANY
USER TRACKI NG REPCRT

USER CODE FI RST TO LAST
DATE FI RST TO LAST
PROGRAM SECURI TY CODES ALL

SMR750 PAGE: 1
TIME: 6:21 PM

SECURI TY ---------- TIME--------- SI NCE
DATE PROGRAM NAVE CODE I'N out USED LAST NOTES
DAN DANI EL SI MMONS
09/ 28/ 02 SME100 *FACTS* Sign In 0 ?? 3: 32PM ?? ?? SIG\N-ON
ARI 610 AR Customer Inquiry 0 3:32PM  3:40PM : 08 101
SM 610 Summary Management | nquiry 0 3:40PM  3:43PM 102 100
ARF935 Sal esperson/ Territory F/IM 0 3:43PM  3:43PM 101 : 00
ARR720 Sal es Hi story Report 0 3:44PM  3: 44PM 101 101
ARR725 Sl sp/ Terr Sal es Report 0 3:45PM  3: 46PM 101 101
ARP720 Rol odex Custoner Card Print 0 3:46PM  3: 46PM 101 100

USERS: 1

Copyright © 1984-2004 Aperum, Inc.

END OF REPCRT

Sample Reports
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DATE: 03/22/02 DEMO COMPANY SMR760 PAGE: 1
USER. SSI Tz4 PROGRAM CHANGE REPCRT TIME: 6:21 PM

PROGRAM FI RST TO LAST

PROGRAM DATE  MEMO

MVB000 09/ 28/ 02 CHANGES AND MODI FI CATI ONS TO PROGRAMS MAY BE NOTED HERE.
SOP310 09/ 15/ 02 ADD OVERLAY PROGRAMS
MODI FI ED TO FIT NEW I NVO CE FORM

PROGRAMS: 2 END OF REPCRT

Copyright © 1984-2004 Aperum, Inc.
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DATE: 03/22/02 DEMO COVPANY

Sample Reports

SMR770 PAGE: 1

USER. SSI Tz4 F/ M AUDI T REPORT TIME: 6:22 PM
PROGRAM FI RST TO LAST
DATE FI RST TO LAST
ALL USERS
DATE USR KEY RECORD
APF910 Vendor F/' M
03/ 01/ 02 DAM DALE A. MARTI N
ad 01] V117| D ANCONI A COPPER AND ELECTRI C | 7125 CROGAN STREET STONE MU
NTAI N, GA 30278 | STONE MOUNTAI N| GA30278 | 404- 631- 9921 FRANSI CO D' ANCONI A OSCAR
WASHI NGTON | D ANCONI A | 02| M S| 900202940914940907940804| 30| 982. 33 330. 49
.00 .00 8004. 34 6962. 33 59. 68 59. 68 11185. 25 11185. 25 0. 00 0
.00 6962. 33| SAME| | M S| B9002##| 982. 33 994. 62| D ANCONI A COPPER, | NC. 7125 CROGAN STREET
STONE MOUNTAI N, GA 30278 | NPNOOOONY | 334098098] |
New | |
| | |
I [ [
[ -S| I
| [l
ARF910 Custoner F/' M
03/01/02 MEJ MARY ELI ZABETH JONES
ad 01] C104| BARNES MACHI NERY & EQUI PMENT | 18 SOUTH DI XON AVE ATLANTA,
GA 30302 | ATLANTA| GA30302 | 404- 223- 0934 JAVES W LSON
| BARNES MAC| SAME| WBL| 20| 01] NOTAX X 4] | 001] 4577. 80 3529. 50 45697. 85 34585. 03
60880. 27 46893. 51| 4577. 80 7942.65 15000] | NYYOYYNO O .00 0000NO1 Y NC| 89052294092794090794
0417 | 019236740123| UPS | 2]
New | I I
| | | LElI GH PHI LLI
PS I I [ N B [ [

CHANGES: 2

Copyright © 1984-2004 Aperum, Inc.
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DATE: 03/22/02
USER. SSI Tz4

DEMO COMPANY
HELP TEXT PRI NT

HELP CODE AR-CSH TO AR1-01-1 NV

HELP CODE

TEXT

SMR780 PAGE: 1
TIME: 6:22 PM

AR- CSH REC MENU
AR-DUN LET MENU
AR- ECP MENU
AR-F/ M MENU
AR-1 NQ MENU
AR-1 NV MENU

AR- RECR MENU
AR- RPT MENU

AR- RTD CK MENU
AR1- 01 TAX AMT
AR1- 01- BRANCH
AR1- 01- COST
AR1- 01- CUST#
AR1- 01- CUST#1
AR1- 01- DEPT
AR1- 01- DESC
AR1-01- DI SC
AR1-01-DI SC $

HELP CODES: 18

CASH & CREDI T APPLI CATI ON
DUNNI NG LETTERS

END CF PERI CD

FI LE MAI NTENANCE

I NQUI RI ES ( ARS600)

AR | N\vO CE PROCESSI NG MENU
RECURRI NG | NvO CES

REPORTS & PRI NTS

RETURNED CHECKS

AR | NvO CE TAX AMI

AR | N\vO CE BRANCH

AR | NvO CE COST

AR | NV CUSTOMER NUMBER

AR | NvO CE CUSTOVER DI SPLAY
AR | N\vO CE DEPARTMENT

AR | N\vO CE DESCRI PTI ON

AR | NvO CE DI SCOUNT

AR | N\vO CE DOLLAR AMOUNT

Copyright © 1984-2004 Aperum, Inc.

END OF REPCRT
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DATE: 03/22/02 DEMO COMPANY SMR810 PAGE: 7
USER. SSI Tz4 EOP CHECKLI ST PRI NT TIME: 6:22 PM

MANUFACTURI NG CONTRCL
DESCRI PTI ON

COWPLETE ALL BOM PRODUCTI ON

COWLETE ALL FORMULATI ON PRCDUCTI ON

PRI NT/ UPDATE BOM PERI OD PRODUCTI ON REPORT

PRI NT/ UPDATE FORMJLATI ON PERI OD PRODUCTI ON REPORT

RUN END- OC- PERI OD UPDATE

PURCHASE ORDERS
DESCRI PTI ON

COWLETE ALL PO ENTRY/ RECEI PTS & PRI NT/ UPDATE LAST RECEI PT REG STER
COWLETE ALL | NVO CE RECEI PTS & PRI NT/ UPDATE LAST | NVO CE RECEI PT REG
PRI NT/ UPDATE PERI OD RECEI PTS REPORT

PRI NT/ UPDATE | NVO CE RECEI PTS REPORT

PRI NT/ UPDATE RECEI PTS DI SCREPANCY REPORT

RUN PAST PURCHASE ORDER REMOVAL PROGRAM

RUN END- OC- PERI CD UPDATE

MODULES: 02 END OF REPCRT

Copyright © 1984-2004 Aperum, Inc. C-12
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DATE: 02/04/03 Specialty Distributors, Inc. SME710 PAGE: 1
USER: GUI T5m Note Print TIME: 10:11 AM

Note Type: ITEM Item
Item 1100 Pallet Loading Hand Truck 1000 Ib capacity
Category: GENR General Information

Subject: STEEL ALLOY FRAME OF RUGGED CONSTRUCTION. RUBBER N
Note created on 01/14/2003 at 11:44 AM by user SSI

Last edited on 01/24/2003 at 5:49 PM by user STK

***x URGENT ***

STEEL ALLOY FRAME OF RUGGED CONSTRUCTION. RUBBER NONSKID, NONSCUFF 6 INCH WHEELS. 1000 LB CAPACITY. 52" TALL, 17
POUNDS. 2 TIE DOWN STRAPS STANDARD.

08/17/94 - ADDITIONAL TIE DOWN STRAPS ARE AVAILABLE AS A NONSTOCK OPTION.
SEE VENDOR CATALOG.

09/03/94 - RECEIVED NOTICE FROM VENDOR THAT THIS MODEL WILL BE DISCONTINUED FIRST OF YEAR. NEW MODEL WILL HAVE 1200
LB CAPACITY AND WILL WEIGH LESS (MAGNESIUM ALLOY CONSTRUCTION) EXPECT A 10% PRICE INCREASE.

END OF PRINT

Copyright © 1984-2004 Aperum, Inc. C-13
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DATE: 03/22/02 DEMO COVPANY

USER: SSI

TZ4 JOB STREAM RESULTS PRI NT

JOB STREAM FI RST TO LAST

DATE START

JSR110 PAGE: 1
TIME: 6:23 PM

# COPI ES

LN# PROGRAM DESCRI PTI ON RUN TIME  COWPLETED STATUS
Job Stream AP-EOP ACCOUNTS PAYABLE END OF PERIOD Last run: 08/31/02

010 APR720 Open Payabl es Report 08/31/02  6:38PM 1 COWPLETED
020 APR730 Aged Payabl es Report 08/31/02  6:41PM 1 COWPLETED
030 APR755 Vendor Ledgercards 08/ 31/ 02 6: 47PM 1 COWPLETED
040 APRB10 Period Check Register 08/31/02  6:50PM 1 COWPLETED
050 APR820 Expense Distribution 08/31/02  7:02PM 1 COVPLETED
060 APR830 Di sbursenment Distribution 08/31/02  7:10PM 1 COWPLETED
070 APR840 Regi ster History Report 08/ 31/ 02 7: 19PM 1 COWPLETED
080 APR850 Docunent Renpval Register 08/31/02  7:22PM 1 COWPLETED
090 APU810 Vendor Ledgercard Renoval 08/ 31/ 02 7: 26PM 1 COWPLETED
100 APUB90 End-oC- Period Update 08/31/02  7:30PM 1 COWPLETED
Job Stream AR-EOP ACCTS RECEI VABLE END OF PERIOD Last run: 08/31/02

010 ARR710 Open Receivabl es Report 08/31/02  5:40PM 1 COWPLETED
020 ARR715 Aged Trial Bal ance 08/31/02  5:44PM 1 COWPLETED
030 ARR750 Custoner Ledgercards 08/31/02  5:49PM 1 COWPLETED
040 ARP810 Statenent Print 08/31/02 5:52PM 1 COWPLETED
050 ARRB20 Sal es Tax Register 08/31/02  6:01PM 1 COWPLETED
060 ARR830 Regi ster History Report 08/ 31/ 02 6: 09PM 1 COWPLETED
070 ARRB40 Docunent Renpval Register 08/31/02 6:11PM 1 COWPLETED
080 ARU810 Customer Ledgercard Renoval 08/ 31/ 02 6: 15PM 1 COWPLETED
090 ARU890 End-oC Period Update 08/31/02 6:17PM 1 COWPLETED
Job Stream PO EOP PURCHASE ORDERS END OF PERICD  Last run: 08/31/02

010 PORB10 Period Receipts Report 08/31/02  6:22PM 1 COWPLETED
020 POR820 Period | nvoice Receipts Report 08/31/02 6: 28PM 1 COWPLETED
030 POR830 Period Recei pts D screpancy 08/ 31/ 02 6: 33PM 1 COVPLETED
040 PQOU890 End-oC Period Update 08/31/02  6:34PM 1 COWPLETED
Job Stream SO EOP SALES ORDERS END OF PERI OD Last run: 08/31/02

010 SORB10 Period Sal es Register 08/31/02 5:30PM 1 COWPLETED
020 SQUB90 End-oC Period Update 08/31/02  5:35PM 1 COWPLETED
PROGRAMS: 25 END OF REPORT

Copyright © 1984-2004 Aperum, Inc.
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DATE: 03/22/02 DEMO COMPANY JSR120 PAGE: 1
USER. SSI Tz4 JOB STREAM LI STI NG TIME: 6:23 PM
JOB STREAM FI RST TO LAST

CONTINUE RUN IF PRINTER -------- FORM ------- CHANGE #PARTS # ESTI MATED RUN
LN# PROGRAM DESCRI PTI ON I F ERROR PREV ERR # SPECI AL W DTH LENGTH PAPER  PAPER COPI ES # PAGES UPDATE

Job Stream AP-EOP ACCOUNTS PAYABLE END OF PERICD Last Run: 08/31/02

010 APR720 Open Payabl es Report N N 0 N 14.0 11.0 N 1 1 15 S
A

22222227277
ALL

A
Y
ALL
T

CoOxNoURAWNE

10.
020 APR730 Aged Payabl es Report N N 0 N 14.0 11.0 N 1 1 15 S
A

727227277727
ALL

SYSTEM DATE 0
Y
N
N
D

CoxNoAWNE

=

RUN UPDATE. S=SKI P UPDATE, R=RUN UPDATE, O=OPERATOR SELECTI ON
PROGRAMS: 02 END OF REPORT

Copyright © 1984-2004 Aperum, Inc.
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DATE: 03/22/02 DEMO COMPANY OAR710 PAGE: 1
USER. SSI Tz4 OFFI CE PHONE DI RECTORY TIME: 6:24 PM
ALPHA A TO J

ALPHA NAME PHONE MEMO | D#
ACCOUNTANT HOWARD ROBERTS 404-961- 1375 ASK FOR HOW E 0001

AUTO

COWPUTER

ELECTRI C

FACTS

FOOD

FORVB

GECRA A EL

I NSURANCE

153 MAIN STREET
LAWRENCEVI LLE, GA 30365

MR GOODPLI ER AUTO & TRCK 404- 962- 2348
2937 FARR ROAD
ATLANTA, GA. 30021

SOFTWARE SOLUTI ONS 404-962- 9900
1688 LAWRENCEVI LLE HGWY
LAVWRENCEVI LLE, GA 30244

GECRA A ELECTRI C SUPPLI ES 404-687- 3243
2563 | NDUSTRI AL PARK
ATLANTA, GA 30592

SOFTWARE SOLUTI ONS 404-962- 9900
1688 LAWRENCEVI LLE HGWY
LAVRENCEVI LLE, GA 30244

NOONAN LUNCH PARLOR 968- 0088
1440 DAVIS M LL

THE PRI NTI NG COVPANY 668- 3990
456 WESTON AVE

SUl TE #2

ATLANTA, GA. 30021

GECRA A ELECTRI C SUPPLI ES 404-687- 3243
2563 | NDUSTRI AL PARK
ATLANTA, GA 30592

AAA LI FE | NSURANCE 501- 382- 8800
23 WESTPO NT DR
SANDY SPRI NGS, GA 30555

PHONE LI STI NGS: 09

Copyright © 1984-2004 Aperum, Inc.

MAI NTAINS VEHI CLES 0002

COWPUTER SOFTWARE 0005

I NTERNAL ELEC NEEDS 0007

COWPUTER SOFTWARE 0005

CALL AHEAD 0013

FORVS PRI NTI NG 0012

I NTERNAL ELEC NEEDS 0007

COVPANY | NSURANCE 0006

END OF REPCRT

Sample Reports
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DATE: 03/22/02
USER. SSI Tz4

EMPLOYEE FI RST TO LAST
EMPLOYEE NAME

DEMO COVPANY
EMPLOYEE LI STI NG

TITLE

OQAR720 PAGE: 1
TIME: 6:25 PM

PHONE

ANNE

BOB

DALE

DANI EL

GREG

MARY

NEI L

ANNE M FRANKLI N
567 W MONTANA STREET
DALLAS, TX. 75332

ROBERT JOHNSON
4378 SQUTH LAKE DR.
MORROW GA 30351

DALE A. MARTIN

75 N. BUFORD HWY
#B

ATLANTA, GA. 30321

DANI EL SI MMONS

12409 FARMDALE LANE
APT. #26B

DALLAS, TEXAS 75233

GREGORY BI LLI NGS
4728 JOHANSTON DR
FORREST PARK, GA 30050

MARY ELI ZABETH JONES
251 CLAI RMONT ROAD
#21

ATLANTA, GA. 30345

NEI'L J. ERI CKSON
29 N. DRUD HLLS
ATLANTA, GA. 30340

RONALD PATTEN
1975 WEST PINE STR.
HAPEVI LLE, GA 30049

EMPLOYEES: 08

Copyright © 1984-2004 Aperum, Inc.

WHSE STOCK CLERK
dept WHSE | oc DALLAS

ADVERTI SI NG MANAGER

dept SALE |oc SOQUTH BR

STAFF ACCOUNTANT
dept ACCT |oc EXT. 335

JR SALESPERSON

dept SALE | oc SW BRANCH

V.P. IN CHARGE OF SALES

dept SALE |oc EXT 25

ORDER ENTRY CLERK
dept ACCT |oc EXT 330

WAREHOUSE CLERK
dept WHSE | oc ATLANTA

SALESPERSON
dept SALE |oc EXT 301

214-984- 2894
214-984- 0322

404-962- 9901
404- 366- 9345

404-962- 9904
404-237-7769

214-984-9343
214-455- 3009

404-962- 9901
404- 366- 6935

404-962- 9904
404-721-0779

404-962- 9904
404- 449- 0001

404-962-9901
404-564- 3801

END OF REPCRT

Sample Reports
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DATE: 03/22/02 DEMO COMPANY OAR730 PAGE: 1
USER. SSI Tz4 MAI LI NG LABEL REPCRT TIME: 6:25 PM

LABEL FI RST TO LAST
LABEL NAME

GEN GENERAL MNAI LOUT

C100 SOQUTHEASTERN WHOLESALE
6009 RI VERDALE ROAD
JONESBORO, GA 30034
ATTN:  ART JOHNSON

C101 DELUXE EQUI PMENT WHSE
3320 JONESBORO BLVD.
DOUG.ASVI LLE, GA 30301
ATTN:  SAM JOHNSON

C102 ROARK ARCHI TECTURAL, | NC.
12471 CARSON BLVD.
ACKWORTH, GA 30063
ATTN. HOMRD ROARK

P100 ATKI NSON ELECTRONI CS
1753 HOWARD RD.
ATLANTA, GA 30021
ATTN: RALPH ATKI NSON

P101 AAA STORAGE FACILITY
1658 SOUTH DI XI E
WOODSTOCK, GA 30258
ATTN: MR ABERNATHY

P102 WAREHOUSE WHOLESALERS
1234 PEARTREE ROAD
MARI ETTA, GA 30265
ATTN: ALAN REBER

C100 SOQUTHEASTERN WHOLESALE
6009 RI VERDALE ROAD
JONESBORO, GA 30034
ATTN:  ART JOHNSON

LABELS: 07 END OF REPORT
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DATE: 03/22/02 DEMO COVPANY OAR740 PAGE: 1
USER. SSI Tz4 CALENDAR/ SCHEDULER PRI NT TIME: 6:35 PM
EMPLOYEE BCB ROBERT JOHNSON

TIME  SCHEDULE

MONDAY 02/ 28/ 02

AM 10: 00 PI CK ALAN UP AT Al RPORT
10: 30 *
11: 00 *
PM 1:00 CONFERENCE SI G\- UP DEADLI NE
5: 00 SCOFTBALL
5:30 *
6: 00 *

TUESDAY 03/01/02

AM 8: 30 STAFF MEETI NG
9:00 *
PM 12: 00 LUNCH W STEVE
12:30 *
2: 00 MEET W JAN

WEDNESDAY 03/ 02/ 02

AM 10: 30 ROLL- QUT MEETI NG
PM 12: 00 LUNCH AT FRI DAY' S
12: 30 *
2:00 CALL ELLEN
4: 00 SEND BOOK TO PRI NTER

THURSDAY 03/ 03/ 02

AM 9: 00 ARRI VE AT CONFERENCE
PM 12: 00 LUNCH
12: 30 *
1: 00 CLASS ON QU
1:30 *
2:00 *
4: 00 SPEAKER
4:30 *

END OF REPORT
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SOQUTHEASTERN WHOLESALE
ATTN:  ART JOHNSON
6009 RI VERDALE ROAD
JONESBORO, GA 30034

ATKI NSON ELECTRONI CS
ATTN: RALPH ATKI NSON
1753 HOWARD RD.
ATLANTA, GA 30021

Copyright © 1984-2004 Aperum, Inc.

ROARK ARCHI TECTURAL, | NC.

ATTN. HOMRD ROARK
12471 CARSON BLVD.
ACKWORTH, GA 30063

AAA STORAGE FACILITY
ATTN: MR ABERNATHY
1658 SQUTH DI XI E
WOODSTOCK, GA 30258

WAREHOUSE WHOLESALERS
ATTN:. ALAN REBER

1234 PEARTREE ROAD
MARI ETTA, GA 30265

Sample Reports

DELUXE EQUI PMENT WHSE
ATTN: SAM JOHNSON

3320 JONESBORO BLVD.
DOUGLASVI LLE, GA 30301
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APPENDIX D: Troubleshooting

Use this section if a problem arises while you are using the FACTS System. Since very few errors
occur in the FACTS System that can be solved by the user, this section is technically oriented. For
users, this section can help you understand what each error means and how to use the error handling
window. For system administrators and technical support providers, this section tells you why an
error occurred, when it is safe to abort out of a program, and how you might be able to correct the
problem. The section begins by describing the error handling window.

Error Handling

While under normal operation, situations can occur which will cause your data to become corrupted.
These include premature shutdown of the system or an incorrect response to a system error message.
In many cases, these situations are the direct result of user error.

All system errors that occur while you are in the FACTS package will be reported by a standard error
handling routine. A window is displayed, giving the error number, the line number of code in which
the error occurred, the program designation (such as ARF910) and the possible cause (such as
Attempting to access record locked by another user in file). You are giving the following options to
help in finding the cause of the error:

e CR-Retry - to attempt the operation again.

e C-Code - to display the full line of code on which the error occurred.

e F-Files - to display the files that were in use when the error occurred and
relevant information, such as key size, file length, maximum size of file,
records used, and available records.

» E-Escape Code - to enter the escape code that allows you to abort from
this error. You must call your system administrator for the escape code.

e Il- Abort - to abort out of an error. This option is displayed only after
you have entered the escape code or if your user code is set up to
immediately allow aborting out of an error. (However, for a file locked
error in file maintenance and inquiry programs, you are always given
this option since no data files can be corrupted.) If the setup of your
user code permits, you can enter SS when this option is displayed to
escape into the workspace of the current program or ES to escape into
the called program workspace.

» H-Hardcopy - to print relevant information needed to diagnose the
problem: the screen as it was before the error, support information (see
option I below), the line of code, and file information (see option F
above).

« I-Info - to display support information about your installation, such as
operating system level, BBx/Pro5/Pro5 level, task control block
information, and FACTS level.

e 7?-Dump - for a BBx/Pro5/Pro5 dump of the variables in your
workspace.
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Aborting from Errors in Different Program Types

D-2

There are two ways to recover from an error: resolution and abortion. Explained below is how
aborting from the different program types can affect the integrity of the data. The system
administrator should use the following guidelines before issuing an escape code to a user for aborting
out of an error.

Remember: Shutting down a computer when such an error condition exists is the same as
aborting the program. Leave the computer on overnight or over the weekend if you have
to.

Inquiry Programs

In all cases, inquiries may safely be aborted if an error occurs. However, these errors invariably point
to the presence of corrupt data.

Print Programs

Print programs may also be aborted; however, there may be some further ramifications. For example,
if AP or PR checks are printing and the Check Print Program is aborted, the entire check run may have
to be reprinted and several check forms may be lost. In another example, an aborted Work Order
Print will mean that the work order in question will have to be manually selected for reprinting. The
system is designed to handle these eventualities, but they can be an inconvenience.

Report Programs

Reports fall into two categories: those that have an optional update and those that do not. For
example, an IC Stock Status Report does not have an update; it only prints data. On the other hand,
the Sales Analysis Salesperson Commission Report has an optional update which allows the removal
of paid commission documents.

If a report does not have an optional update, it is safe to abort. Again, you will want to try and figure
out the cause of the error. It may be the case that a record has been deleted inappropriately (a
customer record, for example) causing an error (i.e., the record must be re-entered), or it may be that
data is corrupt.

If a report has an optional update, but is not in the update phase (the screen displays Reading: and
Printing: as opposed to Reading: and Updating: or Reading: and Removing:) it can be aborted.

If the report is in the update phase DO NOT ABORT. DO NOT SHUT DOWN the computer until
the situation is resolved.
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Register Programs

A register is a report with an update which writes to and removes data from many different files. An
example is the Daily Sales Register in the Sales Orders module. Among other things, this program
creates your open receivable documents, updates inventory sales data, and prepares documents to be
posted to Sales Analysis. The integrity of the data in these files and others involved is critical to the
functioning of the system. NEVER ABORT a register and NEVER SHUT DOWN the computer until
the problem is resolved. Because many files are involved in the update, aborting a register can cause
far more damage to data integrity than aborting a report update. NEVER ABORT a register when it is
updating!

Update Programs

Updates are similar to the update portion of a register. Typically, updates are involved in end-of-
period processing. For example, the Inventory Control End-of-Period Update Program, ICU890, will
reset current period activity figures, lead times, and a host of other related data. Potentially, like
registers, these programs update a large number of files. NEVER ABORT an update and NEVER
SHUT DOWN the computer until the problem is resolved.

File Maintenance Programs

If you are using the file maintenance as an inquiry, it is safe to abort a file maintenance. If you are
entering or changing data, either the data being entered is lost and needs to be re-entered, or sort files
may have to be rebuilt.

Entry Programs

Entry programs, like registers, are exceedingly complex and update large numbers of files. For
example, the Order Entry Program in the Sales Orders module accesses and modifies Accounts
Receivable information, Inventory Control information, and its own Order File information. NEVER
ABORT an entry program and NEVER SHUT DOWN the computer when an error message is
displayed in an entry program.

System Error Messages

The following is a list of errors that FACTS users may see from time to time. This list is derived from
Appendix A of the ProvideX Users Guide, but it is not complete. If the error message you receive is not
included here, refer to the ProvideX guide.

ERROR O RECORD/FILE BUSY Occurs for one of the following reasons:
» afile is locked by another user
» arecord is locked by another user

* adevice time-out occurred
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ERROR1 LOGICAL END-OF-RECORD REACHED Most often occurs when attempting to
WRITE a record longer than defined length, READ more fields than the record contains, or PRINT
more characters than the defined line length (for a printer or terminal).

ERROR 2 END-OF-FILE ON READ/FILE-FULL ON WRITE The most likely cause of this error is
an attempt to READ past the last record in the file or access the current KEY when at end-of-file.
Another cause could be an attempt to write to a full file.

ERROR3 INPUT/OUTPUT ERROR ON FILE A physical error occurred while trying to access a
device. If this error recurs on a disk drive, record the error and report it to your hardware maintenance
supplier.

ERROR 4 DEVICE NOT READY Most likely to occur if a device you are trying to access is turned
off or is offline. If the device is a printer, this error could be caused by an empty paper tray.

ERROR5 DATA ERROR ON DEVICE OR FILE Hardware failure typically returns this error
message. It indicates that the software tried to read or write to a device but failed. This error occurs
more often with reads.

ERROR7 ACCESS OUT OF FILE BOUNDARIES Caused by an attempt to read or write using a
record index that exceeds the allowable number of records on file.

ERROR8 DATA WRITE ERROR The system was unable to update a data file. This error often is
caused by hardware malfunction.

ERROR 10 ILLEGAL PATHNAME SPECIFIED The file name specified during a SAVE, CALL,
OPEN, LOAD or RUN is invalid. It is either too long, contains invalid characters or uses an invalid
syntax. A null string is considered an invalid path name.

ERROR 11 RECORD NOT FOUND/DUPICATE KEY ON WRITE This error occurs when the
system attempts to access a record that does not exist.

ERROR 12 FILE DOES NOT EXIT/ALREADY EXISTS A specified file does not exit, or a file being
created exits already.
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ERROR 13 FILE ACCESS MODE INVALID This error is most often returned when the system is
trying to

e output to a serial file that is not locked
e input from an output device (e.g., printer)
e output from an input device (e.g., keyboard)

e write to a record without providing a KEY= option or not first
EXTRACTed a record

e drop the only active window in a terminal

ERROR 14 INVALID I/O REQUEST FOR FILE STATE This error is cause when

attempting to access a file that is not open, unlock a file that is not locked, opening a file that is already
open or closing a file that is already closed.

ERROR 15 OPERATING SYSTEM ERROR For more details, PRINT MSG(-1)

ERROR 16 FILE/DISK IS FULL The file or disk being written to cannot accept anymore
information.

ERROR 18 PERMISSION DENIED FOR THIS OPERATION An operation is being performed that
is restricted either by the BASIC language or the operating system.

ERROR 20 SYNTAX ERROR This usually indicates a typing error or an improperly constructed
sentence.

ERROR 23 MISSING/INVALID VARIABLE The statement syntax requires the specification of a
variable and non was provided.

ERROR 27 UNEXPECTED OR INCORRECT WEND, RETURN, OR NEXT This error occurs when
a NEXT, WEND, RETURN or UNTIL is executed, and there is no corresponding entry on the top of the
FOR/NEXT, GOSUB/RETURN, WHILE/WEND, or REPEAT/UNTIL stack.
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ERROR 28 NO CORRESPONDING FOR for NEXT The variable identified on the NEXT directive
does not match the variable specified on current FOR directive.

ERROR 31 MEMORY LIMITS REACHED The size of the user workspace exceeds the size
provided on either -SZ option or the START directive. Either free up some of the workspace (by
deleted unused variables or arrays) or increase the memory limits.

ERROR 33 INSUFFICIENT MEMORY AVAILABLE IN SYSTEM—TRY LATER This error
appears when the memory required to run a program exceeds the memory available on your
computer system. PC users may experience this error more often than other UNIX users.

ERROR 36 ENTER PARAMETERS DON'T MATCH THOSE ON THE CALL The parameters
specified in the enter directive do not match the parameters in the call directive. The number and type
(numeric or string) must be the same in both directives.

ERROR 40 DIVIDE CHECK OR NUMERIC OVERFLOW The program attempted to divide by
zero, or the result of an arithmetic operation exceeds the limit of the machine.

ERROR 41 INVALID INTEGER ENCOUNTERED (RANGE ERROR ON NON-INTEGER) The
value specified is either not an integer or exceeds the range allowable for the type of operation being
performed.

ERROR 42 SUBSCRIPT OUT OF RANGE/INVALID SUBSCRIPT The value for the subscript
exceeds that bounds defined for the array. Either the value is less than the minimum or greater than
the maximum.

ERROR 43 FORMAT MASK INVALID This error is caused by an attempt to print a number
through a mask that is too small or does not have enough digits to the left of the decimal. If this
problem occurs while a report is being printed, the technical support provider should expand the
mask and continue the program. (NOTE: This may change the print position). In other program
types, this number will have to be set to the maximum value allowed by the mask. Later, some type of
manual adjustment must be completed to account for the discrepancy.

ERROR 46 LENGTH OF STRING INVALID This error results when an attempt to access a record
in a keyed file with a KEY= value greater in size than the defined key size.
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ERROR 47 SUBSTRING REFERENCE OUT OF STRING Caused by an attempt to access a
substring that either does not exist within a string variable or exceeds the capacity of the variable.

ERROR 84 NO DICTIONARY EXISTS ON OPENed FILE The file Input/Output directive
indicates that the internal data dictionary is to be used and none exists.

ERROR 100 NO DRIVER FOR TERMINAL TYPE OR LIBRARY MISSING During
initialization, ProvideX could not located the device driver module for the type of terminal you are
using (as defined via the TERM environment variable). This error may also be caused by the system
not being able to locate the ProvideX library.

FACTS Problem Solving Tips

File Locking

This error will mean one of two things. Either someone has gained exclusive access of the record (that
is, the record is displayed on another terminal), or someone has locked the entire file the user is
attempting to access. Records become locked if someone has accessed them in a file maintenance.
Therefore, if you are trying to place an order for a given customer, and someone is looking at the
customer’s record in the AR Customer File Maintenance, the Order Entry Program reports this error.
A retry (press CR) is always appropriate in this case. A retry will allow you to proceed. If the error
persists, you should locate the user who is accessing the same information which is required and get
them to release the record. If an entire file is locked, it usually means that someone is in the process of
updating. Again, if you try to go into the Order Entry Program and get this error, someone may be
closing out the Inventory Control module for the period. To do this, they had to lock the IC Item File
and this file is required to place orders.

Full File

From time to time the number of records in a particular file will grow to fill the disk space reserved for
that file. When this occurs, you will receive the following message: File <file name> is full. CR
when expanded, E-Expand File. NOTE: You will only be offered the “E-Expand File” option if you
have access to the Utilities Menu. If you see this option, you may type E and CR to call the file resize
utility. Otherwise, the file must be resized from another terminal.

The system administrator usually has the responsibility of monitoring file and disk usage. The FACTS
system includes an inquiry which shows the current usage of all FACTS files on the system. Periodic
checking of file usage enables the system administrator to anticipate full file conditions and expand
files as necessary before the actual condition cited above arises.
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Missing Data

While the FACTS System has been designed to prevent users from removing data inappropriately,
there are still times when a user can accomplish this. In places where data may be required, yet the
possibility exists that it has been deleted, a message telling you what data is missing will appear, and
you will be directed to add the data at another terminal. For example, you may get the message:
Missing vendor "V100'/Warehouse "01' combination in 'ICWHVD." Enter at another terminal and
CR-continue. Having done this, processing may be resumed by entering CR.

User Tracking Errors

FACTS licenses are issued on a per user basis. The following are rules that must be followed to adhere
to the per user tracking schema built into FACTS:

* Each session on a terminal must use the same FACTS user code.
e A unique terminal alias (PVXFIDO0) must be used for each FACTS
session.

The following are error messages that may be issued should the Per User Count tracking be violated.
Possible conditions for each are listed below the message. If the corrective measure is not evident
from the possible cause description, then it too has been listed below the message.

Too Many Users

Possible causes:

« Physical terminals (bases) logged into FACTS exceed the Maximum
Terminals field as set up in System Control.
* Duplicate aliases (PVXFIDO) are attempting to login to FACTS.

Corrective measures:

Verify that all users attempting to login to FACTS have a unique alias
(PVXFIDO).If using a windowing software (FacetTerm, JSB Multiview, etc.),
check the following:

« verify that the script used to assign PVXFIDO values is actually issuing
unique values.

» verify that the table used in conjunction with the above script has been
correctly set up with unique values for all sessions
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User Tracking Failure. Code=1

Possible Causes: The internal user tracking schema held in memory has been
violated. This normally indicates that someone has deliberately attempted to
tamper with our schema and has invalidated the login.

Corrective Measures; Call your support Affiliate.

User Tracking Failure. Code=2

Possible Causes: FACTS was “killed” while some users/terminals were still
logged in and the user tracking “token” was not cleared. This could happen if
someone simply turns off their terminal when they are logged into FACTS or if
they leave FACTS up and running when the system is shutdown.

Corrective Measures; Get everyone off of the system and have one person log
into FACTS. When at the FACTS Master Menu, break into basic using the
interrupt key appropriate for the terminal and operating system. Successful
operation is indicated by a CR-CONTINUE message at the bottom left corner of
the screen. Enter

SS
GOTO SWEEP
RUN

Everyone should now be able to correctly log into FACTS. If problems still
persist, please contact your support Affiliate.
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